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Document History

® Note

Before you start reading, make sure you have the latest version of this installation guide, which

is available at https:/support.sap.com/sltoolset# | » System Provisioning ¥ Install a System using

Software Provisioning Manager » Installation Option of Software Provisioning Manager 1.0 .

The following table provides an overview on the most important document changes:

Version Date Description
1.0 2012-12-17 First version for Software Provisioning Manager 1.0
11-13 2013-04-02 - Updated Versions:
2013-10-28
SL Toolset 1.0 SPS 07 - SPS 09
14 2014-03-17 Instead of a separate installation guide for each UNIX-based operating system,
we now deliver a single installation guide for all UNIX-based operating systems.
Sections that are only relevant for one or more operating systems are highlighted
accordingly.
15-21 2014-07-07 - Updated Versions:
2016-06-
6-06-06 SL Toolset 1.0 SPS 11 - SPS 17
29 2016-10-07 Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18):

®* New Features:
Option to choose installing an embedded SAP Web Dispatcher during the ASCS
instance installation, documented in: ASCS Instance with Embedded SAP Web
Dispatcher [page 32].
Using RMOSSWPM*SAR instead of SWPM*SAR for outdated OS versions not
supported by SAP kernel 740 and higher, documented in: |+ Introduction

> Constraints ]

® Support for synchronous, near-synchronous and asynchronous replication for
SAP Business Suite on SAP ASE 16.0.
For more information, see Disaster Recovery Setup with SAP Business Suite on
SAP ASE 16.0 [page 178] .
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Version Date Description

2.3 2017-02-06 Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)

® New Features:

Verification of the integrity of data units in Software Provisioning Manager,

documented in: New Features, Downloading the Software Provisioning Manager

Archive

Archive-based Language Installation, documented in: Additional Parameters
When Using a Stack XML File

2.4 2017-05-22 Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)

®* New Features:

New SAPUI5-based graphical user interface (GUI) “SL-UI", documented
in: Prerequisites for Running the Software Provisioning Manager, Running
the Software Provisioning Manager, Useful Information About the Software
Provisioning Manager

Option for choosing to install an embedded gateway during the ASCS
instance installation, documented in: Installation Options Covered by this
Guide, SAP System Parameters, Parameters for Additional Components to
be Included in the ASCS Instance , Post-Installation Checklist, SAP Gateway
Configuration

Cleanup of operating system users, documented in: SAP System Parame-
ters, Creating Operating System Users and Groups

2.5 2017-09-11 Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)

® New Features:

Media Signature Check, documented in: New Features, Running the Soft-
ware Provisioning Manager, Preparing the Installation Media .

This feature implies that section Creating Kernel Archives from an Existing
SAP System has been deleted from this documentation because the re-
lated option in the software provisioning manager had to be removed.
Download Media for a Maintenance Plan, documented in: New Features,
Downloading Media for a Maintenance Plan

SAP Host Agent Upgrade , documented in: New Features, SAP System Pa-
rameters, Downloading SAP Kernel Archives (Archive-Based Installation)
Load tools are now available as LOADTOOLS . SAR in the Software Provision-
ing Manager archive, documented in: New Features, Downloading and Ex-
tracting the Software Provisioning Manager Archive

Simplified additional application server instance installation, documented
in: New Features, Preparing the Installation Media, Downloading SAP Kernel
Archives (Archive-Based Installation)

Support of SSL, documented in: New Features, Enabling SSL encrypted
data transfer.
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Version Date Description

2.6 2018-01-15 Updated version for Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)

New Features:

Digital signature check for installation archives, documented in: New Fea-
tures, Downloading SAP Kernel Archives (Archive-Based Installation) Ar-
chive-Based Installation for Diagnostics Agent, Downloading the SAP Kernel
Archives Required for the Dual-Stack Split (Without Operating System and
Database Migration), Downloading the SAP Kernel Archives Required for
Operating System and Database Migration

Software provisioning manager Log Files Improvements, documented in:
New Features, Useful Information about the Software Provisioning Manager,
Troubleshooting with the Software Provisioning Manager

Secure ABAP message server connection, documented in: New Features,
SAP System Parameters

Enabling IPv6, documented in: New Features, Prerequisites for Running the
Software Provisioning Manager

New Features section restructured: As of SP22, a dedicated subsection for each

new SP has been created. New features below SP22 remain in a common table.

The Java SDT GUI - which was in the SP21 version still available in parallel to the
SL-Ul - has been deprecated with SP22. As of SP22, SL-Ul is the only available
GUI of the software provisioning manager:

The following sections which were explicitely related to Java SDT GUI were
completely removed from this documentation: Performing a Remote Instal-
lation Remote Processing of the Software Provisioning Manager ( Java SDT
GUI only), Starting the Java SDT GUI Separately, Running the Software
Provisioning Manager in Accessibility Mode (general accessibility informa-
tion was moved to Useful Information About the Software Provisioning Man-
ager).

The Java SDT GUI-specific information was removed from the common
software provisioning manager sections: Running the Software Provisioning
Manager, Useful Information About the Software Provisioning Manager, In-
terrupted Processing of the Software Provisioning Manager, Troubleshooting
with the Software Provisioning Manager, Deleting an SAP System or Single
Instances

New section Using the Step State Editor (SAP Support Experts Only) was added
to section Additional Information About the Software Provisioning Manager
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2.7 2018-05-07 Updated version for Software Provisioning Manager 1.0 SP23 (SL Toolset 1.0 SP23)
® New Features:
®* New Software Provisioning Manager Option Download Media for a
Maintenance Plan, documented in: New Features, Downloading the Media
for a Maintenance Planner Transaction
® Validity Check for SUM* . SAR Archive, documented in: New Features, Addi-
tional Parameters When Using a Stack XML File
* Information “enqueue server” versus “enqueue server 2", “enqueue replication
server” versus “enqueue replication server 2" added: High-Availability System ,
System Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Enqueue
Server 2 and Enqueue Replication Server 2
2.8 2018-09-17 Updated version for Software Provisioning Manager 1.0 SP24 (SL Toolset 1.0 SP24)
29 2019-01-21 Updated version for Software Provisioning Manager 1.0 SP25 (SL Toolset 1.0 SP25)
30 2019-05-27 Updated version for Software Provisioning Manager 1.0 SP26 (SL Toolset 1.0 SP26)
® New Chapter
For advanced SAP ASE audit options, you must adapt the size according to the
enabled options and the workload of your system. You can place the devices
containing the optional database sybsecurityarchive at this location. For more
information, see SAP ASE 16.0: Auditing with SAP Adaptive Server Enterprise
[page 177].
32 2019-09-16 Updated version for Software Provisioning Manager 1.0 SP27 (SL Toolset 1.0 SP27)
33 2020-01-20 Updated version for Software Provisioning Manager 1.0 SP28 (SL Toolset 1.0 SP28)
34 2020-06-08 Updated version for Software Provisioning Manager 1.0 SP29 (SL Toolset 1.0 SP29)
35 2020-10-05 Updated version for Software Provisioning Manager 1.0 SP30 (SL Toolset 1.0 SP30)
36 2021-02-15 Updated version for Software Provisioning Manager 1.0 SP31 (SL Toolset 1.0 SP31)
37 2021-06-21 Updated version for Software Provisioning Manager 1.0 SP32 (SL Toolset 1.0 SP32)
38 2021-10-11 Updated version for Software Provisioning Manager 1.0 SP33 (SL Toolset 1.0 SP33)
39 2022-02-14 Updated version for Software Provisioning Manager 1.0 SP34 (SL Toolset 1.0 SP34)
3.95 2022-03-25 Linux only: Updated version of the installation guide with systemd released (see
SAP Note 3139184 #%).
4.0 2022-05-24 Updated version for Software Provisioning Manager 1.0 SP35 (SL Toolset 1.0 SP35)
401 2022-10-10 Updated version for software provisioning manager 1.0 SP35 (SL Toolset 1.0 SP35):
Last version containing information about no longer supported operating systems
and CPU architectures according to SAP Note 2998013 ¥ .
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41 2022-10-10 Updated version for Software Provisioning Manager 1.0 SP36 (SL Toolset 1.0 SP36)

4.2 2023-02-13 Updated version for Software Provisioning Manager 1.0 SP37 (SL Toolset 1.0 SP37)

4.3 2023-05-26 Updated version for Software Provisioning Manager 1.0 SP38 (SL Toolset 1.0 SP38)

431 2023-10-09 Updated version for software provisioning manager 1.0 SP38 (SL Toolset 1.0 SP38):
Last version containing information about no longer supported Windows operating
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44 2023-10-09 Updated version for Software Provisioning Manager 1.0 SP39 (SL Toolset 1.0 SP39)
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Updated version for Software Provisioning Manager 1.0 SP40 (SL Toolset 1.0 SP40)
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1 About this Document

This installation guide describes how to install an SAP system based on the application server ABAP of SAP
NetWeaver 7.3 EHP1 to 7.52 using the installation tool software provisioning manager 1.0 SP40, which is part of
SL Toolset 1.0 SP40.

This guide is valid for the operating systems AlX, HP-UX, Linux, and Solaris, and covers the SAP system
products and releases listed in SAP Products Based on SAP NetWeaver 7.3 EHP1 to 7.52 Supported for
Installation Using Software Provisioning Manager 1.0 [page 11].

® Note

As an alternative to using Software Provisioning Manager, you can install your system

with a completely automated end-to-end framework available using SAP Landscape
Management. For more information, see SAP Note 1709155#% and https://help.sap.com/docs/
SAP_LANDSCAPE_MANAGEMENT_ENTERPRISE # .

For information about maintenance of SAP Business Suite and corresponding SAP NetWeaver versions, see
SAP Note 1648480 .

For information about supported operating system and database platforms for the SAP product you want to
install, see the Product Availability Matrix at http://support.sap.com/pam

A Caution

Make sure you have read Before You Start [page 14] before you continue with this installation guide.

SAP Products Based on SAP NetWeaver 7.3 EHP1 to 7.52 Supported for Installation Using Software
Provisioning Manager 1.0 [page 11]
Here you can find a list of the SAP products based on SAP NetWeaver 7.3 EHP1 to 7.52 ABAP that are
supported for installation using Software Provisioning Manager 1.0, on the specific operating system
and database combination described in this guide.

Naming Conventions [page 11]
This section lists the naming conventions that are currently apply for the software provisioning
manager 1.0 and terms used in this documentation.

Constraints [page 12]
This section lists the naming constraints that are currently valid for the software provisioning manager
1.0 and this documentation.

Before You Start [page 14]
Make sure that you have read the release-specific “Master Guide" for your SAP Business Suite
application, SAP NetWeaver application , or SAP Solution Manager system before you continue with
this installation guide.

SAP Notes for the Installation [page 15]
This section lists the most important SAP Notes relevant for an installation using Software Provisioning
Manager

New Features [page 17]
This section provides an overview of the new features in software provisioning manager 1.0.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
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1.1 SAP Products Based on SAP NetWeaver 7.3 EHP1 to 7.52
Supported for Installation Using Software Provisioning
Manager 1.0

Here you can find a list of the SAP products based on SAP NetWeaver 7.3 EHP1 to 7.52 ABAP that are
supported for installation using Software Provisioning Manager 1.0, on the specific operating system and
database combination described in this guide.

SAP Product Based on the following SAP NetWeaver Release
SAP Business Suite 7i 2016: SAP NetWeaver 7.5
® EHP4 for SAP CRM 7.0 ABAP SAP NetWeaver 7.4 Support Release 2
L]
EHP8 for SAP ERP 6.0 ABAP SAP NetWeaver 73 EHP1
® EHPS8 for SAP ERP 6.0 ABAP including SAP S/4HANA
Finance 1605 SPO3
®* EHPA4 for SAP SRM 7.0 ABAP
®* EHP4 for SAP SCM 7.0 ABAP
SAP Business Suite 7i 2013 Support Release 2: SAP NetWeaver 7.5
® EHP3for SAP CRM 7.0 ABAP Support Release 2 SAP NetWeaver 7.4 Support Release 2
L]
EHP7 for SAP ERP 6.0 ABAP Support Release 2 SAP NetWeaver 73 EHP1
® EHP7 for SAP ERP 6.0 ABAP including SAP Simple Fi-
nance 1.0 /1503
® EHP3for SAP SRM 7.0 ABAP Support Release 2
® EHP3for SAP SCM 7.0 ABAP Support Release 2
SAP NetWeaver 7.5 SAP NetWeaver 7.5
SAP Solution Manager 7.2 Support Release 2 SAP NetWeaver 7.4 Support Release 2
AS ABAP 7.4, OEM version 1.0 SAP NetWeaver 7.4 Support Release 2
SAP NetWeaver 7.4 Support Release 2 SAP NetWeaver 7.4

1.2 Naming Conventions

This section lists the naming conventions that are currently apply for the software provisioning manager 1.0
and terms used in this documentation.

* The software provisioning manager 1.0 is the successor of the product- and release-specific delivery of
provisioning tools, such as “SAPinst".
Before you perform an installation from scratch or a target system installation in the context of a system
copy, we strongly recommend that you always download the latest version of the software provisioning
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manager 1.0 which is part of the Software Logistics Toolset 1.0 (“SL Toolset” for short). For more
information, see Preparing the Installation Media [page 93].

This way, you automatically get the latest version with the latest fixes of the tool and supported
processes. For more information about the software provisioning manager 1.0 as well as products

and releases supported by it, see SAP Note 1680045#% and https://wiki.scn.sap.com/wiki/display/SL/
Software+Provisioning+Manager+1.0+and+2.0 ¥

The “SAPinst” tool has been renamed to “software provisioning manager”, but the terms “SAPinst” and
“sapinst” are still used in:

* The name of the technical framework of the software provisioning manager. For more information
about the current SAPinst Framework version, see SAP Note 3207613#% (SAPinst Framework 753
Central Note).

¢ Texts and screen elements in the the software provisioning manager's SL-Ul

* Names of executables, for example sapinst

* Names of command line parameters, for example SAPINST_STACK_XML

* Names of operating system user groups, such as the additional group sapinst

* ‘“usagetype”, “technical usage”, and “product instance”
As of software provisioning manager 1.0 SPO7 (SL Toolset 1.0 SP12), the term “product instance” replaces
the terms " usage type” and “technical usage”. For more information, see SAP Note 1970349 #r .
For more information, see New Features [page 17].

* “SAP system” refers to SAP system based on the application server of 7.3 including Enhancement Package
1/ Application Server ABAP 7.4 / SAP NetWeaver 74 / SAP NetWeaver 7.5 / SAP NetWeaver Application
Server for ABAP 7.51 innovation package / SAP NetWeaver Application Server for ABAP 7.52 .

¢ “Diagnostics Agent” refers to the SAP Solution Manager Diagnostics Agent which is the remote component
of End-to-End Root Cause Analysis. It allows having a connection between SAP Solution Manager and
managed systems, and then to collect information from the managed systems for reporting purposes.

1.3 Constraints

This section lists the naming constraints that are currently valid for the software provisioning manager 1.0 and
this documentation.

¢ Effective immediately, the software provisioning manager no longer supports the deprecated CPU
architectures and/or operating system versions listed in SAP Note 2998013 .

® Note

* |f your current operating system is listed as deprecated in SAP Note 2998013 %, we strongly
recommend that you migrate to a supported platform.

* If you continue to run Software Provisioning Manager on the deprecated CPU architectures and/or
operating system versions listed in SAP Note 2998013, you do so at your own risk and without
support from SAP. The software provisioning manager 1.0 SP36 and higher will still run on the
deprecated CPU architectures and/or operating system versions listed in SAP Note 2998013 #
but it may run into an error. When you start the software provisioning manager, you will see a
warning like the following: “Platform Support : Support for SAP JVM on PPC64 big endian for Linux
ends June 30 th, 2022. See SAP note 2998013.” If you run into an issue, you must use the “frozen”
software provisioning manager 1.0 SP35 software and the related installation guide. For more
information, see SAP Note 3220901 # .
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¢ End of support for SAP products based on SAP NetWeaver 7.10, 7.11, 7.20, 7.30, 740 SR1

® Note

SAP products based on SAP NetWeaver 7.10, 7.11, 7.20, 7.30, 740 SR1 (with the exception of SAP
Solution Manager 7.2 ABAP, which will continue to be supported ) are only supported in mainstream
maintenance until the end of 2020. Extended maintenance will not be provided.

For more information, see SAP Note 2980160 #% .

You can download the last published version of the guide set for the last Software Provisioning
Manager 1.0 SP30 for out-of-maintenance products (SWPM1ORMSP30_<Version>.SAR) from SAP
Note 2980160#% . The guide set attached to SAP Note 2980160 covers only the SAP product
versions which have reached end of maintenance.

¢ The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System
ID <SAPSID>, common startup framework, common database), is no longer supported in SAP systems
based on SAP NetWeaver 7.5. So if you want to install a new SAP NetWeaver 7.5 Process Integration (PIl)
system which is based on SAP NetWeaver 7.5, do not use the documentation Installation Guide - SAP
Systems Based on the Application Server ABAP+Java of SAP NetWeaver on <OS>: <DB>. Instead, use
the Installation Guide - SAP Systems Based on the Application Server ABAP of SAP NetWeaver on <OS>:
<DB> to install the ABAP stack with its own <SAPS1D> and the Installation Guide - SAP Systems Based
on the Application Server Java of SAP NetWeaver on <OS>: <DB> to install the Java stack with its own
<SAPSID>. For more information, see the implementation sequence in the Master Guide - SAP NetWeaver
7.5 at http:/help.sap.com/netweaver# | » <Release> j Installation and Upgrade 3.

* Not all SAP NetWeaver releases or SAP Business Suite applications that are available in Software
Provisioning Manager 1.0 and are described in this installation guide have already been released. Always
check the list of supported products [page 11] and SAP Note 1680045 to ensure that the installation
options you want to perform are already supported. For information about supported operating system
and database platforms, see the Product Availability Matrix at http://support.sap.com/pam#.

* Note that a complete system installation from scratch is not available for every product. For some products
- such as SAP NetWeaver 7.5 - a complete new system installation from scratch is only provided for the
highest support release. If there are one or more support releases, then a complete system installation is
only available for the highest of these support releases. As for the lower support releases, only options for
system copy and additional application server instances are provided.

* Your operating system platform must be 64-bit.

* The SAP Adaptive Server Enterprise Cluster Edition is not supported.

* Raw devices are not supported.

* The startsap and stopsap commands have been deprecated. For more information and for information
on alternatives, see Starting and Stopping SAP System Instances Using Commands [page 196].

* Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 ¥ .
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14 Before You Start

Make sure that you have read the release-specific “Master Guide” for your SAP Business Suite application, SAP
NetWeaver application, or SAP Solution Manager system before you continue with this installation guide.

The “Master Guide” is the central document leading you through the overall implementation process for your
SAP system installation. It contains crucial information about the overall implementation sequence, that is
activities you have to perform before and after the installation process described in this installation guide.

You can find a printed version of this guide in your installation package or you can download the latest version
from https://help.sap.com.

The following table lists the “Master Guide” of the SAP system application for which you can use this
installation guide, along with the available quick link or path to the appropriate download location:

Document Internet Address

Master Guide — SAP NetWeaver AS for ABAP 7.52  http://help.sap.com/nw752abap Fr

| # Installation and Upgrade 3

Master Guide — SAP NetWeaver AS for ABAP 7.51  http://help.sap.com/nw75labap

innovation package
|} > Installation and Upgrade }
Master Guide — SAP NetWeaver 7.5 http://help.sap.com/nw75 &
| # Installation and Upgrade 3
Master Guide — SAP Solution Manager 7.2 http://help.sap.com/solutionmanager ¥
|} > 7.2 <SP> > Installation and Upgrade ]
Master Guide SAP Supply Chain Management http://help.sap.com/scm
70 <Including SAP Enhancement Package
<Number> Powered by SAP NetWeaver |} > <Release> > Installation and Upgrade }

Master Guide (Including Upgrade Information) http://help.sap.com/crm
- SAP Customer Relationship Management 7.0

<Including SAP Enhancement Package Ik > <Release> » Installation and Upgrade 3
<Number>

Master Guide (Including Upgrade Information) http://help.sap.com/srmfr

- SAP Supplier Relationship Management 7.0

<Including SAP Enhancement Package [P > <Release>  Installation and Upgrade 3
<Number>

Master Guide - SAP Enhancement Package http://help.sap.com/erp i

<Number> for SAP ERP 6.0

|# » <rRelease> ¥ Installation and Upgrade 3

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
14 PUBLIC About this Document


https://help.sap.com
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw752abap
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw751abap
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw75
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fsolutionmanager
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fscm
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fcrm
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fsrm
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Ferp

Document

Internet Address

Master Guide — SAP Enhancement Package 1 for

SAP NetWeaver 7.3

http://help.sap.com/nw731

|} > Installation and Upgrade ]

1.5 SAP Notes for the Installation

This section lists the most important SAP Notes relevant for an installation using Software Provisioning

Manager

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most
recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find at https://
support.sap.com/notes .

SAP Notes for the Installation

SAP Note Number Title Description
1680045 P Release Note for software provisioning man- software provisioning manager 1.0 with installa-
ager 1.0 tion and system copy for SAP NetWeaver-based
systems
1748888 M Inst. Systems Based on SAP NetWeaver 7.3 software provisioning manager 1.0: SAP
and higher: SAP ASE NetWeaver 7.3 and higher
1554717 #r Planning Information for SAP on ASE 16.0 SAP release information for customers deploying
SAP on SAP ASE 16.0
1619967 F SYB: DBA Cockpit Correction Collection SAP The implementation of SAP Note 1619967 #r
Basis 7.31 directly after the installation is strongly recom-
mended for SAP ASE 16.0.
1882376 SYB: DBA Cockpit Correction Collection SAP The implementation of SAP Note 1882376 #r
Basis 74 directly after the installation is strongly recom-
mended for SAP ASE 16.0.
2293673 SYB: DBA Cockpit Correction Collection SAP The implementation of SAP Note 2293673 ¢
Basis 7.5 directly after the installation is strongly recom-
mended for SAP ASE 16.0.
2380028 SYB: DBA Cockpit Correction Collection SAP  The implementation of SAP Note 2380028 ¥

Basis 7.51

directly after the installation is strongly recom-
mended for SAP ASE 16.0.
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SAP Note Number

Title

Description

1245200 e ICF Service Activation for Web Dynpro DBA The Web browser-based version of the DBA Cock-
Cockpit pit does not start correctly.
1585981 # Backup Instructions for SAP on ASE 16.0 Information about backup and recovery (valid for
SAP ASE 16.0)
1650511 "% High Availability Offerings with SAP ASE Information about high availability cluster solu-
tions for SAP ASE 16.0
73606 P Supported Languages and Code Pages Information on possible languages and language
combinations in SAP systems
1972803 M SAP on AIX: Recommendations This SAP Note contains recommendations and
clarifications for many topics relevant for SAP on
AlX.
1075118 P SAP on HP-UX: FAQ This SAP Note contains information that is spe-
cific to the SAP system installation on HP-UX
2369910 SAP Software on Linux: General information This SAP Note contains Linux-specific informa-
tion about the SAP system installation
1669684 i SAP on Oracle Solaris 11 This SAP Note contains information and referen-
ces to SAP Notes relevant for Solaris 11
1067221 "% Composite SAP Note for heterogeneous instal- This SAP Note and its related SAP Notes de-
lation scribe the released operating system and data-
base combinations for heterogeneous SAP sys-
tems landscapes.
789220 M Support Package levels for SAP NetWeaver in-  Information about the ABAP Support Package
stallations/upgrades levels and kernel patch levels contained in the
current SAP NetWeaver release
1990240 Support of mixed landscapes (Unicode and Temporarily your system landscape is mixed with
Non-Unicode) Unicode and Non-Unicode systems. You have
third party software in your system landscape
which does not support Unicode at all. You won-
der whether such a heterogeneous system land-
scape is supported without restrictions.
886535 Downloading multispanning archives Downloading multispanning archives
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1.6 New Features

This section provides an overview of the new features in software provisioning manager 1.0.

Make sure that you also read the Release Notes for your SAP product at https://help.sap.com# | <Search
your SAP Product>» <Select your SAP Product Version> » What's New .

Feature

Description

Availability

New SAPinst Frame-
work Version 753

The SAPinst framework patch level has been upgraded from ver-
sion 749 (SAP Note 2393060 SAPinst Framework 749 Central
Note) to 753. For more information, see SAP Note 3207613 SA-
Pinst Framework 753 Central Note.

software provisioning manager
1.0 SP36 (SL Toolset 1.0 SP36)

Linux: Native sys-
temd support

Linux only: Starting with SUSE Linux Enterprise Server 15, Red
Hat Enterprise Linux 8, and Oracle Linux 8, and the respective
SAP kernel patch levels, native support for the software suite sys-
temd for Linux is available for SAP systems. For more information
about Linux with systemd, see SAP Note 3139184#% . When you
install SAP systems using software provisioning manager 1.0 SP
34 or higher, native systemd support is automatically activated.

software provisioning manager
1.0 SP34 (SL Toolset 1.0 SP34)

Support of AIX 7.3

AIX 7.3 is now supported for all software lifecycle management
options from software provisioning manager. For more informa-
tion, see SAP Note 3104875#% .

software provisioning manager
1.0 SP34 (SL Toolset 1.0 SP34)

Switch from
7.21_EXT Kernel to
7.22_EXT Kernel

Kernel 7.21 has reached end of maintenance. In addition, some
issues have been fixed with the new 7.22_EXT kernel media.

software provisioning manager
1.0 SP31 (SL Toolset 1.0 SP31)

Configuring the
Number of Work
Processes during
the Installation

You can now enter the number of work processes interactively
when performing an installation in custom mode.

For more information, see Basic Installation Parameters [page
54].

software provisioning manager
1.0 SP30 (SL Toolset 1.0 SP30

New Look and Feel
of SL-UI

As of version 1.0 SP24 Patch Level (PL) 5, the software provision-
ing manager comes with a new look and feel of the SL-Ul. For
more information, see https://blogs.sap.com/2018/11/10/new-
look-for-software-provisioning-manager/ #r .

software provisioning manager
1.0 SP24, PLO5 (SL Toolset 1.0
SP24)

New software pro-
visioning manager
Option Download
Software Packages
for Maintenance
Planner Transaction

If you perform an installation using a Stack XML file,

you can now download media according to a Mainte-

nance Plan. For more information, see Installation Using a
Stack XML File [page 37], Downloading Software Pack-

ages for a Maintenance Planner Transaction [page 103],

and https://blogs.sap.com/2018/06/01/software-provisioning-
manager-new-option-for-standalone-download-service/ .

software provisioning manager
1.0 SP23 (SL Toolset 1.0 SP23)
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Feature

Description Availability

Validity Check for
SUM*_SAR Archive

software provisioning manager

If you perform an installation using a Stack XML file and choose
1.0 SP23 (SL Toolset 1.0 SP23)

to extract the SUM* . SAR archive, the validity of this archive is

now checked by the software provisioning manager. For more
information , see entry Extract the SUM*_SAR Archive in Additional
Parameters When Using a Stack XML File [page 67].

Secure ABAP Mes-
sage Server Con-
nection

software provisioning manager

The software provisioning manager now uses secure connections
1.0 SP22 (SL Toolset 1.0 SP22)

to the ABAP message server of the SAP system being installed.
For more information, see the ABAP Message Server Port entry
within the Ports table in SAP System Parameters [page 55].

software provision-
ing manager Log
Files Improvements

software provisioning manager log files are now available immedi-
ately after software provisioning manager has been started, that
is before a product has been selected on the Welcome screen.
For more information, see Useful Information about Software Pro-
visioning Manager [page 128] and Troubleshooting with Software
Provisioning Manager [page 139].

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)

Digital Signature
Check of Installation
Archives

The digital signature of installation archives is checked auto-
matically by software provisioning manager during the Define
Parameters phase while processing the Software Package Browser
screens. As of now software provisioning manager only accepts
archives whose digital signature has been checked. For more in-
formation, see Downloading SAP Kernel Archives (Archive-Based
Installation) [page 100] and SAP Note 2541751 #% - SYB: Software
Provisioning Manager RDBMS content has been tampered .

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)

LOADTOOLS.SAR
archive in software
provisioning man-
ager enabled for
NUC

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)

The load tools in

SWPM10SP<Support_Package Number>_<Version_Number>
.SAR are now also enabled for an installation using non-Unicode
(NUC) SAP kernel version 740 or higher.

For more information, see Downloading and Extracting the Soft-
ware Provisioning Manager 1.0 Archive [page 98]

® Note

This feature enhances feature LOADTOOLS . SAR archive

in Software Provisioning Manager of software provision-

ing manager 1.0 SP21 (SL Toolset 1.0 SP21) (see entry
LOADTOOLS. SAR archive in software provisioning manager
below in this table).

Enabling IPv6

software provisioning manager

You can now set up a new SAP system or SAP system instance
1.0 SP22 (SL Toolset 1.0 SP22)

using Internet Protocol Version 6 (IPv6).

For more information, see Prerequisites for Running Software Pro-
visioning Manager [page 117].
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Feature

Description

Availability

Media Signature
Check

The digital signature of media is checked automatically by the
software provisioning manager during the Define Parameters
phase while processing the Media Browser screens. The software
provisioning manager only accepts media whose digital signature
has been checked.

For more information, see Preparing the Installation Media [page
93] and Running the software provisioning manager [page 121].

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

SAP Host Agent Up-
grade During the In-
stallation (Optional)

During the Define Parameters phase of the installation, software
provisioning manager prompts you whether you want to upgrade
an existing version of the SAP Host Agent on the installation host.
If there is no SAP Host Agent on the installation host, it is installed
automatically without prompt. For more information, see the Gen-
eral Parameters table in SAP System Parameters [page 55] .

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

Simplified Addi-
tional Application
Server Instance In-
stallation

During an additional application server installation, SAP kernel
archives are only prompted if they cannot be retrieved from the
primary application server instance of the existing SAP system.
For more information, see Preparing the Installation Media [page
93].

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

LOADTOOLS.SAR
archive in software
provisioning man-
ager

An up-to-date version of the load tools - such as R31oad,
R3szchk, R31dctl, SAPuptool - which were available so far only
in the SAPEXEDB . SAR archive of the kernel media, has now been
made available in the software provisioning manager archive. For
more information, see SAP Note 2472835 . For an installation
using Unicode kernel version 7.40 or higher, the load tools from
the

SWPM10SP<Support_Package Number>_<Version_Number>
.SAR are used automatically.

For more information, see Downloading and Extracting the Soft-
ware Provisioning Manager 1.0 Archive [page 98]

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

Secure Sockets
Layer (SSL) en-
crypted data trans-
fer

The feature SSL encrypted data transfer is available for SAP ASE
16.0 SPO2 starting with PL6. For general limitations and prerequi-
sites refer to SAP Note 2481596#% - SYB: Encrypted data transfer
between SAP System and SAP ASE database. The SAP software
provisioning manager offers the possibility to enable the SSL en-
crypted data transfer via a checkbox. The SSL certificates are
generated by the SAP software provisioning manager and enabled
for the database server and the SAP application server. There

are no manual steps necessary to configure the usage of SSL for
the purpose of encrypted data transfer. For more information see
Enabling SSL Encrypted Data Transfer [page 200]

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

SL-Ul with SAPINST
749

With the new software provisioning manager framework version
SAPINST 7.49, you can now use the new SAPUI5-based graphical
user interface (GUI) “SL-UI". For more information, see Useful In-
formation about Software Provisioning Manager [page 128], Run-
ning Software Provisioning Manager [page 121] .

software provisioning manager
1.0 SP20 (SL Toolset 1.0 SP20)
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Feature

Description Availability

Cleanup of Operat-
ing System Users

software provisioning manager

You can now specify during the Define Parameters phase that the
1.0 SP20 (SL Toolset 1.0 SP20)

operating system users are to be removed from group sapinst
after the execution of software provisioning manager has com-
pleted.

For more information, see Operating System Users in SAP System
Parameters [page 55].

Option to install an
SAP Gateway in an
ASCS instance

You can now install an SAP Gateway in an ASCS instance. You can software provisioning manager
choose this option while running the ASCS instance installation. 1.0 SP20 (SL Toolset 1.0 SP20)

For more information, see ASCS Instance with Embedded Gate-
way [page 34]

Verification of Integ-
rity of Data Units in
software provision-
ing manager

software provisioning manager

The integrity of data units extracted from the software provision-
1.0 SP19 (SL Toolset 1.0 SP19)

ing manager archive is verified. For more information, see Down-
loading and Extracting the Software Provisioning Manager 1.0 Ar-
chive [page 98] .

In addition, check SAP Note 1680045 whether additional infor-
mation is available.

Archive-based Lan-
guage Installation

If you perform an installation using a Stack XML file, you can now  software provisioning manager
add language archives to the download basket and use them for 1.0 SP19 (SL Toolset 1.0 SP19)
language installation. This feature is currently restricted to the

latest products only. For more information, see Additional Param-

eters When Using a Stack XML File [page 67]

Option toinstall an
SAP Web Dispatcher
inan ASCS instance

You can now install an SAP Web Dispatcher in an ASCS instance.  software provisioning manager
You can choose this option while running the ASCS instance in- 1.0 SP18 (SL Toolset 1.0 SP18)
stallation.

For more information, see ASCS Instance with Embedded SAP
Web Dispatcher [page 32]

Archive-Based In-

You can now download the required installation archives instead software provisioning manager

stallation of the complete SAP kernel installation media. For more informa- 1.0 SP17 (SL Toolset 1.0 SP17)
tion, see section Downloading Specific Installation Archives (Ar-
chive-Based Installation) in Preparing the Installation Media [page
93].

Diagnostics Agent The Diagnostics Agent is no longer installed automatically with software provisioning manager

the SAP system. The Install Diagnostics Agent check box on the 1.0 SP10 (SL Toolset 1.0 SP16)
Install Diagnostics Agent screen is no longer available.

You now have to install the Diagnostics Agent always separately.
We recommend that you install it prior to the installation of your
SAP system(s).

For more information, see the Diagnostics Agent Installation
Strategy attached to SAP Note 1365123 #%, to SAP Note
1833501 % and to SAP Note 1858920#% and the attached Diag-
nostics Agent Setup Guide.
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Feature

Description Availability

System Provision-
ing for SAP
NetWeaver 7.5 and

SAP NetWeaver 7.5-

based Products

All system provisioning tasks (installation, system copy, system software provisioning manager
rename) are available for the new SAP NetWeaver 7.5 release. 1.0 SPO9 (SL Toolset 1.0 SP15)

The Dual Stack option, which integrates an AS ABAP and AS
Javain a single system (common System ID <SAPSID>, common
startup framework, common database), is no longer supported in
SAP systems based on SAP NetWeaver 7.5.

® After upgrading to SAP NetWeaver 7.5 PI, you first have to
split the still existing dual stack-system before you can use
SAP NetWeaver 7.5 Pl productively.
For more information, see the Upgrade Master Guide - SAP

NetWeaver 7.5 at: http://help.sap.com/nw75 |} > Installation

and Upgrade 3

® SAP NetWeaver 7.5 is Unicode only

® The primary application server instance direc-
tory has been renamed from /usr/sap/<SAPSI1D>/
DVEBMGS<Instance_Number>to Zusr/sap/<SAPSID>/
D<Instance_Number>.
For more information, see SAP Directories [page 82].

® Declustering and depooling of tables during the installation
is enabled by default. For more information, see SAP Note
1892354 .

System Provisioning All system provisioning tasks (installation, system copy, system software provisioning manager

for SAP Solution
Manager 7.2

rename) are available for the new SAP Solution Manager 7.2 1.0 SPO9 (SL Toolset 1.0 SP15)
release. Compared to previous SAP Solution Manager releases,

SAP Solution Manager 7.2 is no longer provided as a classical

dual-stack system (ABAP system with Java Add-in), but consists

of a separate ABAP and Java stack.
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Feature Description Availability

Creating Kernel Ar-  You can reuse the binaries of a dedicated SAP system for a new software provisioning manager
chives from existing  SAP system installation or target system installation in the con- 1.0 SPO9 (SL Toolset 1.0 SP14)
SAP System text of a system copy by creating * . SAR archives based on the

*_Ist files from the executable (exe) directories of the source

SAP system.

® Note

This feature is only available for Unicode systems.

A Caution

This feature has been deprecated with Software Provisioning
Manager 1.0 SP21 (SL Toolset 1.0 SP21) and the related op-
tion has been removed from the Welcome screen. This depre-
cation has been accomplished to ensure compliancy with the
new feature “Media Signature Check" of Software Provision-
ing Manager 1.0 SP21 (SL Toolset 1.0 SP21) described above
in this table.

Installation Usinga  You can start software provisioning manager using a Stack XML software provisioning manager
Stack XML File file generated by the Maintenance Planner. The configuration pa- 1.0 SPO7 (SL Toolset 1.0 SP12)
rameters in this file can then be used by software provisioning
manager to improve the integration with SUM and to simplify the
process of installation for a new system on target software level.

For more information, see Installation Using a Stack XML File
[page 37].

Adaptive Installation You can assign virtual host names to SAP system instances during software provisioning manager
the input phase of the installation directly on the screens where 1.0 SPO7 (SL Toolset 1.0 SP12)
you define the instance parameters.

For more information, see SAP System Parameters [page 55].

Feedback Evaluation SAP SE's aim is to provide fast and efficient procedures. To eval- software provisioning manager
Form uate the procedure you just carried out, we need information 1.0 SPO7 (SL Toolset 1.0 SP12)
generated by the tool during process execution and your experi-
ence with the tool itself. A new evaluation form contains a simple
questionnaire and XML data generated during the procedure.

Port 4239 is used for displaying the feedback evaluation form.
For more information, see Prerequisites for Running Software Pro-
visioning Manager [page 117].
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Feature Description Availability

Option Verify Signed The digital signature ensures that the signatory of a digital docu-  software provisioning manager
Media ment can be identified unambiguously and signatory’s name is 1.0 SPO6 (SL Toolset 1.0 SP11)
documented together with the signed document, the date, and
the time.

For more information, see SAP Note 1979965 #% .
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2 Installation Options Covered by this
Guide

This section shows the installation options covered by this installation guide. You have to decide what exactly
you want to install because the steps you have to perform vary according to the installation option you choose.

After you have decided on the installation option that you want to use, continue with Planning [page 36].
Standard System [page 24]
Distributed System [page 25]
High-Availability System [page 26]
Additional Application Server Instance [page 28]

Splitting off an ABAP Central Services Instance from an Existing Primary Application Server Instance [page
31]

ASCS Instance with Embedded SAP Web Dispatcher [page 32]
ASCS Instance with Embedded Gateway [page 34]

2.1 Standard System

You can install a standard system on a single host.

There are the following instances:

¢ ABAP Central services instance (ASCS instance)
Contains the ABAP message server and the Standalone Enqueue Server
In a standard
* Optionally, you can install the ASCS instance with an embedded SAP Web Dispatcher. For more
information, see ASCS Instance with Embedded SAP Web Dispatcher [page 32].
* Optionally, you can install the ASCS instance with an embedded gateway. For more information, see
ASCS Instance with Embedded Gateway [page 34].
* Database instance (DB)
* Primary application server instance (PAS instance)

Additionally, you can install one or more additional application server instances. For more information, see
Additional Application Server Instance [page 28].
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2.2 Distributed System

An SAP system consists of SAP instances. An SAP instance is a group of processes that are started and
stopped at the same time.

In a distributed system, every instance can run on a separate host:

® Note

We strongly recommend installing the ASCS instance on the same host as the primary application server.
The installation of the ASCS instance on a separate host is reserved for high-availability configurations on
Windows that are not using Microsoft Failover Clustering.

* ABAP Central services instance (ASCS instance)
Contains the ABAP message server and the Standalone Enqueue Server
* Optionally, you can install the ASCS instance with an embedded SAP Web Dispatcher. For more
information, see ASCS Instance with Embedded SAP Web Dispatcher [page 32].
* Optionally, you can install the ASCS instance with an embedded gateway. For more information, see
ASCS Instance with Embedded Gateway [page 34].
* Database instance (DB)
The ABAP stack uses its own database schema in the database.
* Primary application server instance (PAS)

The graphics below assume that you use the global directories of the ASCS instance as global file system. That
means that the host with the ASCS instance is the SAP global host. However, you can also separately install the
global directories on any host of your SAP system landscape.

You can also use the SAP transport host or the host with the global file system (SAP global host) as your
primary application server instance host.

Optionally, you can install one or more additional application server instances. For more information, see
Installation of an Additional Application Server Instance [page 28].

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
Installation Options Covered by this Guide PUBLIC 25



SAP Global Host

ABAP
Central
Services
Instance
(ASCS)

Database Instance Host with Global Primary Application
Host Transport Directory Server Instance Host
(SAP Trans Host,
Optional)

Primary Application

Server Instance
(PAS)

\___/’

Distributed ABAP System

2.3 High-Availability System

An SAP system consists of SAP instances. An SAP instance is a group of processes that are started and
stopped at the same time.

In a high-availability system, every instance can run on a separate host.

® Note

The High-Availability System is valid only for SAP ASE 16.0.

There are the following instances:

¢ ABAP central services instance (ASCS instance)
Contains the ABAP message server and the Standalone Enqueue Server

® Note

ASCS instance with “Standalone Enqueue Server” versus ASCS instance with new “Standalone
Enqueue Server 2”: Software Provisioning Manager 1.0 installs the “Standalone Enqueue Server” by
default for all SAP system releases in the ASCS instance. However, if you have installed the ASCS
instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to the new
“Standalone Enqueue Server 2" after the installation has completed. For more information, see https:/

help.sap.com/nw752abap# |+ Application Help » SAP NetWeaver Library: Function-Oriented View
» SAP NetWeaver Application Server for ABAP » Components of SAP NetWeaver Application Server for

ABAP » Standalone Enqueue Server 2 » High Availability with Standalone Enqueue Server 2 3, and
Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2
and Enqueue Replicator 2 [page 160] .
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¢ Optionally you can install the ASCS instance with an embedded SAP Web Dispatcher. For more
information, see ASCS Instance with Embedded SAP Web Dispatcher [page 32].

¢ Optionally you can install the ASCS instance with an embedded gateway. For more information, see
ASCS Instance with Embedded Gateway [page 34].

* ERS instance for the ASCS instance (mandatory)
The ERS instance contains the replication table, which is a copy of the lock table of the Standalone
Enqueue Server in the ASCS instance.

® Note

ERS instance with “Enqueue Replication Server” versus ERS instance with new “Enqueue
Replicator 2”: Software Provisioning Manager 1.0 installs the ERS instance with the classic “Enqueue
Replication Server” by default for all SAP system releases. However, if you have installed the

ERS instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch

to “ Enqueue Replicator 2" after the installation has completed. For more information, see https:/
help.sap.com/nw752abap# | Application Help # SAP NetWeaver Library: Function-Oriented View

» SAP NetWeaver Application Server for ABAP » Components of SAP NetWeaver Application Server for
ABAP » Standalone Enqueue Server 2 J, and Systems Based on SAP NetWeaver AS for ABAP 7.52
only: Switching to Standalone Enqueue Server 2 and Enqueue Replicator 2 [page 160].

* Database instance (DB)

* Primary application server instance (PAS)

The graphics below each assumes that you run the ASCS instance and the ERS instance on the switchover
cluster infrastructure. However, you can also run other SAP system instances that are a single point of failure
(SPOF) on a switchover cluster infrastructure, for example the database instance.

We recommend that you run the ASCS instance in a switchover cluster infrastructure.

To increase high availability by creating redundancy, we recommend that you install additional application
server instances on hosts different from the primary application server instance host. For more information,
see Installation of an Additional Application Server Instance [page 28].

The following figure shows an example for the distribution of the SAP system instances in a high-availability
system.
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2.4 Additional Application Server Instance

You can install one or more additional application server instances for an existing SAP system. Additional
application server instances are optional and can be installed on separate hosts.

An additional application server instance can run on:

* The host of any instance of the existing SAP system (exceptions see below)
* Onadedicated host

® Note

If you want to install additional application server instances running on an operating system other than the
primary application server instance, see Heterogeneous SAP System Installation [page 200]. For example,
you need to do this if your primary application server instance runs on Linux for z System but the additional
application server instance is to run on Windows.

Additional Application Server Instance for a Standard System

For example, the following figure shows a standard system with additional application server instances that
run:

* Onthe main host of the SAP system, that is, on the host on which the primary application server instance
and the database instance run
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Additional Application Server Instance for a Standard ABAP System

For more information, see Standard System [page 24].

Additional Application Server Instance for a Distributed System

The following figure shows a distributed system with additional application server instances that run:

* Onthe main host of the SAP system, that is, on the host on which the primary application server instance
runs
* Ondedicated hosts

We do not recommend installing additional application server instances on the SAP global host.
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For more information, see Distributed System [page 25].
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Additional Application Server Instance for a Distributed ABAP System

Additional Application Server Instance for a High-Availability System

The following figure shows a high-availability system with additional application server instances that run:

* On the host of the primary application server instance

* Ondedicated hosts
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For more information, see High-Availability System [page 26].

2.5 Splitting off an ABAP Central Services Instance from an
Existing Primary Application Server Instance

The ABAP central services instance (ASCS instance) consists of the essential ABAP enqueue and message
system services only. With a separate ASCS instance, it is easier for you to later turn your SAP system into a
high-availability system.

The benefit of having a separate ASCS instance is mainly in the area of high-availability. This approach
concentrates the possible single points of failure of a system into a single instance and, therefore, restricts
failure to a single instance.

Every newly installed SAP system based on SAP NetWeaver 7.3 and higher is automatically installed with an
ASCS instance, even if you install all SAP system instances on one host (standard system).

However, if you upgraded your SAP system from a release based on a SAP NetWeaver release lower than 7.3,
your SAP system might not yet have a separate ASCS instance.

The section Splitting Off an ABAP Central Services Instance from an Existing Primary Application Server
Instance [page 180] describes how you can move the message server and the enqueue work process from
an existing primary application server instance to a newly installed ABAP central services instance (ASCS
instance).
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2.6 ASCS Instance with Embedded SAP Web Dispatcher

You can install an SAP Web Dispatcher embedded in the ASCS instance. If you select this option, an SAP Web
Dispatcher is installed running within the ASCS instance. No separate SAP Web Dispatcher instance and no
dedicated <SAPSID> are created for the SAP Web Dispatcher.

- Recommendation

The embedded SAP Web Dispatcher is subject to a number of limitations. For more information, see SAP
Note 3115889 . It is a convenience option for small systems, but is not recommended for production
systems. The general recommendation is to install a standalone SAP Web Dispatcher instead.

® Note

We only recommend this option for special scenarios. For more information, see SAP Note 908097 # . The
embedded SAP Web Dispatcher is subject to a number of limitations. For more information, see SAP Note
3115889 . It is a convenient option for small systems, but is not recommended for production systems.
The general recommendation is to install a standalone SAP Web Dispatcher instead. For an SAP Web
Dispatcher installation, a standalone installation (see below) continues to be the default scenario.

Single Point _u
Of Entry: -
IP Address P
' Application
Port, and URL NP nEtEes Server

Enqueue
Server

Message

Server —
Application
Server RDBMS

Web
Dispatcher

Process
http://.. N
N Application

Server

Load Balancing and Configuration:
Information from
SAP Message Server

ASCS Instance with Embedded SAP Web Dispatcher

The SAP Web Dispatcher is located between the Web client (browser) and your SAP system that is running the
Web application.

It acts as single point of entry for incoming requests (HTTP, HTTPS), defined by the IP address, port, and URL,
and forwards them in turn to the application server (AS) of the SAP system.
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The SAP Web Dispatcher receives information about the SAP system that it needs for load distribution (load
balancing) from the message server and application server via HTTP.

Installation of “Standalone” SAP Web Dispatcher with its own <SAPSID> and

Instance

If you want to install an SAP Web Dispatcher for another system - that is not for the system for which you
use the ASCS instance and with its own SAP system ID and instance number - you have to install SAP Web
Dispatcher separately as described in the documentation Installation of Installation of SAP Web Dispatcher

for SAP Systems Based on SAP NetWeaver 7.0 to 7.52 on <OS> which you can find at https://support.sap.com/

sltoolsetr | » Installation Option of Software Provisioning Manager 1.0 ¥ Installation Option of Software
Provisioning Manager 1.0 ¥ Installation Guides - Standalone Engines and Clients - Software Provisioning
Manager 1.0 » SAP Web Dispatcher 3.

More Information

For more information about the architecture and the functions of SAP Web Dispatcher, see the SAP Web
Dispatcher documentation in theSAP Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package | 3 Application Help » Function-Oriented View Application
1

http://help.sap.com/nw731#
® SAP NetWeaver 74

http://help.sap.com/nw74 Fir
® SAP NetWeaver 7.5

http://help.sap.com/nw75#

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap
SAP NetWeaver AS for ABAP 7.52

https://help.sap.com/nw752abap

Server > Application Server Infrastructure > Components of

SAP NetWeaver Application Server } SAP Web Dispatcher }

Related Information

Parameters for Additional Components to be Included in the ASCS Instance [page 69]
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2.7 ASCS Instance with Embedded Gateway

You can install a gateway embedded in the ASCS instance. If you select this option, a gateway is installed within
the ASCS instance.

® Note

No separate standalone gateway instance and no dedicated <SAPSID> are created for the gateway.

Enqueue
Server

Dispatcher
Gateway Processes Message

Server

Gateway

SAP Gateway Integrated in ASCS Instance
Gateway Embedded in the ASCS Instance

The gateway enables communication between work processes and external programs, as well as
communication between work processes from different instances or SAP systems.

You can also install a standalone gateway instance. For more information, see the documentation Installation
Guide - Installation of a Standalone Gateway Instance for SAP Systems Based on SAP NetWeaver 7.1 to

7.5x at https://support.sap.com/sltoolset# | # Installation Option of Software Provisioning Manager 1.0 ¥
Installation Guides - Standalone Engines and Clients - Software Provisioning Manager 1.0 » Standalone Gateway

Instance .
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Related Information

Parameters for Additional Components to be Included in the ASCS Instance [page 69]
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3 Planning

3.1 Planning Checklist

This section includes the planning steps that you have to complete for the following installation options.

* Standard, distributed, or high-availability system

* Additional application server instance

Detailed information about the steps are available in the linked sections.

Prerequisites

1. You have planned your SAP system landscape according to the Master Guide available at the appropriate
download location as described in Before You Start [page 14] .

2. You have decided on your installation option (see Installation Options Covered by this Guide [page 24]).

Standard, Distributed, or High-Availability System

® Note

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing
a standard system, you can ignore references to other hosts. Since an SAP system on IBM Db2 for
z/0S system is always a distributed constellation, we only offer two installation options: standard or
high-availability.

1. Installation Using a Stack XML File [page 37]:
If you want to install an SAP ABAP system along with the required Support Package stack and ABAP
Add-Ons in one implementation run, you need to plan the desired installation target using the maintenance
planner at https://apps.support.sap.com/sap/support/mp#.
In the maintenance planner, a stack XML file with the desired Support Package stack and Add-On
information is generated, which you then hand over to the software provisioning manager by calling it with
command line parameter SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>. Included
constraints and defaults defined in the stack XML file are then used for the initial installation by Software
Provisioning Manager and for the application of Support Package stacks and Add-Ons by the Software
Update Manager (SUM).

- Recommendation

We recommend that you perform the installation using a stack configuration file for all new products
such as SAP S/4AHANASAP on Premise.
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2. Installation Using a Stack XML File [page 37]:

If you want to install an SAP Process Integration 7.5 system or an SAP Solution Manager 7.2 system
comprising ABAP and Java, both the ABAP and the Java system must be installed with the identical
Support Package (SP) level.

You check the hardware and software requirements [page 39] on every installation host.

You plan how to set up user and access management [page 53].

You identify Basic SAP System Installation Parameters [page 54].

You carefully plan the setup of your database [page 70].

You decide on the transport host to use [page 72].

You decide whether you want to integrate LDAP Directory Services in your SAP system [page 183].

© 0N O AW

To install a high-availability system, you read Planning the Switchover Cluster for High Availability [page
731.
10. Continue with Preparation [page 76].

Additional Application Server Instance

1. You check the hardware and software requirements [page 39] for every installation host on which you
want to install one or more additional application server instances.

2. You identify Basic SAP System Installation Parameters [page 54].

3. Continue with Preparation [page 76].

3.2 Installation Using a Stack XML File

The option to perform an installation using a Stack XML file (also called “up-to-date installation™ or “UDI"
for short) improves the process of provisioning an up-to-date SAP system by creating a unified consumption
experience and a direct close collaboration between the involved tools, namely:

* The Maintenance Planner

* software provisioning manager (the “software provisioning manager” for short)

* Software Update Manager (abbreviated as “SUM")

The software provisioning manager then can take over more default settings that are already predefined in the
Maintenance Planner.

-> Recommendation

We recommend that you perform the installation using a Stack XML file for new products, such as SAP
S/4HANA or SAP Solution Manager 7.2.
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Restrictions

You cannot perform a target system installation in the context of a system copy as an installation with a Stack
XML file.

Prerequisites

You must have an S-User with the authorization to access and use the Maintenance Planner at https://
apps.support.sap.com/sap/support/mp .

For additional information about involved tools and supported SAP system releases, see SAP Note
2277574 .

Features

An installation using a Stack XML file provides the following features:

38

You can use a Stack XML file generated by the Maintenance Planner at https:/
apps.support.sap.com/sap/support/mp# . The parameters contained in the Stack XML file can then

be processed by software provisioning manager to get better integrated with SUM and to simplify the
process of installation for a new system on a target software level. This makes IT administration easier by
reducing the efforts in Total Cost of Ownership (TCO). For more information, see the Best Practice Guide
to Planning Landscape Changes at https://support.sap.com/en/tools/software-logistics-tools/landscape-
management-process.htm| .

When processing a Stack XML file, software provisioning manager can take over more default settings
that are already predefined in the Maintenance Planner and offers more possibilities for automation
as compared to when running without it. For more information about the benefits by comparing the
existing process with the new improved process, see Up-To-Date Installation at https://blogs.sap.com/
2016/10/21/up-to-date-installation-2/ .

® Note

The procedure and the screenshots provided in the linked document are only an example to show
how an up-to-date installation works in general for an example SAP product, and what the benefits are.
This document is not intended to serve as a detailed instruction for an up-to-date-installation of any
supported SAP product.

You can also run an installation using a Stack XML file in unattended mode as described in System
Provisioning Using an Input Parameter File [page 130].

You can use software provisioning manager to directly download the installation software from SAP by
providing the Maintenance Plan to software provisioning manager while running software provisioning
manager option Download Software Packages for Maintenance Planner Transaction.

For more information, see Downloading Software Packages for a Maintenance Planner Transaction [page
103].
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Integration

For the additional input parameters that you need to specify, see Additional Parameters When Using a Stack
XML File (Optional). You can find the link to this section in Related Information below.

If you want to install an SAP Process Integration 7.5 system or an SAP Solution Manager 7.2 system comprising
ABAP and Java, consider the following additional requirements:

* Boththe ABAP and the Java system must be installed with the identical Support Package (SP) level.

® The SAP system ID (SAPSID) of the ABAP system must be different from the SAPSID of the Java system.

* Theinstallation with Stack XML file must be run separately, first for the ABAP system, then for the Java
system.

The Software Update Manager (SUM) is started by the software provisioning manager at the end of the
installation process. A browser window opens with a link to Ul of the SUM that is already running. Follow the

instructions on the SUM dialogs and in the SUM Guide at https://support.sap.com/sltoolset# | » System
Maintenance 3.
Each section in this guide describing steps that are completely or at least partially automatized when using a
Stack XML files is marked with an appropriate note at the beginning. These are the following sections:

* Planning Checklist [page 36]

* Additional Parameters When Using a Stack XML File [page 67]

* Downloading Software Packages for a Maintenance Planner Transaction [page 103]

* Running Software Provisioning Manager [page 121]

* Configuring the Change and Transport System [page 153]

* Applying the Latest Kernel and Support Package Stacks [page 156]

* Installing Additional Languages and Performing Language Transport [page 162]

3.3 Hardware and Software Requirements

Ensure that your hosts meet the hardware and software requirements for your operating system and the SAP
instances. Otherwise you might experience problems when working with the SAP system.

Prerequisites

* Make sure that the host name meets the requirements listed in SAP Note 611361 .
* Contact your OS vendor for the latest OS patches.
* Check your keyboard definitions.

* Ifyou want to install a printer on a host other than the primary application server instance host (for
example, on a separate database instance host), check whether the printer can be accessed under UNIX.
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Procedure

1. Check the Product Availability Matrix at http://support.sap.com/pam#& for supported operating system
releases.

2. Check the hardware and software requirements using:
* The Prerequisite Checker:

¢ Standalone (optional) before the installation process
For more information, see Running the Prerequisites Check Standalone [page 40].

* Integrated in the installation tool (mandatory) as part of the installation process
For more information, see Running Software Provisioning Manager [page 121].

® The hardware and software requirements tables in Requirements for the SAP System Hosts [page
41].
3. If you want to install a production system, the values provided by the Prerequisite Checker and the
hardware and software requirements checklists are not sufficient. In addition, do the following:
* YouusetheQuick Sizer tool available at http://sap.com/sizing .
* You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing
depending on:
¢ The set of applications to be deployed
* How intensively the applications are to be used

* The number of users

3.3.1 Running the Prerequisites Check in Standalone Mode
(Optional)

This section describes how to run the prerequisites check in standalone mode. Running the prerequisites
check in standalone mode is optional.

Context

When you install an SAP system, the software provisioning manager automatically starts the prerequisites
check and checks the hardware and software requirements in the background. As an optional step during
planning, you can also run the prerequisites check in standalone mode to check the hardware and software
requirements for your operating system and the SAP instances before the actual installation.

-> Recommendation

We recommend that you use both the prerequisites check and the requirements tables for reference.
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Procedure

1. Download and unpack the Software Provisioning Manager archive to a local directory as described in
Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 98] .

2. Make either the separate SAPEXE<Version>.SAR archive or the complete kernel medium available as
described in Preparing the Installation Media [page 93] .

3. Start the software provisioning manager as described in Running Software Provisioning Manager [page
121].

4. Onthe Welcome screen, choose [ <SAP_Product> } <Database> ¥ Preparations j Prerequisites
Check 1.

5. Follow the instructions in the software provisioning manager dialogs and enter the required parameters.

® Note

To find more information on each parameter during the Define Parameters phase, position the cursor
on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.

After you have finished, the Parameter Summary screen appears. This screen summarizes all parameters
that you have entered and that you want to have checked. If you want to make a change, select the relevant
parameters and choose Revise.

6. To start the prerequisites check, choose Next.

Results

The Prerequisite Checker Results screen displays the results found. If required, you can also check the results in
file prerequisite_checker_results.html, which you can find in the installation directory.

Related Information

Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 98]
Preparing the Installation Media [page 93]

3.3.2 Requirements for the SAP System Hosts

Every installation host must meet at least the requirements listed in the following tables. Most of the
requirements are valid for every installation host whereas some requirements are instance-specific and are
marked accordingly.
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® Note

The information here and in the following sections is not intended to replace the operating system
documentation. For more information, see your operating system documentation.

Related Information

General Installation Information for Your Operating System [page 42]
Hardware Requirements [page 43]

Software Requirements [page 47]

Other Requirements [page 52]

3.3.2.1 General Installation Information for Your Operating
System

Before checking the hardware and software requirements, we recommend that you make yourself familiar with
some general information about installation of SAP systems on your operating system platform.

General Installation Information for Your Operating System

Operating System Information

AlX Before you start the installation, make sure that you have read SAP Note In addition to the hardware
and software requirements listed here, make sure that you also consult the hardware and software
requirements provided by IBM at 1972803 #& .

In addition, we also recommend that you check the information available in the SAP on AIX space on

the SAP Community Network at https:/www.sap.com/community/topic/aix.htm|#r .

HP-UX In addition to the hardware and softwareBefore you start the installation, make sure that you have
read SAP Note 1075118 /% .

SAP on ASE uses Concurrent I/0 on HP-UX. The Veritas File System (Online JFS 5.0.1 or above)
must be installed on your system prior to installing SAP applications on ASE and HP-UX. For more
information, see SAP Note 1077887 #r .

SAP Adaptive Server Enterprise 16.0: Install the following AioEnh patch: https:/
h20392.www2.hp.com/portal/swdepot/displayProductinfo.de?productNumber=AioEnh #* .

SAP only supports the use of native binaries. Always use the appropriate SAP binaries for your
processor.
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Operating System Information

Linux Before you start the installation, make sure that you have read the SAP Notes for your Linux distribu-
tion listed in the central SAP Note 2369910 #r .

In addition, we also recommend that you check the information available in the SAP on Linux space
on the SAP Community Network at https:/www.sap.com/community/topic/linux.htm| .

Solaris Before you start the installation, make sure that you have read SAP Note 1669684 #%r .

3.3.2.2 Hardware Requirements

Every installation host must meet at least the hardware requirements listed in the following tables. Most of
the requirements are valid for every installation host whereas some requirements are instance-specific and are
marked accordingly.

Hardware Requirements

Requirement Values and Activities

Processing units For application server instances and database instances: The number of physical or virtual
processing units usable by the operating system image must be equal to or greater than 2.

Database Instance:

SAP ASE 16.0: All 64-bit processors that are capable of running the supported operating
system versions for SAP ASE 16.0.

All other instances: 2 dual core CPUs or 4 single core CPUs.

For an ASCS instance running on a separate host: One physical or virtual processing unit
usable by the operating system image might be sufficient.

Examples of processing units are processor cores or hardware threads (multithreading).

In a virtualized environment, ensure that adequate processor resources are available to
support the workloads of the running SAP systems.

Optical media drive ISO 9660 compatible
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Requirement Values and Activities

Hard disk space ® General Requirements:
® 2 GB oftemporary disk space for each required physical installation media - or
alternatively the downloaded SAP kernel archives - that you have to copy to a local
hard disk. For more information, see Preparing the Installation Media [page 93].
® If you prefer downloading the separate SAP kernel archives instead of using the
complete SAP kernel media, you require 2 GB of temporary disk space for the set of
SAP kernel archives that you have to copy to a local hard disk. For more information,
see Downloading SAP Kernel Archives (Archive-Based Installation) [page 100] .
® 2 GB oftemporary disk space for the installation.
® Ifanadvanced disk array is available (for example, RAID), contact your hardware
vendor to make sure that the data security requirements are covered by this tech-
nology.
® Instance-Specific Requirements:
If you install several instances on one host, you have to add up the requirements
accordingly.
® For more information about space requirements for the file systems and directories of
the instances, see SAP Directories [page 82] and the appropriate database-specific
information listed below.
® ABAP central services instance (ASCS):
Minimum 2 GB
® If youinstall the ASCS instance with an embedded SAP Web Dispatcher, for the
installation as such you require at least 1 GB of hard disk space in addition. For
production use of the SAP Web Dispatcher, you need to reserve at least 5 GB.
® If youinstall the ASCS instance with an embedded gateway, you require at least
1 GB of hard disk space in addition.
® ERSinstance for the ASCS instance (if required):
Minimum 2 GB
® Database Instance:
Database instance valid only for SAP ASE 16.0: Minimum 40 GB (depending on the
SAP product to be installed)
Database Software: 8 GB
For safety reasons (system failure), the file systems must be physically distributed
over several disks or RAID-technology must be used.
® Primary application server instance:
Minimum 2 GB (SAP NetWeaver BW server: Minimum 30 GB)
¢ Additional application server instance:
Minimum 2 GB (SAP NetWeaver BW server: Minimum 30 GB)
® SAP Host Agent:
Minimum 0.5 GB
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Requirement Values and Activities

RAM |On|y valid for 'Platform': AIX

® Note

AlX: Keep in mind that the operating system itself requires about 10% of the available
RAM.

| End of 'Platform’: AIX |

The following lists the RAM requirements for each SAP instance.

If you install several instances on one host, you have to add up the requirements accord-
ingly.
® ABAP central services instance (ASCS instance)
Minimum 1 GB
If you install the ASCS instance with an embedded SAP Web Dispatcher, see SAP Note
2007212 #% for memory consumption in productive use.
® ERSinstance for the ASCS instance (if required):
Minimum 1 GB
¢ Database Instance:
SAP ASE 16.0: 7 GB
® Primary application server instance
Minimum 3 GB (BW server: Minimum 2 GB)
¢ Additional application server instance:
Minimum 3 GB
® SAP Host Agent:
Minimum 1 GB

[Only valid for Platform': HP-UX |

HP-UX: Refer to SAP Note 1112627 #% for the commands to display the RAM size on HP-UX.
| End of 'Platform': HP-UX |

|On|y valid for 'Platform': Linux |

Linux: For more information about how to evaluate main memory consumption on Linux, see
SAP Note 1382721 # .

| End of 'Platform': Linux
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Requirement Values and Activities

AIX: Paging space You need hard disk drives with sufficient paging space. You can calculate the required paging
space as follows:
® Optimistic strategy:
You need at least 20 GB for the primary application server instance and at least
another 10 GB for every additional application server instance.

* Defensive strategy:
3*RAM, at least 20 GB

In addition, for the database instance you need:

®* 0.75*RAM, if RAM is greater than 8 GB
* 1*RAM,if RAMis less than 8 GB

For the latest information about recommended paging space, see SAP Note 1121904 # .

HP-UX: Swap space You need hard disk drives with sufficient space for swap. You can calculate the required swap
space as follows:

2 *RAM, at least 20 GB
SAP NetWeaver Process Integration 7.5 or higher: 2 * RAM or 80 GB, whichever is higher

For more information about HP-UX swap space recommendations and about how to set up
swap space, see SAP Note 1112627 #r .

Linux: Swap space You need hard disk drives with sufficient space for swap. We recommend that you use the
amount of swap space as described in SAP Note 1597355#% . You might decide to use more
or less swap space based on your individual system configuration and your own experience
during daily usage of the SAP system.

Oracle Solaris: Swap space You need hard disk drives with sufficient space for swap.

At least 20 GB are required. For more information, see SAP Note 570375#% .
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Requirement Values and Activities

Verifying paging space size  To verify paging space size and kernel settings, you can execute meml imits as follows:
andkernel settings using 1 = \1oue sure that the SAPCAR program is available on the installation host. If SAPCAR
memlimits

is not available, you can download it from https:/me.sap.com/softwarecenter#r | ¥

SUPPORT PACKAGES & PATCHES By Category » SAP TECHNOLOGY COMPONENTS

» SAPCAR 3.

2. Make the SAPEXE. SAR archive available on the installation host. Either download it
as described in Downloading SAP Kernel Archives (Archive-Based Installation) [page
100] or take it from the kernel media, where this archive is contained in the folder
K_<Kernel_Version>_<U/N>_<0S>/DBINDEP.

3. Tounpack the file memlimits, enter the following command:

SAPCAR -xvfg SAPEXE.SAR memlimits
4. Start memlimits using the following command:
-/memlimits -1 20000
In case of error messages, increase the paging space and rerun meml imits until there
are no more errors.

3.3.2.3 Software Requirements

Every installation host must meet at least the software requirements listed in the following tables. Most of the
requirements are valid for every installation host whereas some requirements are instance-specific and are
marked accordingly.

Software Requirements

Requirement Values and Activities

SAP ASE 16.0 FOR BUS.SUITE

The database software is automatically installed by the software provisioning man-
ager.

Check the Product Availability Matrix (PAM) at http://support.sap.com/pam#& for
supported database platforms.
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Requirement Values and Activities

AIX: Operating system version Your operating system platform must be 64-bit.

Check the Product Availability Matrix (PAM) at http:/support.sap.com/pam# for
supported operating system versions.

Contact your OS vendor for the latest OS patches.

Minimal OS requirements for the specific SAP Kernel releases are listed in SAP Note
1780629 % .

You require at least AIX 7.1 TL1 SP1 to be able to run the software provisioning
manager.

® SAP ASE 16.0 for Bus.Suite
AIX 7.2
AIX 7.1 TL1 SP1 and higher
To check the operating system version, enter the following command:
oslevel -s

Required SPs

AlX Level: Required SP: oslevel -s
AIX71TL1 SP6 7100-01-06-1241
AIX71TL2 SP2 7100-02-02-1316

AIX 7.1 requires a patch that fixes APARIV10828. Contact IBM directly to obtain
the patch.

HP-UX: Operating system version Your operating system platform must be 64-bit.

Check the Product Availability Matrix (PAM) at http://support.sap.com/pam# for
supported operating system versions.

To check the operating system version on your installation hosts, use the following
command:

uname -r
See SAP Note 939891/ for information about support time frames of HP-UX.

The following patches are required for HP-UX 11.31: PHSS_37493, PHSS_36352,
PHKL_37802, PHKL_42687
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Requirement

Values and Activities

Linux: Operating system version

Your operating system platform must be 64-bit.

Check the Product Availability Matrix (PAM) at http://support.sap.com/pam i for
supported operating system versions.

Contact your OS vendor for the latest OS patches.

To check the operating system version on your installation hosts, use the following
command:

cat /etc/*-release

|On|y valid for 'Platform': Linux

If you are installing on SUSE Linux Enterprise Server (SLES), see SAP Note
1275776 F% to prepare SLES for SAP environments.

|End of 'Platform': Linux |

Linux Secure Enabled Linux (SELi-
nux) Mode

Set Linux Secure Enabled Linux (SELinux) | SELinux mode to Permissive or Disabled
on all SAP System hosts for the installation procedure. For more information, see
SAP Note 32477907k .

Oracle Solaris: Operating system

version

Your operating system platform must be 64-bit.

Check the Product Availability Matrix (PAM) at http://support.sap.com/pam i for
supported operating system versions.

To check the operating system version on your installation hosts, use the following
command:

/bin/uname -r

SAP Kernel Releases and Versions

For more information about release and roadmap information for the SAP Kernel
versions, and how this relates to SAP system support packages - including impor-
tant notes on downward compatibility and release dates - see the central SAP Kernel
notes:

To use regular software provisioning manager (SWPM10<Version>.SAR) with SAP
kernel up to 753 on RHEL 6 or SLES 11 or Oracle Linux 6, you must install the re-

quired libstdc++ RPM packages. For more information, see SAP Note 2195019 # .

AIX: Kernel parameters

To adjust the settings for asynchronous |/0 if the database is installed using file
systems, see SAP Note 1972803 #

To adjust AIX Virtual Memory Management settings, see SAP Note 973227 #r .
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Requirement

Values and Activities

HP-UX: Kernel parameters

To run an SAP system, make sure that you check and, if necessary, modify the
HP-UX kernel.

A Caution

We recommend that a UNIX system administrator performs all kernel modifica-
tions.

Proceed as follows:

1. Check SAP Note 172747 #& for recommendations on current HP-UX kernel pa-
rameters.

A Caution

If a kernel value is already larger than the one suggested in the SAP Note,
do not automatically reduce it to match the SAP requirement.

You have to analyze the exact meaning of such a parameter and, if required,
to reduce the parameter value. In some cases this might improve the per-
formance of your SAP applications.

2. If necessary, modify the kernel parameters in one of the following ways:
* Manually, as described in SAP Note 172747 Far .

® Interactively, using the HP-UX System Administrator Manager (SAM) or
System Management Homepage (SMH).

Linux: Kernel parameters

Check SAP Note 2369910#% for Linux kernel versions certified by SAP.

To check the Linux kernel parameters for your Linux distribution, see one of the
following SAP Notes:

* SLES15: SAP Note 2578399 #tr

® SLES12: SAP Note 1984787 ¥

* RHELS: SAP Note 2772999 Fr
® RHEL7: SAP Note 2002167 ¥t
* RHELG6: SAP Note 1496410 #

Oracle Solaris: Kernel parameters

To run an SAP system, you must check and, if necessary, modify the Oracle Solaris
kernel parameters or resource controls.

*  Oracle Solaris 10: SAP Note 724713 ¥
®  Oracle Solaris 11: SAP Note 1797712 #

HP-UX: OS patches

To check the minimum required OS patches, see SAP Note 837670 % .

Oracle Solaris: OS patches

Check the relevant SAP Note for required Oracle Solaris patches:

*  Oracle Solaris 10 on SPARC: SAP Note 832871
®  Oracle Solaris 11: SAP Note 1797712 #
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Requirement

Values and Activities

AIX: National Language Support
(NLS)

Make sure that National Language Support (NLS) and corresponding locales are
installed.

HP-UX: National Language Support
(NLS)

Make sure that National Language Support (NLS) and corresponding locales are
installed.

You can check this as follows:

® Enter the following commands to check whether National Language Support
(NLS) is installed:
swlist -v | grep -i nls
The output should contain the string NLS-AUX . ..
® Enter the following commands to check which locales are available:
locale -a
The following files must be available: de_DE. 1s088591, en_US. iso88591.

Linux: National Language Support
(NLS)

Make sure that National Language Support (NLS) and corresponding locales are
installed.

You can check this as follows:

¢ Ensure that the required locales such as the following are available:
de_DE, en_US

® Check SAP Note 187864 #% for information about corrected operating system
locales and SAP blended Code Pages.

Oracle Solaris: National Language
Support (NLS)

Make sure that National Language Support (NLS) and corresponding locales are
installed.

Enter the following command to check which locales are available:
locale -a

The following locale must be available: en_US. 1S08859-1

System language

For the installation, you must choose English as the operating system language on
all hosts that run SAP software.
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3.3.2.4 Other Requirements

Every installation host must meet at least the requirements listed in the following tables. Most of the
requirements are valid for every installation host whereas some requirements are instance-specific and are
marked accordingly.

Other Requirements

Requirement Values and Activities

Minimum Web Browser Make sure that you have at least one of the following web browsers installed on the host
where you run the software provisioning manager's SL-Ul:
® Microsoft Internet Explorer 11 or higher
® Microsoft Edge
® Mozilla Firefox

® Google Chrome
Always use the latest version of these web browsers.

You need a web browser to be able to run the SL-Ul, and to display the Evaluation Form
and send it to SAP.

AIX: Additional software Make sure that the following additional file sets are installed:

®* bos.adt.* - Base Application Development
® bos.perf.* - performance and diagnostics tools

® perfagent.tools - performance monitoring tools

Host name To find out physical host names, open a command prompt and enter hostname.

For more information about the allowed host name length and characters allowed for
SAP system instance hosts, see SAP Note 611361 #4r .

[Only valid for 'Platform': HP-UX \

For HP-UX, see SAP Note 1503149#% in addition.

| End of 'Platform': HP-UX |

If you want to use virtual host names, see SAP Note 962955 #r .
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Requirement Values and Activities

Login shell The software provisioning manager only prompts you for this parameter if you use a login
shell other than C shell (csh).

For more information, see SAP Note 202227 .

[Only valid for 'Platform": HP-UX ‘

For HP-UX, see SAP Note 1038842 #% in addition.

| End of 'Platform': HP-UX |

SAP Host Agent installation:

® Make sure that /bin/false can be used as a login shell.

* [Only valid for Platform’: AIX \
AlX only: Add /bin/false to the list of valid login shells (attribute shel Is)

in /etc/security/login.cfg.
| End of 'Platform'’: AIX |

HP-UX: Mount and file system For recommendations about block size and mount option configuration, see SAP Note
configuration 1077887 Far .

Shared file systems for decen- If application servers are installed decentralized, a “shared” file system must be installed,
tralized systems for example Network File System (NFS).

AIX: C++ Runtime environment  Minimal C++ runtime requirements for the specific SAP Kernel releases are listed in SAP
Note 1780629 Fr .

3.4 Planning User and Access Management

You have to plan how to configure user and access management for the SAP system to be installed.

Before you add a newly installed SAP system to your system landscape, you must decide which kind of user
management you want to use:

* Central User Administration (CUA)
* An LDAP directory as the data source for user data

Procedure

To specify the initial data source of the User Management Engine (UME), proceed as described in Specifying
the Initial Data Source of the User Management Engine [page 116].
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More Information

For more information about configuring the user management of your SAP system to be installed, see the SAP
Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package
1

http://help.sap.com/nw731#r

®* SAP NetWeaver 7.4
http://help.sap.com/nw74fhv Configuration of User and Role Administration > Directory

|} Application Help > SAP NetWeaver Library: Function-
Oriented View > Security > Identity Management > User
and Role Administration of Application Server ABAP >

*  SAP NetWeaver 7.5 Services » LDAP Connector 4
http://help.sap.com/nw75"%
® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap
® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap i

3.5 Basic Installation Parameters

The software provisioning manager prompts for input parameters during the Define Parameters phase of the
installation.

You can install your SAP system either in Typical or Custom mode:

* Typical
If you choose Typical, the installation is performed with default settings. This means that the software
provisioning manager prompts you only for a small selection of installation parameters. These parameters
include at least the following:

¢ SAP system ID and database connectivity parameters

* Master password

¢ SAP system profile directory — only for systems with instances on separate hosts

* SAP systems based on SAP NetWeaver 740 and higher: Individual encryption key for the secure

storage
For more information about the installation parameters, see the corresponding tables below in this
document. If you want to change any of the default settings, you can do so on the Parameter Summary
screen.
* Custom

If you choose Custom, you are prompted for all parameters. At the end, you can still change any of these
parameters on the Parameter Summary screen.
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® Note

You cannot change from Custom to Typical mode or from Typical to Custom mode on the Parameter
Summary screen.

® Note

* If you want to ASCS Instance with Embedded SAP Web Dispatcher [page 32], you must choose
Custom. Otherwise, you are not prompted for the SAP Web Dispatcher installation parameters [page
69] during the Define Parameters phase of the ASCS instance installation.

* If you want to ASCS Instance with Embedded Gateway [page 34], you must choose Custom. Otherwise,
you are not prompted for the SAP Gateway installation during the Define Parameters phase of the
ASCS instance installation.

The tables in the sections below list the basic SAP system installation parameters that you need to specify
before installing your SAP system. For all other installation parameters, use the tool help on the software
provisioning manager screens.

Related Information

SAP System Parameters [page 55]

SAP System Database Parameters [page 65]

Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2 [page 66]
Additional Parameters When Using a Stack XML File [page 67]

Parameters for Additional Components to be Included in the ASCS Instance [page 69]

3.5.1 SAP System Parameters

The tables in this section lists the basic SAP system installation parameters that you need to specify before
installing your SAP system. For all other installation parameters, use the tool help on the software provisioning
manager screens.

General Parameters

Parameter Description

Unicode System  Every new installation of an SAP system is Unicode.
SAP systems based on SAP NetWeaver 7.5 or higher are Unicode only.

If you install an additional application server instance in an existing non-Unicode system (that has been
upgraded to the current release), the additional application server instance is installed automatically
as a non-Unicode instance. The software provisioning manager checks whether a non-Unicode system
exists and chooses the right executables for the system type.
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Parameter Description

SAP SystemID  The SAP system ID (<SAPSID>) identifies the entire SAP system.

<SAPSID>
The software provisioning manager prompts you for the <SAPS1D> when you execute the first installa-

tion option to install a new SAP system.

If there are further installation options to be executed, the software provisioning manager prompts you
for the profi le directory. For more information, see the description of the parameter SAP System
Profile Directory.

< Example

This prompt appears when you install the ASCS instance, which is the first instance to be installed in
a distributed system.

A Caution

Choose your SAP system ID carefully since renaming requires considerable effort.

Make sure that your SAP system ID:

® Isunique throughout your organization. Do not use an existing <SAPSID> when installing a new
SAP system.

® Consists of exactly three alphanumeric characters

® Contains only uppercase letters

® Has aletter for the first character

® Does not include any of the reserved IDs listed in SAP Note 1979280 #r .

® If you want to install an additional application server instance, make sure that no Gateway instance
with the same SAP System ID (SAPSID) exists in your SAP system landscape.
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Parameter Description

SAP System In-  Technical identifier for internal processes. It consists of a two-digit number from 00 to 97.

stance Numbers
The instance number must be unique on a host. That is, if more than one SAP instance is running on the

same host, these instances must be assigned different numbers.

If you do not enter a specific value, the instance number is set automatically to the next free and valid
instance number that has not yet been assigned to the SAP system to be installed or to SAP systems
that already exist on the installation host.

To find out instance numbers of SAP systems that already exist on the installation host, look for subdir-
ectories ending with <Instance Number> of local (not mounted) Zusr/sap/<SAPSID> directories.

For more information about the naming of SAP system instances, see SAP Directories [page 82].

| Only valid for 'Platform': AIX

A Caution

AlX only: If you are using NIM Service Handler (NIMSH), do not use 01 or O2 for the instance
number. The software provisioning manager uses the instance number for the internal message
server port 39<Instance Number>. The NIM client daemon uses reserved ports 3901 and 3902.

| End of 'Platform’: AIX |

|On|y valid for 'Platform': HP-UX |

A& Caution
HP-UX only: Do not use:

¢ 75 for the instance number because this number is already used by the operating system. For
more information, see SAP Note 29972 Fr .

® 02 asthe instance number because this number is used to determine the port number for
report RSLGCOLL, which is 14<Instance Number> by default. However, port 1402 is already
used by the OS process rstlisten. If you still decide to use 02 as the instance number, the
instance fails to start during the installation process. You then have to manually change the
port number for report RSLGCOLL to continue with the installation. For more information, see
Running Software Provisioning Manager [page 121].

| End of 'Platform': HP-UX
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Parameter

Description

Virtual Host
Name

Virtual host name (network name) of the SAP<SAPSID> cluster group
You can assign a virtual host name to an SAP instance in one of the following ways:

® You can assign a virtual host name for the instance to be installed, by specifying it in the
<Instance Name> Host Name field of the <Instance Name> /nstance screen. Then this instance
is installed with this virtual host name.

® Alternatively you can assign virtual host names also by starting the software provisioning manager
with the SAPINST_USE_HOSTNAME property. For more information, see Running Software Provi-
sioning Manager [page 121].

After the installation has completed, all application servers can use this virtual host name to connect to
the instance. If you do not provide the virtual host name, the instance is installed automatically using the
physical host name of the host where you run the software provisioning manager.

You must have already reserved the virtual host name (network name) and its IP address on a DNS
server before you run the software provisioning manager. For more information, see Using Virtual Host
Names [page 91].

® Note

Fully qualified host names, IPv4, IPv6 are not accepted as virtual host names.

SAP Process
Integration (PI)
7.5, SAP Solu-
tion Manager
7.2:

Application
Server Gateway
Communication
Setup

Java system on a host If you want to install the primary application server instance of the different
from the host of the primary application server instance of the ABAP system, then you must specify the
host of the Java primary application server instance during the Define Parameters phase of the primary
application server instance installation of the ABAP system.

This is to set up the connection between the ABAP and the Java system.

SAP System Pro-
file Directory

/<sapmnt>/<SAPSID>/profi lelf you want to install the primary application server instance of the
or /usr/sap/<SAPSID>/SYS/profile

The software provisioning manager retrieves parameters from the SAP system profile directory of an
existing SAP system.

SAP profiles are operating system files that contain instance configuration information.

The software provisioning manager prompts you to enter the location of the profi le directory when
the installation option that you execute is not the first one belonging to your SAP system installation,
for example, if you are installing a distributed system or an additional application server instance to an
existing SAP system. See also the description of the parameters SAP System ID and Database ID.

/usr/sap/<SAPSID>/SYS/profile is the soft link referring to /<sapmnt>/<SAPSI1D>/profile.
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Parameter

Description

Master Password Common password for all users that are created during the installation:

Operating system users (for example <sapsid>adm)

A Caution

If you did not create the operating system users manually before the installation, the software
provisioning manager creates them with the common master password (see Operating System
Users). In this case, make sure that the master password meets the requirements of your
operating system.

ABAP users: SAP*, DDIC, and EARLYWATCH.

Secure Store key phrase
SAP systems based on SAP NetWeaver 7.4 and Higher: For more information, see line Key Phrase
for Secure Store Settings and line Individual Encryption Key for the Secure Storage in this table.

A Caution

The software provisioning manager applies the master password to users SAP*and DDIC for SAP
system clients 000 and 001 only, but not to users SAP*, DDIC, and EARLYWATCH in SAP system
client 066.

Instead, the software provisioning manager always assigns the following passwords to these users
in client 066:

SAP*: 06071992
EARLYWATCH: support

See also Ensuring User Security.

Basic Password policy

The master password must meet the following requirements:

It can be 8 to 30 characters long
It must contain at least one letter (a-z, A-Z)
It must contain at least one digit (0-9)

It must not contain \ (backslash) or ** (double quote).

Additional restrictions depending on SAP Adaptive Server Enterprise:

It must be at least 6 characters long
It can only contain the following characters: a-z, A-Z, 0-9, <space>, 1#$%&" () *+,-./:<=>7?

e1™_"{I3

Depending on the installation option, additional restrictions may apply.

- Recommendation

The Master Password feature can be used as a simple method to obtain customer-specific pass-
words for all newly created users. A basic security rule is not to have identical passwords for differ-
ent users. Following this rule, we strongly recommend individualizing the values of these passwords
after the installation is complete.
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Parameter

Description

For more information, see Ensuring User Security [page 164].

Message Server
Access Control
List

You can specify if you want to have a message server Access Control List (ACL) created.

The ACL is created as a file in the /<sapmnt>/<SAPSID>/global directory. If it exists, it defines the

hosts from which the message server accepts requests.

A Caution

Only trigger the creation of this file if you do not plan to install any additional instances for this
system. With the creation of this ACL, you overwrite existing settings and prevent instances from
being installed on additional hosts. If you decide to install an additional instance later, you need
to remove this file manually before the installation and create it again after the installation of the
additional instance.

For more information, see the information about ms/acl_info in SAP Notes 1495075%% and
826779 .

SAP systems
based on SAP
NetWeaver 7.4

and Higher only:

Individual En-
cryption Key for
the Secure Stor-
age

You can set a randomly generated individual encryption key for the secure storage in the file system and

the secure storage in the database. If you skip this step, the system is installed with a default key which

provides obfuscation only, but it can be changed later.

For more information on the secure storage in the file system, see the SAP Library - depending on
the SAP NetWeaver release your SAP system is based on - at:

http://help.sap.com/nw74

http://help.sap.com/nw75

https://help.sap.com/nw75labap
https://help.sap.com/nw752abap #r
|} Application Help > Function-Oriented View > Security > System Security > System Security for

SAP NetWeaver AS ABAP Only # Secure Storage in the File System (AS ABAP) 4

For more information on the secure storage in the database, see the SAP Library - depending on the
SAP NetWeaver release your SAP system is based on - at:

http://help.sap.com/nw74

http://help.sap.com/nw75

https://help.sap.com/nw75labap

https://help.sap.com/nw752abap

| 2 Application Help » Function-Oriented View ¥ Security > System Security > System Security for
SAP NetWeaver AS ABAP Only > Secure Storage (ABAP) > Key Management > Using Individual
Encryption Keys } Generating Encryption Keys }
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Parameter

Description

DNS Domain If you want to use HTTP-based URL frameworks such as Web Dynpro applications, you have to specify
Name for SAP the DNS domain name for the SAP system.
System
Y The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN), which is con-
figured in profile parameter SAPLOCALHOSTFULL. FQDN is the fully qualified domain name for an IP
address. It consists of the host name and the domain name:
<Host_Name>.<Domain_Name>
The DNS Domain Name is needed to define the URLs for the ABAP application servers. It is appended to
the server name to calculate the FQDN.
% Example
If your application server host is called kirk .wdf.sap . com, the DNS Domain Name is
wdf.sap.com.
SAP Host Agent  If there already exists an SAP Host Agent on the installation host, the software provisioning manager
Upgrade (Op- asks you if you want to upgrade it to a newer patch level version. If you want the existing version to be
tional) upgraded, you must provide the new target version of the SAPHOSTAGENT<Version>.SAR archive.
For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page 100]
Ports
Parameter Description
ABAP Message Server Port A Caution

The message server port number must be unique on the host where the message
server for the SAP system is running. If there are several message servers running on
one host, the message server ports must all be unique.

If you do not specify a value, the default port number is used.
ABAP Message Server Port

There is an external messagev server port and an internal message server port.

The ABAP message server uses both the internal and the external message server ports.
The default profile contains the configuration for both message server ports.

The external message server port uses the parameter rdisp/msserv with default value
36<ABAP_Message_Server_Instance_Number>.

The internal message server port uses the parameter rdisp/msserv_internal with
default value 39<ABAP_Message_Server_Instance_Number>.

During the installation of an SAP system from scratch or an additional application server
instance to an existing SAP system , the message server is configured to only accept secure
connections. The DEFAULT.PFL profile parameter system/secure_communication
is set to ON (system/secure_communication = ON) if the kernel supports secure

connections to the message server. For more information, see SAP Note 2040644 # .
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Operating System Users

Parameter Definition
Operating System Users and Groups The software provisioning manager processes the operating system users as
follows:

® |If the operating system users do not exist, the software provisioning man-
ager creates the following users:
®* The SAP system administrator user <sapsid>adm
¢ Database administrator users
The software provisioning manager sets the master password for these
users by default. You can overwrite and change the passwords either by
using the parameter mode Custom or by changing them on the parameter
summary screen.
® If the operating system users already exist, the software provisioning man-
ager prompts you for the existing password, except if the password of these
users is the same as the master password.
® Make sure that the user ID and group ID of these operating system users are
unique and the same on each relevant application server instance host.

The sapinst_instdir directory belongs to a group named sapinst. If this
group is not available, it is created automatically as a local group. For security
reasons, we recommend removing the operating system users from the group
sapinst after the execution of the software provisioning manager has com-
pleted.

During the Define Parameters phase of the software provisioning manager, you
can specify that the operating system users are to be removed automatically
from the group sapinst after the execution of the software provisioning man-
ager has completed.

For more information about the group sapinst, see Creating Operating System
Users and Groups [page 77].

For more information about the sapinst_instdir directory, see Useful Infor-
mation about Software Provisioning Manager [page 128].

User Management Engine Parameters

Parameter Definition
Java Administrator User The software provisioning manager creates this user in the
ABAP system.
® Note

After the installation, this user is available both in the ABAP

This user is only created during the installation of the and in the Java system.

application server ABAP for an SAP NetWeaver 7.5 Proc-
ess Integration (PI) system or for an SAP Solution Man-  The software provisioning manager sets the user name
ager 7.2 system. J2EE_ADMIN and the master password by default.

If required, you can choose another user name and pass-
word according to your requirements.
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Parameter

Definition

Java Guest User

® Note

This user is only created during the installation of the

application server ABAP for an SAP NetWeaver 7.5 Proc-

ess Integration (PI) system or for an SAP Solution Man-
ager 7.2 system.

This user is for employees who do not belong to a company
or who have registered as company users and who are wait-
ing for approval. Guest users belong to the default group
Authenticated Users.

The software provisioning manager creates this user in the
ABAP system.

After the installation, it is available both in the ABAP and in
the Java system.

The software provisioning manager sets the user name
J2EE_GUEST and the master password by default.

If required, you can choose another user name and pass-
word according to your requirements.

For more information about supported UME data sources
and change options, see SAP Note 718383 #r .

Communication User

® Note

This user is only created during the installation of the

application server ABAP for an SAP NetWeaver 7.5 Proc-

ess Integration (PI) system or for an SAP Solution Man-
ager 7.2 system.

The software provisioning manager creates this user in the
ABAP system.

After the installation, it is available both in the ABAP and in
the Java system

This user is used for the communication between the ABAP
system and the Java system.

The software provisioning manager sets the user name
SAPJSF and the master password by default.

If required, you can choose another user name and pass-
word according to your requirements.

For more information about supported UME data sources
and change options, see SAP Note 718383 #r .
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System Landscape Directory

Parameter

Definition

SLD Destination for the System

The System Landscape Directory (SLD) registers the systems and the installed software

of your entire system landscape.
You can choose between the following options:

® Register in existing SLD

Choose this option to register the SAP system you are installing in an existing SAP

System Landscape Directory (SLD) by specifying the SLD connection parameters

listed below in this table.
® No SLD destination

Choose this option if you do not want to register the SAP system you are installing

in an existing SAP System Landscape Directory (SLD).

You then have to configure the SLD destination manually after the installation has

finished.

For more information, see Performing Post-Installation Steps for the ABAP Application

Server [page 158]

SLD Host

The host name of the existing SLD.

SLD HTTP(S) Port

HTTP port of the SAP system based on AS Java on which the System
Landscape Directory (SLD) resides. The following naming convention applies:
5<Primary_Application_Server_Instance_Number>00.

% Example

If the primary application server instance number of the AS Java on which the

System Landscape Directory (SLD) resides is 01, the SLD HTTP Port is 50100.

SLD Data Supplier User and

The existing SLD Data Supplier user and password of the existing SLD

password
Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
64 PUBLIC Planning



3.5.2 SAP System Database Parameters

Parameters

Description

Database ID <DBSI1D>

The <DBSID> identifies the database instance. The software provisioning manager prompts
you for the <DBSID> when you are installing the database instance.

The <DBSID> must be the same as the <SAPSID>.

A Caution

Choose your database ID carefully. Renaming is difficult and requires you to reinstall the
SAP system.

® If you want to install a new database:
Make sure that your database ID:

® Is unique throughout your organization

® Consists of exactly three alphanumeric characters
® Contains only uppercase letters

® Has aletter for the first character

*  Does not include any of the reserved IDs listed in SAP Note 1979280 ¥ .

ABAP Database User
(SAPSR3)

The user name corresponds to the owner of the database tables.

Database user for data-
base system administra-
tion (sapsa)

This is the default user for database monitoring and administration.

Database user for data-
base system security tasks
(sapsso)

This is the default user for security relevant tasks such as user creation and password setup.

Database Communication
Port

The database server communication port is used for TCP/IP communication between the
database server and remote clients. In a standard system installation and for the database
instance in a distributed installation, the software provisioning manager always proposes 4901
as default.

Add sapdata/saplog Di-
rectories

Database devices are stored in the following directories:

[Only valid for 'Platform': Linux ‘

//<DBSID>/sapdata_<n> and

l End of 'Platform': Linux ‘

[Only valid for 'Platform": Linux ‘

//<DBSID>/saplog_<n>

l End of 'Platform': Linux ‘

You can create additional sapdata, saplog directories before you start the software provision-
ing manager. To distribute database devices, use separate file systems for the directories.
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Parameters Description

Database Memory 2.1 GB RAM (hard-coded)

3.5.3 Additional Parameters when Installing SAP Process
Integration 7.5 or SAP Solution Manager 7.2

The parameters in this section are only required if you want to install SAP Process Integration 7.5 or SAP

Solution Manager 7.2.

Parameter

Description

When Using a Stack XML File:

SAP System ID <SAPSI1D>

When Installation Using a Stack XML File [page 37], in addition to
the requirements listed in using a stack configuration file [page
55] |} > General Parameters > SAP System ID ] make sure
that the SAP system ID (SAPSID) of the ABAP system must be
different from the SAPSID of the Java system.

Communication Port for ABAP

For a secure communication of connected SAP systems to the
ABAP stack you have to define the HTTPS port that is to be
configured in the application server instance profile. Further
post-installation steps [page 161] are required to fully enable
HTTPS communication. For more information about HTTPS ena-
blement, see SAP Note 510007 #r .

In addition you can configure an HTTP port. However, this is
not recommended for productive SAP systems due to security

reasons.

- Recommendation

If you are about to install an SAP NetWeaver 7.5 Process
Integration system and you intend to run automated con-
figuration using the Central Technical Configuration (CTC)
Wizard after the installation, it is strongly recommended
that you configure the ABAP communication port for ABAP
already during the installation process, because you can only
run the CTC Wizard if the ABAP port is either completely
configured for HTTPS or optionally for HTTP. For more infor-
mation, see PI: Configuring the Process Integration System
After the Installation in Installation of SAP Systems Based on
the Application Server Java of SAP NetWeaver 7.5 and SAP
Solution Manager 7.2 SR2 Java on UNIX: <Database>.
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Parameter

Description

Application Server Gateway Communication Setup

If you want to install the primary application server instance of
the Java system on a host different from the host of the primary
application server instance of the ABAP system, then you must
specify the host of the Java primary application server instance
during the Define Parameters phase of the primary application
server instance installation of the ABAP system.

This is to set up the connection between the ABAP and the Java
system.

3.5.4 Additional Parameters When Using a Stack XML File

The parameters in this section are only required if you use a Stack XML file generated from the Maintenance

Planner.

Parameter

Description

SAP Process Integration (PI) 7.5, SAP Solution
Manager 7.2:

SAP System ID <SAPSI1D>

In addition to the requirements listed in SAP System Parameters [page
55] |} > General Parameters > SAP System ID } make sure that the

SAP system ID (SAPSID) of the ABAP system must be different from
the SAPSID of the Java system.

Transport Domain

The ABAP Transport Management System (TMS) must be configured
before ABAP correction packages can be applied. You can also run the
configuration or even reconfigure the TMS after the installation has
finished.

To be able to transport changes between the SAP systems in your sys-
tem landscape, you need to configure the Transport Management Sys-
tem (TMS) for all SAP systems in your system landscape and configure
one transport domain controller. To start the TMS in your ABAP system
for later reconfiguration, call transaction STMS. At least one transport
landscape with this system as transport domain controller is required
before you can apply corrections, support packages, or upgrades to the
SAP system.

The name of the Transport Domain must not contain blank characters.
You cannot change the name afterwards without reconfiguring the
transport domain controller and thereby the entire Transport Domain.

By default use DOMAIN_<SAPSID> for the Transport Domain of a single
transport landscape with this system as transport domain controller.
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Parameter Description

Directory with Transport Files Location of the ABAP transport files that are to be included after the
ABAP load during the installation. All transport files in this directory are
imported with the transport control program (tp).

Location of SPAM/SAINT Update Archive A SPAM/SAINT update contains updates and improvements to the
Support Package Manager (SPAM) and the Add-On Installation Tool
(SAINT). Provide the full path to the SPAM/SAINT update archive.

SPAM/SAINT is delivered with the ABAP load. SAP recommends that
you always use the latest version of SPAM/SAINT before applying Sup-
port Packages.

Decide whether you want to prepare for the Soft- ~ With the Software Update Manager (SUM), you can apply support pack-
ware Update Manager run at the end of the instal- ages stacks at the end of the installation.

lation ® Do not start SUM automatically

® Start SUM automatically at the end of the installation
Choose to start SUM automatically, if you want to have the SUM
STARTUP script called in the default <Update Directory>/SUM/
directory at the end of the installation.

Extract the SUM*_SAR Archive If you choose to extract the SUM* . SAR archive, the provided archive is
validated and extracted to the default update directory:

UNIX and IBM i: Zusr/sap/<SAPSID>/

SUMHTTP port If you are running several SAP system updates on the same host, you
have to use different port numbers for each update. You can adjust the
default SUM HTTP port by entering the required port number in the
SUM HTTP Port field. When doing so you set the SUM GUI Port number
to (=<HTTP port number+2>). Dependencies See also the Soft-
ware Update Manager documentation at: https://support.sap.com/en/

tools/software-logistics-tools/software-update-manager.htmi| ¥

SUM Batch Input File You can specify a batch file with some default values for the up-
date. SUM then starts with parameter batchfile=<XML file with
input parameters>.

Enter the full path to the existing batch file.

Placeholders like @PARAMETER_VALUEQ inside the file are replaced by
values known from the installation.
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Parameter Description

Install Additional SAP System Languages A set of default languages is delivered with the ABAP load. From the
language media delivered with your product version or - if already pro-
vided by the Maintenance Planner for the respective product - using
language archives, you can select additional languages that you want to
have installed during SAP system installation.

If you want to install additional languages, you must provide the direc-
tory with the additional language packages for the ABAP installation
load, for example with subdirectories like DATA_UNITS/ES.

For more information, see Installation Using a Stack XML File (Optional) [page 37].

Related Information

Installation Using a Stack XML File [page 37]

3.5.5 Parameters for Additional Components to be Included
in the ASCS Instance

You only need to specify the following parameters during the ASCS instance installation if you perform an
embedded installation of additional components.

® Note

You must choose Custom parameter mode. Otherwise you are not prompted for the parameters related to
these additional components during the Define Parameters phase.

Parameters Description

Install a gateway embedded in the ASCS When processing the screens for the ASCS instance installation, you are

instance prompted to mark this checkbox on the screen Additional Components to be
Included in the ASCS Instance.

Install an SAP Web Dispatcher embed- When processing the screens for the ASCS instance installation, you are

ded in the ASCS instance prompted to mark this checkbox on the screen Additional Components to be

Included in the ASCS Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the
additional parameters required for the SAP Web Dispatcher installation on the
subsequent screens:
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Parameters Description

Message Server Host

The name of the host on which the message server is located (profile parameter
rdisp/mshost)

Message Server HTTP Port

HTTP port of the message server (profile parameter ms/server_port_<xx>)

Password for the Internet Communication Management (ICM) user

In order to use the web administration interface for the Internet Communication
Manager (ICM) and SAP Web Dispatcher, an administration user webadm is
created by the software provisioning manager.

You have to assign a password for this user.

Related Information

ASCS Instance with Embedded SAP Web Dispatcher [page 32]
ASCS Instance with Embedded Gateway [page 34]

3.6 Setup of Database Layout

® Note

The following sections apply especially to the installation of a production system.

When you plan your SAP system installation, it is essential to consider the setup of your database layout with
regard to the distribution of SAP directories or database file systems to disks. The distribution depends on
your specific environment and you must take factors into consideration, such as storage consumption of the
software components involved, safety requirements and expected workload.

Required File Systems for SAP ASE

To ensure that your SAP system performs well in a production environment, you have to create separate file
systems manually for the directories listed in the following table before you start the software provisioning
manager. The file systems must have the permission value 750, the owner syb<dbsid>, and the group
sapsys.

The software provisioning manager creates the file systems, user, group and permissions automatically, if the
directories have not been created before the installation.
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During the installation of your SAP system, you can specify the number and names of the sapdata directories.
The software provisioning manager allows to place several data or log devices in one sapdata or saplog
folder. You can create additional sapdata and saplog directories before you start the software provisioning

manager.

The following table lists the file systems that are required by the SAP ASE database:

File System / Logical Volume:

Description:

/sybase/<DBSID>

SAP ASE software ($SYBASE)

Size: at least 6 GB

/sybase/<DBSID>/sybsystem

Location for devices master.dat, sybmgmtdb.dat, sybsysdb.dat,
sysprocs.dat

Size: at least 1 GB

/sybase/<DBSID>/sybtemp

Location for device tempdb

Size: at least 4 GB

/sybase/<DBSID>/saptemp

Location for device saptempdb

Size: at least 6 GB

/sybase/<DBSID>/sapdiag

Location for devices containing the database saptools.

Size: at least 5 GB

/sybase/<DBSID>/sapdata_<n>

Location for devices containing data

For more information, see SAP Note 1748838 #r .

/sybase/<DBSID>/saplog_<n>

Location for devices containing logs

For more information, see SAP Note 1748838 #r .

/sybase/<DBSID>/sybsecurity

Location for devices containing the database sybsecurity
Size: at least 1 GB for monitoring SAP ASE configuration changes

For advanced SAP ASE audit options, you must adapt the size
according to the enabled options and the workload of your sys-
tem. You can place the devices containing the optional database
sybsecurityarchive at this location. For more information, see
SAP ASE 16.0: Auditing with SAP Adaptive Server Enterprise [page
1771].

For information about SAP file systems, see SAP Directories [page 82].
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3.7 SAP System Transport Host

The transport host contains the transport directory used by the SAP transport system to store transport data
and change SAP system information, such as software programs, write dictionary data, or customizing data.
If you have several SAP systems it depends on your security requirements whether you want them to share a
transport directory or whether you use separate directories.

When you install an SAP system, you have to decide which transport host and directory you want to use for
your SAP system:

Use the transport directory that the software provisioning manager creates during the installation of the
SAP system by default on the global host.

The software provisioning manager by default creates the transport directory on the global host

in /usr/sap/trans.

Use a transport directory located on a host other than the default host:

You can use an existing transport directory and host in your SAP system landscape.

You can set up a new transport directory on a different host.

More Information

72

Release

In either case, you must prepare this host for use by the new SAP system. For more information, see
Exporting and Mounting the Global Transport Directory [page 113].

Required File Systems and Directories [page 82]
See the SAP Library at:

SAP Library Path

SAP NetWeaver 7.3 including Enhancement

Package 1
http://help.sap.com/nw731 %

SAP NetWeaver 7.4
http://help.sap.com/nw74

SAP NetWeaver 7.5
http://help.sap.com/nw75 "

SAP NetWeaver Application Server for
ABAP 7.51 innovation package
https://help.sap.com/nw75labap P
SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|+ Application Help ¥ Function-Oriented View ¥ Solution Life Cycle
Management > Software Logistics > Change and Transport System
» Change and Transport System — Overview ¥ Basics of the
Change and Transport System > Transport Management System —

Concept 4
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3.8 Planning the Switchover Cluster for High Availability

This section describes basic aspects of planning the switchover cluster for a high-availability system.

You can reduce unplanned downtime for your SAP system by setting up a switchover cluster. This setup
installs critical software units — known as “single points of failure” (SPOFs) — across multiple host machines
in the cluster. In the event of a failure on the primary node, proprietary switchover software automatically
switches the failed software unit to another hardware node in the cluster. Manual intervention is not required.
Applications trying to access the failed software unit might experience a short delay but can then resume
processing as normal.

Switchover clusters also have the advantage that you can deliberately initiate switchover to release a
particular node for planned system maintenance. Switchover solutions can protect against hardware failure
and operating system failure but not against human error, such as operator errors or faulty application
software. Additional downtime might be caused by upgrading your SAP system or applying patches to it.

Without a switchover cluster, the SAP system SPOFs — central services instance, the database instance, and
the central file share — are vulnerable to failure because they cannot be replicated. All of these can only exist
once in a normal SAP system.

You can protect software units that are not SPOFs against failure by making them redundant, which means
simply installing multiple instances. For example, you can add additional application server instances. This
complements the switchover solution and is an essential part of building high availability (HA) into your SAP
system.

-> Recommendation

We recommend switchover clusters to improve the availability of your SAP system.

A switchover cluster consists of:

* Ahardware cluster of two or more physically separate host machines to run multiple copies of the critical
software units, in an SAP system the SPOFs referred to above

¢ Switchover software to detect failure in a node and switch the affected software unit to the standby node,
where it can continue operating

* A mechanism to enable application software to seamlessly continue working with the switched software
unit — normally this is achieved by virtual addressing (although identity switchover is also possible)

Prerequisites

You must first discuss switchover clusters with your hardware partner because this is a complex technical area.
In particular, you need to choose a proprietary switchover product that works with your operating system.

We recommend that you read the following documentation before you start:

* Check the SAP High Availability pages at https://wiki.scn.sap.com/wiki/display/Sl/
SAP+High+Availability# . They contain crucial information about high-availability cluster certification and
certified high-availability partners.

* The ERS instance is essential for a high-availability system and should be controlled by the cluster
software. You need one ERS instance for the ASCS instance installed in your system.
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Features

® Note

The diagrams in this section are only examples. Only the instances relevant to the switchover are shown.

These diagrams summarize the overall setup and do not show the exact constellation for an installation
based on one of the available technologies.

You need to discuss your individual HA setup with your HA partner.

The following diagram shows the essential features of a switchover setup:
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Switchover Setup with ERS Instance and ASCS Instance in Different Failover Groups (Overview)
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The following diagram shows an example of a switchover setup in more detail:
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Switchover Setup with ERS Instance and ASCS Instance in Different Failover Groups (Schematic View)
Constraints

This documentation concentrates on the switchover solution for the central services instance. For more
information about how to protect the Network File System (NFS) software and the database instance by using
switchover software or (for the database) replicated database servers, contact your HA partner.

This documentation concentrates on the switchover solution for the central services instance. For more
information about how to protect the central file share and the database instance by using switchover software
or (for of the database) replicated database servers, contact your HA partner.

Make sure that your hardware is powerful enough and your configuration is robust enough to handle

the increased workload after a switchover. Some reduction in performance might be acceptable after an
emergency. However, it is not acceptable if the system comes to a standstill because it is overloaded after
switchover.
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4 Preparation

4.1 Preparation Checklist

This section includes the preparation steps that you have to perform for the following installation options:

¢ Standard, distributed, or high-availability system
¢ Additional application server instance

Detailed information about the steps are available in the linked sections.

Standard, Distributed, or High-Availability System

® Note

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a
standard system, you can ignore references to other hosts.

1. You check that the required Creating Operating System Users and Groups [page 77] are created.

2. You operating systemset up file systems [page 82] and make sure that the required disk space is available
for the directories to be created during the installation.

3. If you want to use virtual host names, you have to set the environment variable SAPINST_USE_HOSTNAME
[page 91].
Alternatively, you can specify a virtual host name either in the command to start the software provisioning
manager or - after the software provisioning manager has started - in the relevant field on the respective
instance screen (see Running Software Provisioning Manager [page 1217).

4. If you want to install a high-availability system, you perform switchover preparations [page 92].

5. If you want to share the transport directory trans from another system, export [page 113] this directory
to your installation hosts.

6. You install the SAP front-end software [page 92] on the desktop of the user.

7. You check that the required installation media [page 93] are available for each installation host.

8. If you decided to use a generic LDAP directory, you have to create a user for LDAP directory access [page
199].

9. You continue with Installation [page 108].
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Additional Application Server Instance

You have to perform the following preparations on the host where you install the additional application server
instances:

1. You check that the required operating system users and groups [page 77] are created.

2. You set up file systems [page 82] and make sure that the required disk space is available for the
directories to be created during the installation.

3. If you want to use virtual host names, you have to set the environment variable SAPINST_USE_HOSTNAME
[page 91].
Alternatively you can specify a virtual host name either in the command to start the software provisioning
manager or - after the software provisioning manager has started - in the relevant field on the respective
instance screen (see Running Software Provisioning Manager [page 121]).

4. If you want to share the transport directory trans from another system, export [page 113] this directory to
your installation hosts.

5. You install the SAP front-end software [page 92] on the desktop of the user.

6. You check that the required installation media [page 93] are available on each installation host.

7. You continue with Installation [page 108].

4.2 Creating Operating System Users and Groups

During the installation, the software provisioning manager checks all required accounts (users, groups) and
services on the local machine. The software provisioning manager checks whether the required users and
groups already exist. If not, it creates new users and groups as necessary.

The sapinst_instdir directory belongs to a group named sapinst. If this group is not available, it is
created automatically as a local group.

If you do not want the software provisioning manager to create operating system users, groups, and services
automatically, you can optionally create them before the installation is started. This might be the case if you
use central user management such as Network Information System (NIS).

For distributed installations, unless you are using global accounts or NIS, you must create the target users
automatically using the software provisioning manager or manually on the operating system, before starting
the installation :

A Caution

The user ID (UID) and group ID (GID) of SAP users and groups must be identical for all servers belonging to
an SAP system.

This does not mean that all users and groups have to be installed on all SAP servers.

The software provisioning manager checks if the required services are available on the host and creates
them if necessary. See the log messages about the service entries and adapt the network-wide (NIS) entries
accordingly.

The software provisioning manager checks the NIS users, groups, and services using NIS commands. However,
the software provisioning manager does not change NIS configurations.
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-> Recommendation

For a distributed or a high-availability system, we recommend that you distribute account information
(operating system users and groups) over the network, for example by using Network Information Service
(NIS)..

If you want to use global accounts that are configured on a separate host, you can do this in one of the following
ways:
* You start the software provisioning manager and choose |» Generic Installation Options ¥ <Database>

» Preparation » Operating System Users and Groups 4.
For more information, see Running Software Provisioning Manager [page 121].

* You create operating system users and groups manually. Check the settings for these operating system
users.

User Settings

° [ Only valid for 'Platform': Oracle Solaris
Oracle Solaris: If your operating system is Oracle Solaris 10 or higher, follow the parameter

recommendations for SAP applications in SAP Note 724713 .

| End of 'Platform': Oracle Solaris

° [ Only valid for 'Platform': AIX
AIX: Make sure that you have set the limits for operating system users as described in SAP Note
323816#% .

| End of ‘Platform': AIX

° [Only valid for 'Platform': HP-UX, Linux, Oracle Solaris
HP-UX, Oracle Solaris: Make sure that you have set the limits listed below for operating system users root,
<sapsid>adm, and your database-specific operating system users .
Linux: Starting with SUSE Linux Enterprise Server 15, Red Hat Enterprise Linux 8, and Oracle Linux 8,
and the respective SAP kernel patch levels, native support for the software suite systemd for Linux is
available for SAP systems. If you use Linux with systemd, ignore the following procedures for setting limits
because there's no need to change the limits. Make sure that polkit is installed. systemd requires polkit for
authorization checks for the <sapsid>adm user. For more information about Linux with systemd, see SAP
Note 3139184 .
If you are still using a Linux version or an SAP kernel patch that is not released for native systemd
support with SAP systems (see 3139184#%), proceed as follows: Make sure that you have set the limits
as outlined below for operating system users root, <sapsid>adm, and your database-specific operating
system users .

A Caution

Caution: the Iimit mechanism supports hard and soft limits. The soft limit cannot be bigger than
the hard limit. The hard limit can be set/increased by the root user like: Limit -h <limit>
<new_value>, for example limit -h datasize unlimited.
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* Using csh shell, the output of command limit needs to be at least as follows:
% Example

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

Output Properties
cputime unlimited
filesize unlimited
datasize unlimited
stacksize 8192 KB
coredumpsize unlimited
descriptors 8192
memoryuse unlimited

* Using sh or ksh shell, the output of command ulimit -aneeds to be at least as follows:

% Example

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

Output sh Output ksh Properties
cpu time (seconds) cpu time (seconds) unlimited
file size (blocks) file size (blocks) unlimited
data seg size (kbytes) data size (Kibytes) unlimited
stack size (kbytes) stack size (Kibytes) 8192 KB
core file size (blocks) core file size (blocks) unlimited
open files nofile 8192

max memory size (kbytes) max memory size (Kibytes) unlimited

| End of 'Platform': HP-UX, Linux, Oracle Solaris

¢ All users must have identical environment settings. Any change to the environment — such as variables, or
paths — is at your own responsibility.

* If you have multiple operating system users with user ID (UID) O, you must assign the sapinst group to all
of them.
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* Do not delete any shell initialization scripts in the home directory of the operating system users. This
applies even if you do not intend to use the shells that these scripts are for.

¢ If youinstall an SAP system with instances distributed over several hosts, make sure that the following
requirements are met:

* Theuser ID (UID) and group ID (GID) of each operating system user must be unique and the same on
each instance host that belongs to the same SAP system.

* Make sure that the group ID of group sapinst is always different from the group ID of any other group
(for example, of group sapsys) used during the installation.
For example, if you want to install an additional application server instance for an existing SAP system,
you must make sure that the group ID of group sapinst created on the host of the additional
application server instance is different from the group ID of any other group on the primary application
server instance host of the existing SAP system.

* If you use local operating system user accounts instead of central user management (for example,
NIS), users <sapsid>adm, sapadm, and the database operating system user must have the same
password on all hosts.

¢ If you create operating system users manually or use already existing operating system users, make sure
that the home directory for each of these users is not the root directory (/) .

* Make sure that the home directory of user <sapsid>adm is not critical for recursive changes on
permissions.
When operating system users are created by the software provisioning manager, the permissions on the
home directories of these users are changed recursively. This can cause unpredictable errors if you define
a critical home directory.
For example, the home directory must not be / or Zusr/sap.

° [Onlyvalidfor'Platform':HP-UX
HP-UX: To prevent terminal query errors in the <sapsid>adm environment, comment out the line eval
“"tset -s -Q -m ":?hp~inthe Zetc/skel/.login script. For more information, see SAP Note
1038842 .

l End of 'Platform': HP-UX

Operating System Users and Groups

The software provisioning manager chooses available operating system user IDs and group IDs unless you are
installing an additional application server instance. On an additional application server instance you have to
enter the same IDs as on the host of the primary application server instance.

If you have multiple operating system users with user ID (UID) O, you must assign the sapinst group to all of
them.

You can specify the name of the ABAP connect user (sap<sapsid>) independently from the SAP schema
name during the dialog phase of the software provisioning manager.
- Recommendation

We recommend, however, that you keep the names of the connect user and the database schema identical
in standard use cases.
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-> Recommendation

For security reasons, we recommend that you remove the operating system users from the group sapinst
after the software provisioning manager has completed. For more information, see Ensuring User Security

[page 164].

We recommend that you specify this “cleanup” already during the Define Parameters phase on the Cleanup
Operating System Users screen. Then, the removal of the operating system users from the group sapinst

is done automatically. For more information, see Cleanup of Operating System Users in SAP System

Parameters [page 55].

Users and Groups

User:

Primary Group:

UNIX superuser root

No primary group assigned by SAPinst (group sapinst is as-

signed as secondary group).

SAP system administrator <sapsid>adm

sapsys (sapinst as secondary group)

syb<dbsid>

sapsys

SAP Host Agent:

User and Groups of the SAP Host Agent

User Primary Group

Additional Group

Comment

sapadm sapsys

SAP Host Agent administrator

® Note

If sapadm does not exist, it is
created during the SAP Host
Agent installation using /bin/

false shell.

Make sure that /bin/false
can be used as a login shell.

|On|y valid for 'Platform': AIX

AIX: Add /bin/false to the
list of valid login shells (attribute
shells)in /Zetc/security/

login.cfg.
| End of 'Platform’: AIX

Groups and Members of the SAP Host Agent User

Groups

Members

sapsys

sapadm
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Groups Members

sapinst sapadm

4.3 Required File Systems and Directories

The following sections describe the directory structures for the SAP system, how to set up SAP file systems for
the SAP system and, if required, raw devices on operating system level:

® Note

The installation of any SAP system does not require a special file system setup or separate partitions.

Related Information

SAP Directories [page 82]
Setting Up File Systems for a High-Availability System [page 87]

4.3.1 SAP Directories

Depending on the installation option you have chosen, the software provisioning manager automatically
creates the directories listed in the following figures and tables. Before running the installation, you have to
set up the required file systems manually. In addition, you have to make sure that the required disk space for
the directories to be installed is available on the relevant hard disks.

The software provisioning manager creates the following types of directories:

* Physically shared directories
* Logically shared directories
* Local directories

[Only valid for 'Platform': HP-UX

HP-UX only: For recommendations about block size and mount option configuration, see SAP Note
1077887 ¥ .

l End of 'Platform': HP-UX

Directories of the SAP System

The figure below assumes that you have set up one file system for the SAP system mount directory <sapmnt>
and one file system for the Zusr/sap directory. However, you have to decide for which directories you want

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
82 PUBLIC Preparation


http://help.sap.com/disclaimer?site=https://me.sap.com/notes/1077887

to set up separate file systems. If you do not set up any file system on your installation host, the software
provisioning manager creates all directories in the root directory (/). A high-availability setup might influence
the file system structure. Contact your HA partner for their recommendation. For more information, see
Setting Up File Systems for a High-Availability System [page 87] .

The software provisioning manager prompts you only for the <sapmnt> directory during the installation.

The following figures show the directory structure of SAP systems based on SAP NetWeaver 7.5 and the
directory structure of SAP systems based on SAP NetWeaver 7.3 EHP1 to 7.4:

* Directory Structure for an ABAP System Based on SAP NetWeaver 7.5:
In SAP systems based on SAP NetWeaver 7.5 or higher, all application server instances, including the
primary application server instance, are named D<lnstance_Number>.

Local directories

| |
I I
| |
I I
: : / (root)
1 1 ]
I I I
I | usr
| | I
<sapmnt> I I
e '
| |
I L L I I
<SAPSID> ! ! <SAPSID>
trans 1 |
| T | |
| I
- ':'53-{51_ - :D<N0> ASCS<No> [ERS<No>]
| global ¥ - fobal 1
) ,‘-—" ""..._‘. Iog \og |0g
| profile : rofile :
data data data
_ exe I exe |
-—- = 1 k
jvm » 1 = jvm 1 wor work work
e L run - 1
- \
uc P - -'l == : < uc 1 1 exe exe exe
I'e | / | 4 Iy Iy
L <platform> — - —», > dbg <« | | | 1
| 3 J=nue 1 1 1 !
|—<platform>—|——v- ——————— |

- File system [ASCS<No>]: ABAP Central Services Instance
: [ERS<No>]: ERS Instance, Mandatory for High-Availability

. . D<No>]: Pri Application S Insta d (Optionally) Additional
__________ .,  :Symbolic Link [ o>]: Primary Application Server Instance and (Optionally) itiona

i (S Application Server Instances
- Replication by sapc| PP
P Y sapepe <platform>: operating system platform, for example linuxx86_64

Directory Structure for an ABAP System Based on SAP NetWeaver 7.5 or Higher
* Directory Structure for an ABAP System Based on SAP NetWeaver 7.3 EHP1 to 7.4:
In SAP systems based on SAP NetWeaver 7.3 EHP1 to 7.4 the primary application server instance is named
DVEBMGS<Instance_Number>.
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Local directories

1 1
I I
1 1
I I
I I
| | / (root)
1 1 1
I I I
1 | usr
I I
I I l
I I
1 1 I |
I I
<SAPSID> I I <SAPSID>
1 1 |
v I I |
P 45YS :DVEBMGS<NG> D<No> ASCS<No>  [ERS<No>]
| global *
- :_ : log log log log
| profile X X
data data
| exe _ 1 1 data data
~-TTTT ! k work
jvm e | wor work work
PR i B I
uc #~ RN | exe exe exe exe
-, \
| | A A A A
I— <platfcﬁm> - 2dbg 7 1 1 ] | 1
R S R ] ! | ] |
L_<platform> 1€ — - — _ _ _ _ _ O Y R E U [ N
| |
- File system [ASCS<No>]: ABAP Central Services Instance
sap : [ERS<No>]: ERS Instance, Mandatory for High-Availability
- Gpviraloalfie Lk [DVEBMGS<No=>]: Primary Application Server Instance
______ = e [D<No=>]: Additional Application Server Instance
: Replication by sapcpe . )
—————— - <platform>: operating system platform, for example linuxx86_64

Directory Structure for an ABAP System Based on SAP NetWeaver 7.3 EHP1to 74

Every new installation of an ABAP standalone system is Unicode (directory uc — Unicode).
Physically Shared Directories (SAP System)

Physically shared directories reside on the global host and are shared by Network File System (NFS). The
software provisioning manager creates the following directories:

* Thedirectory /<sapmnt>/<SAPSID>, which contains SAP kernel and related files, is created on the first
installation host. Normally, the first installation host is the host on which the central services instance
is to run, but you can also choose another host for , which is the global transport directory. /<sapmnt>/
<SAPSID>.
You need to manually share this directory with Network File System (NFS) and — for a distributed system
such as a high-availability system or a system with additional application server instances — mount it from
the other installation hosts.
The software provisioning manager creates the following shared subdirectories in /<sapmnt>/<SAPSID>,
which is the during the SAP system installation. If you install an SAP system with instances distributed
over several hosts, you have to share these directories for all hosts with the same operating system (see
Exporting and Mounting Global Directories [page 115]):

* global
Contains globally shared data
* profile
Contains the profiles of all instances
* exe
Contains executable kernel programs. The kernel programs are replicated from directory <sapmnt>/
<SAPSID>/exe/uc/<platform> to the exe directories of each Unicode system instance.
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* Thedirectory Zusr/sap/trans
The Zusr/sap/trans directory is physically separated from the server directories. This is to ensure that
the ability of the server to run is not affected if the /usr/sap/trans directory is full.
If you want to use an existing transport directory, you have to mount it before you install the relevant
application server instance. Otherwise, the software provisioning manager creates Zusr/sap/trans
locally.

- Recommendation

We recommend that you set up your global transport directory as a shared file system.

For more information about the global transport directory, see Exporting and Mounting the Global
Transport Directory [page 113].

Physically Shared SAP Directories

Directory Required Minimum Disk Space

/<sapmnt>/ Minimum 2.5 GB

<SAPSID>

/usr/sap/trans This value heavily depends on the use of your SAP system.

For production systems, we recommend to use as much free space as available (at least 2 GB),
because the space requirement normally grows dynamically.

For the installation, it is sufficient to use 2 GB for each SAP system instance. You can enlarge the file
system afterwards.

Logically Shared Directories (SAP System)

Logically shared directories reside on the local hosts with symbolic links to the global host. The software
provisioning manager creates the directory Zusr/sap/<SAPSI1D>/SYS on each host.

This directory contains the following symbolic links to physically shared directories:

* Symbolic link profi le points to /<sapmnt>/<SAPSID>/profile
¢ Symbolic link global points to /<sapmnt>/<SAPSI1D>/global

This directory contains the exe subdirectory with symbolic links pointing to the corresponding subdirectories
of /<sapmnt>/<SAPSID>/exe on the SAP global host:

* Symbolic link uc (for Unicode) points to /<sapmnt>/<SAPSI1D>/exe/uc

¢ Symbolic link nuc (for non-Unicode) points to /<sapmnt>/<SAPSID>/exe/nuc

* Symbolic link run points to another symbolic link Zusr/sap/<SAPSI1D>/SYS/exe/dbg in the same
directory, and symbolic link dbg finally points to /<sapmnt>/<SAPSID>/exe/uc/<platform>

Whenever a local instance is started, the sapcpe program checks the executables against those in the logically
shared directories and, if necessary, replicates them to the local instance.

The software provisioning manager uses sapcpe to replicate the kernel automatically from Zusr/sap/
<SAPSID>/SYS/exe/run/DIR_CT_RUN to Zusr/sap/<SAPSID>/<INSTANCE>/exe/DIR_EXECUTABLE for
each SAP system instance.

Local Directories (SAP System)
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The software provisioning manager also creates local directories that reside on the local hosts. The

directory Zusr/sap/<SAPSID> contains files for the operation of a local instance as well as symbolic links

to the data for one system. This directory is physically located on each host in the SAP system and contains the
following subdirectories:

SYS

® Note

The subdirectories of Zusr/sap/<SAPSI1D>/SYS have symbolic links to the corresponding
subdirectories of /<sapmnt>/<SAPSID>, as shown in the figure above.

Instance-specific directories with the following names:
* SAP systems based on SAP NetWeaver 7.3 EHP1 to 7.4:
* Thedirectory of the primary application server instance is called DVEBMGS<Instance_Number>.
* Thedirectory of an additional application server instance is called D<Instance_Number>.

* Thedirectory of an application server instance (primary application server instance and additional
application server instances) is called D<Instance_Number>.

The directory of the ABAP central services instance (ASCS) instance is called ASCS<Instance_Number>.

The directory of an ERS instance is called ERS<Instance_Number>.
If you install a high-availability system, you must install an ERS instance for the ASCS instance.

Local SAP Directories

Directory Description Required Minimum Disk Space
SAP systems based on SAP NetWeaver 7.3 Primary application serverin-  ®  SAP Business Warehouse server
EHP1 to 7.4: stance directory only: minimum 25 GB
Jusr/sap/<SAPSID>/ ° COj\|tBher installations: minimum 18
DVEBMGS<Instance Number>
SAP systems based on SAP NetWeaver 7.5 or
higher:
/usr/sap/<SAPSID>/D<Instance
Number>
/usr/sap/<SAPSID>/D<Instance Additional application server ~ ®  SAP Business Warehouse server
Number> instance directory only: minimum 25 GB
® Otherinstallations: minimum 18
GB
/usr/sap/<SAPSID>/ASCS<Instance ABAP central services in- Minimum 2 GB
Number> stance (ASCS instance) direc-
tory
/usr/sap/<SAPSID>/ERS<Instance ERS instance directory for the Minimum 2 GB
Number> ASCS instance (high availabil-
ity only)
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Directories of the SAP Host Agent

The SAP Host Agent has only local directories as shown in the following figure:

Physically shared
directories

Logically shared
directories

Local directories

/ (root)

usr

sap

hostctrl

exe

I
I
I
1
|
|
|
|
|
|
|
I
I
I
I
I
I
I
I
I
1 work
I
I
I
I
I
|
I
|
|
|
|
|

sap : File system

Directory Structure for the SAP Host Agent

Local Directories (SAP Host Agent)

The SAP Host Agent directory Zusr/sap/hostctrl requires 100 MB of disk space. It contains the following
subdirectories:

* exe
Contains the profile host_profile

* work
Working directory of the SAP Host Agent

4.3.2 Setting Up File Systems for a High-Availability System

Third-party technology is used to make the SAP directories available to the SAP system. The technologies
of choice are NFS, shared disks, and cluster file system. If you have decided to use a high-availability (HA)
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solution for your SAP system, make sure that you properly address the HA requirements of the SAP file
systems in your SAP environment with the HA partner of your choice.

Prerequisites

You have already installed the hardware - that is, hosts, disks, and network — and decided how to distribute

the database, SAP instances, and — if required — Network File System (NFS) server over the cluster nodes (that
is, over the host machines). For more information, see Planning the Switchover Cluster [page 73] and contact
your HA partner.

Context

From the perspective of an SAP application, there are the following types of SAP Directories [page 82]:

Physically shared directories: /<sapmnt>/<SAPSID> and /usr/sap/trans
Inan HA setup, /<sapmnt> should be a highly available file system, and Zusr/sap/trans should be a
shared file system.
Logically shared directories that are bound to a node such as Zusr/sap with the following local directories:
* /Jusr/sap/<SAPSID>
* /usr/sap/<SAPSID>/SYS
* /Jusr/sap/hostctrl
In an HA Setup, no special actions are required for these local directories.
Local directories that contain the SAP instances such as Zusr/sap/<SAPSI1D>/ASCS<Instance
Number>.
In an HA setup, the directories of the clustered instances (/usr/sap/<SAPSID>/<Instance
Type><Instance Number>) should be mounted as cluster-controlled file systems and reside on highly
available file systems.

[Only valid for 'Platform': HP-UX

HP-UX only: For recommendations about block size and mount option configuration, see SAP Note
1077887 ¥ .
l End of 'Platform': HP-UX

Procedure

1

88

Create the file systems or raw partitions for the SAP instances you can switch over in such a way that the
content can be made available to all nodes that can run the service. .

At least the ABAP central services (ASCS) instance and the ERS instance must be part of the switchover
cluster

The SAP directories /<sapmnt>/<SAPSID> and Zusr/sap/trans are usually mounted from a Network
File System (NFS). Especially for /<sapmnt>/<SAPSID> you should think of using a highly available
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file system. However, an SAP instance directory Zusr/sap/<SAPSID>/<Instance Type><Instance
Number> that you want to prepare for HA must always be mounted on the cluster node that is currently
running the instance.

A Caution
To start or stop an SAP instance, you have to do one of the following:

* Make the physically shared SAP directories under /<sapmnt>/<SAPSID>/ available to the server
beforehand.

* Consult your HA partner to clarify the best solution for the cluster software.

2. Use the following approach for the file system for the Zusr/sap/<SAPSID> directory:

The Zusr/sap/<SAPSID> directory contains at least two subdirectories (see also SAP Directories [page
82]):

* SYS/sapmnt/<SAPSID>

* <lInstance Type> <Instance Number> - where the name is defined by the type of services and
the application server number:

* SAP systems based on SAP NetWeaver 7.5 or higher: D<Instance Number> — which contains
data for the primary application server instance or an additional application server instance

* SAP systems based on SAP NetWeaver 7.3 EHP1 to 7.4: DVEBMGS<Instance Number> — which
contains data for the primary application server instance

* SAP systems based on SAP NetWeaver 7.3 EHP1 to 74: D<Instance Number> — which
contains data for an additional application server instance

* ASCS<Instance Number> — which contains data for the ABAP central services instance (ASCS
instance)

* ERS<Instance Number> — which contains the replication table, which is a copy of the lock table

Only <Instance Type><Instance Number> directories of clustered instances need to be migrated with
the SAP instances during the switchover.

Create cluster-controlled file systems for /usr/sap/<SAPSID>/<Instance Type><Instance
Number> of clustered instances.

The instance-specific directory name for the ABAP central services instance is normally ASCS<Instance
Number>. Migrating only these directories avoids mount conflicts when switching over to a node on which
another application server instance is already running. The ASCS<Instance Number> directory can join
the Zusr/sap/<SAPSID> tree instead of mounting on top of it. The same is true for all other clustered
instances.

® Note

This approach becomes increasingly important when you want to cluster the central services instances
with other local instances running on the cluster hosts outside the control of the switchover software.
This applies to the ERS instance and additional ABAP application server instances. The result is a more
efficient use of resources. Use this approach for integrated installations of the application server with
ABAP stacks.

3. You assign the local (not switching) file systems to permanent mount points.

4. You assign the shared file systems as documented by your HA partner.
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Example

The graphic below shows a scenario of the file systems and disks in an HA setup with an integrated NFS server.
Such a setup is not mandatory. For more information about a setup that meets your needs, consult your HA

partner.

Local Disks — Node A

Shared Disks

Local Disks — Node B

usr export sapmnt sapmnt export usr
I | I
sap sapmnt <SAPSID>—m | —p <SAPSID> € =— = <SAPSID> sapmnt sap
S
<SAPSID= global . <SAPSID=
: Node A fail
Node B fails ‘ profile  [MOCE A TAlS |
SYS exe SYS
global global
ERS
profile
exe
|Og exe
data
exe
= o
g =
o ASCS =
e =
o o
o work
log
data
exe
PAS AAS =
/l e—— Key /I e—— |
log exe work ) log exe work
Mount point
before switchover
Mount point ‘\————,"/
, afterswitchover
= = =» NFS mount point
File Systems and Disks in an HA Setup
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4.4 Using Virtual Host Names

You can use one or more virtual TCP/ 1P host names for SAP servers within an SAP server landscape to hide
their physical network identities from each other. This can be useful when quickly moving SAP servers or
complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

Context

If you want to install a high-availability (HA) system [page 267, you need the virtual host name when you install
the ASCS instance in a cluster.

Procedure

Assign the required virtual host names to the instance to be installed by specifying them in one of the following
ways:
¢ By starting the software provisioning manager with the SAPINST_USE_HOSTNAME property
For more information, see Running Software Provisioning Manager [page 121].

* Alternatively by specifying virtual host names in the <Instance Name> Host Name field of the
<Instance Name> Instance screen

For more information, see the Virtual Host Name parameter description in SAP System Parameters [page 55]
and SAP Note 962955 .
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4.5 Performing Switchover Preparations for High
Availability

You have to assign virtual host names to prepare the switchover for high availability.

Context

To be able to use the required virtual host names [page 91], you must set the software provisioning manager
property SAPINST_USE_HOSTNAME to specify the required virtual host name. You can do this in one of the
following ways:

¢ By starting the software provisioning manager with the SAPINST_USE_HOSTNAME property
For more information, see Running Software Provisioning Manager [page 121].

* Alternatively by specifying virtual host names in the <Instance Name> Host Name field of the
<Instance Name> Instance screen

For more information, see Virtual Host Name in SAP System Parameters [page 55].

Procedure

Assign the virtual IP addresses and host names for the ASCS instance, and (if required) NFS to appropriate
failover groups.

® Note

For more information on virtual addresses and virtual host names and how to assign resources to failover
groups, ask your HA partner.

4.6 Installing the SAP Front-End Software

Before you start the installation, make sure that the SAP front-end software is installed on at least one
computer in your system environment to be able to log on to the SAP system after the installation has finished.

Procedure

1. Check SAP Note 147519#% for the recommended SAP front-end release.
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2. Install the SAP front-end software required for your SAP system release as described in the
documentation SAP Frontend Installation Guide - <Release> at: https://wiki.scn.sap.com/wiki/display/
ATopics/SAP+GUI+Family e

4.7 Preparing the Installation Media

This section describes how to prepare the installation media.
Installation media are available as follows:

* The software provisioning manager 1.0 archive containing the software provisioning manager software
You always have to download the latest version of the software provisioning manager 1.0 archive.
For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive
[page 98].

* The media containing the software to be installed. These are the following:

* Kernel media:
You can make them available in one of the following ways:

* Make yourself familiar with current SAP Kernel releases and SAP's Kernel strategy:
Central SAP Notes
2083594 #% - SAP Kernel Versions and SAP Kernel Patch Levels
3116151#% - SP Stack Kernel Schedule Forecast
1744209%% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546/ - Release Roadmap for Kernel 74x and 75x
1802333 #% - Finding information about regressions in the SAP kernel
19466# - Downloading SAP kernel patches
2966761#F - Overview of SAP Kernel Correction Archives
2966621#% - Overview of Kernel-Related Software Components
953653 # - Rolling Kernel Switch
The white paper Update Strategy for the Kernel of the Application # Server ABAP in On Premise

Landscapes provides SAP recommendations on how to patch the SAP kernel.

* Download the SAP Kernel Archives (SAR files) from the SAP Software Download Center - this is
the recommended way.
For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page
1001.
If you are performing an Installation Using a Stack XML File [page 37], you can directly download
the artefacts (SAR archives) as specified in the Maintenance Plan.

* Use the physical installation media as part of the installation package.
For more information, see Media Required for the Installation - Listed by SAP System Instance
[page 941].

* Download the complete kernel media from the SAP Software Download Center.
For more information, see Downloading Complete Installation Media [page 105].
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* RDBMS and export media.
You can make them available in one of the following ways:

¢ Use the physical installation media as part of the installation package.

* Download the complete kernel media from the SAP Software Download Center.
For detailed information about how to obtain these media, see Media Required for the Installation - Listed
by SAP System Instance [page 94].

Media Required for the Installation - Listed by SAP System Instance [page 94]
This section provides a list of the media required for the installation, listed by SAP system instance to
be installed.

4.7.1 Media Required for the Installation - Listed by SAP
System Instance

This section provides a list of the media required for the installation, listed by SAP system instance to be
installed.

The digital signature of installation media is checked automatically by the software provisioning manager
during the Define Parameters phase while the Media Browser screens are processed (see also Running
Software Provisioning Manager [page 121] ). The software provisioning manager only accepts media whose
digital signature has been checked.

For more information about which kernel version to use, see the following information sources::
Central SAP Notes

2083594 ¢ - SAP Kernel Versions and SAP Kernel Patch Levels

3116151 - SP Stack Kernel Schedule Forecast

1744209%% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546#% - Release Roadmap for Kernel 74x and 75x

1802333 - Finding information about regressions in the SAP kernel
19466#% - Downloading SAP kernel patches

2966761% - Overview of SAP Kernel Correction Archives

2966621# - Overview of Kernel-Related Software Components

953653 # - Rolling Kernel Switch

The white paper Update Strategy for the Kernel of the Application # Server ABAP in On Premise Landscapes
provides SAP recommendations on how to patch the SAP kernel.

In addition, check the Product Availability Matrix at: http:/support.sap.com/pam#.

For more information about release and roadmap information for the SAP Kernel versions, and how this relates
to SAP system support packages - including important notes on downward compatibility and release dates -
see the central SAP Kernel notes:

Proceed as follows to make the media available:
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1. Identify the required media for your installation [page 24] as listed below.
Every installation of an SAP system on SAP Adaptive Server Enterprise is Unicode.

SAP Instance

Installation Required Software Packages from Installation Media

ABAP Central * Software Provisioning Manager 1.0 archive

services in- ® UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>)where Umeans Unicode and N

stance (ASCS means non-Unicode.

instance)
® Note
Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Database in- ® Software Provisioning Manager 1.0 archive

stance ¢ UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>) where Umeans Unicode and N

means non-Unicode.

® Note

Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Database software

Installation Export (folders EXP*)

Enqueue Repli-
cation Server

Software Provisioning Manager 1.0 archive

UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>)where U means Unicode and N
means non-Unicode.

® Note

Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Primary appli-
cation server in-
stance

Software Provisioning Manager 1.0 archive

UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>) where U means Unicode and N
means non-Unicode.

® Note

Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Installation Export (folders EXP*)
SAP SCM only: SAP MaxDB liveCache

Database Client Software
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SAP Instance
Installation

Required Software Packages from Installation Media

Additional appli-
cation server in-
stance

Software Provisioning Manager 1.0 archive

UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>) where U means Unicode and N
means non-Unicode.

® Note

If you install an additional application server instance in an existing non-Unicode system,
the additional application server instance is created automatically as a non-Unicode in-
stance. The software provisioning manager checks whether a non-Unicode system exists
and chooses the right executables for the system type.

SAP SCM only: SAP MaxDB liveCache

Database Client Software

SAP Host Agent (Separate Installation Only)

SAP Instance Installation Required Media

SAP Host Agent (separate installation only)

¢ Software provisioning manager 1.0 archive

® UC Kernel (folder K_<Version>_U_<0S>) where U

means Unicode.

2. Make the installation media available on each installation host as follows:

1. Download and unpack the latest version of Software Provisioning Manager as described in
Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 98].

2. Make the kernel media available.
You can do this in one of the following ways:

* Download the dedicated kernel archives - this is the recommended way.
For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page

100].

® Note

If you are using a Stack XML file (see Installation Using a Stack XML File [page 37]), you
have the installation media defined when generating the Landscape Plan. The media link
provided in the Landscape Plan guides you to the location in the SAP Software Download
Center at https:/me.sap.com/softwarecenter#s where you can download the installation
media required for your SAP product, operating system and database.

Using the software provisioning manager, you can also directly download the artefacts (SAR
archives) as specified in the Maintenance Plan. For more information, see Downloading
Software Packages for a Maintenance Planner Transaction [page 103].

* Use the physical kernel medium from the installation package.
You can do this in one of the following ways:

* Copy the required media folders directly to the installation hosts.

* Mount the media on a central media server that can be accessed from the installation hosts.
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A Caution

If you copy the media to disk, make sure that the paths to the destination location of the
copied media do not contain any blanks.

* Download the kernel medium from the Software Download Center.
For more information, see Downloading Complete Installation Media [page 105].

® Note

Even if you use the complete kernel media, the software provisioning manager might prompt you
during the provisioning process for additional archives (*.SAR files) due to special Patch Level
(PL) requirements depending on categories such as the product, operating system, and database
platform at the end of this section.

For example: The software provisioning manager might require a certain PL of <X> of the
SAPEXEDB. SAR (for DBTYPE <Y>), but this PL of the SAPEXEDB . SAR is not contained in the

SAP kernel media . In this case you have to download the required PL from https:/me.sap.com/
softwarecenter# following the instructions in Downloading SAP Kernel Archives (Archive-Based
Installation) [page 100].

® Note

If you perform an additional application server installation, kernel archives,

such as SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR, IGSEXE<Version>.SAR,
igshelper<version>.sar, are only prompted if they cannot be retrieved from the primary
application server instance or the ASCS instance of the existing SAP system. The release and
patch versions must match those used for the primary application server instance and the ASCS
instance.

3. Make the RDBMS and export media. available.
You can do this in one of the following ways:

* Copy the required media folders directly to the installation hosts.
* Mount the media on a central media server that can be accessed from the installation hosts.

A Caution

If you copy the media to disk, make sure that the paths to the destination location of the copied
media do not contain any blanks.

3. If you want to perform target system installation in the context of a heterogeneous system copy you need
a migration key. You can generate it at https:/support.sap.com/en/my-support/keys.htm| .

Related Information

Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 98]
Downloading SAP Kernel Archives (Archive-Based Installation) [page 100]
Downloading Software Packages for a Maintenance Planner Transaction [page 103]
Downloading Complete Installation Media [page 105]
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4711 Downloading and Extracting the Software
Provisioning Manager 1.0 Archive

You must always download and extract the software provisioning manager 1.0 archive from the SAP Software
Download Center because you must use the latest version.

Prerequisites

* Make sure that you are logged on as a user with root authorizations, and that the download directory has
at least the permissions 755.

* Make sure that you use the latest version of the SAPCAR tool when manually extracting the software
provisioning manager archive. You need the SAPCAR tool to be able to unpack and verify software
component archives (*SAR files). *SAR is the format of software lifecycle media and tools that you can
download from the SAP Software Download Center.

® Note

An older SAPCAR version might extract archive files in a wrong way and this could prevent the software
provisioning manager from working consistently.

Proceed as follows to get the latest version of the SAPCAR tool:
1. Go to https:/me.sap.com/softwarecenter® | » SUPPORT PACKAGES & PATCHES » By Category

» SAP TECHNOLOGY COMPONENTS » SAPCAR 1.

2. Select the SAPCAR for your operating system and download it to an empty directory.

3. Evenif you have the latest SAPCAR already available, we strongly recommend that you verify its digital
signature anyway, unless you downloaded it directly from https:/me.sap.com/softwarecenter/ e
yourself. You can do this by verifying the checksum of the downloaded SAPCAR tool:

1. Depending on what operating system you are using, compute a hash of the downloaded SAPCAR
tool, using the SHA-256 algorithm used by SAP .

2. Now verify the digital signature of the downloaded SAPCAR tool by comparing the hash with the
checksum (generated by SAP using the SHA-256 algorithm) from the Content Info button in the
Related Info column on the right-hand side of the place where you downloaded the SAPCAR tool.

4. To improve usability, we recommend that you rename the executable to sapcar.

For more information about SAPCAR, see SAP Note 212876 .

Context

An up-to-date version of the load tools - such as R31oad, R3szchk, R31dctl, SAPuptool

- which were available so far only in the SAPEXEDB_<. . .>.SAR archive of the kernel

media, has now been made available in the software provisioning manager archive (software
provisioning manager10SP<Support_Package_Number>_<Version_Number>_SAR), in a sub-
archive named LOADTOOLS. SAR, located in the COMMON/LOADTOOLS folder. For an installation

using kernel version 740 or higher, the load tools from the software provisioning
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manager10SP<Support_Package Number>_<Version_Number>.SAR are used automatically instead

of the loadtools available in the SAPEXEDB_<. . .>_SAR archive of the kernel media. There

is no action required from your side, the software provisioning manager uses the

relevant loadtools automatically once you run it from the extracted software provisioning
manager10SP<Support_Package Number>_<Version_Number>.SAR archive. For more information, see
SAP Note 2472835 .

Procedure

1. Download the latest version of the Software Provisioning Manager 1.0 archive
SWPM10SP<Support_Package Number>_<Version_Number>.SAR from:

https:/support.sap.com/sltoolset# | » System Provisioning # Download Software Provisioning
Manager 3

2. Using the latest version of SAPCAR, you can verify the digital signature of the downloaded
SWPM10SP<Support_Package_ Number>_<Version_Number>.SAR archive as follows:

a. Get the latest version of the SAPCRYPTOL IB archive to your installation host as follows:

1. Go to https:/me.sap.com/softwarecenter® | SUPPORT PACKAGES & PATCHES Jand search
for “sapcryptolib”.
2. Select the archive file for your operating system and download it to the same directory where you
have put the SAPCAR executable.
3. Use the following command to extract the SAPCRYPTOLIB archive to the same directory where
you have put the SAPCAR executable:
SAPCAR —xvT sapcryptolibp_84.sar —R <target directory>
4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/cribag.p7s# and move
it to the same directory.
b. Verify the digital signature of the downloaded
SWPM10SP<Support_Package Number>_<Version_Number>.SAR archive by executing the
following command:

® Note
Check SAP Notes 2178665# and 1680045#% whether additional information is available.

/<Path to SAPCAR>/SAPCAR -tvVf <Path to Download Directory>/
SWPM10SP<Support_Package_Number>_<Version_Number>_.SAR -cri<file name of
revocation list>

3. Unpack the Software Provisioning Manager archive to a local directory using the following command:
/<Path to SAPCAR>/sapcar -xvf <Path to Download Directory>/

SWPM10SP<Support_Package_Number>_<Version_Number>.SAR -R <Path to Unpack
Directory>

® Note

Make sure that all users have at least read permissions for the directory to which you unpack the
Software Provisioning Manager archive.
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A Caution

Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not
unpack it to the same folder as other installation media.

4.71.2 Downloading SAP Kernel Archives (Archive-Based
Installation)

Instead of downloading the complete SAP kernel media, we recommend that you download the SAP kernel
archives specificly required for your installation option. During the installation, you can either specify the path
to each archive separately, or provide the path to a download basket with all downloaded archives.

® Note

If you are performing an installation using a Stack XML file, you can use the service Downloading Software
Packages for a Maintenance Planner Transaction [page 103].

Context

The digital signature of installation archives is checked automatically by the software provisioning manager
[page 121] during the Define Parameters phase while processing the Software Package Browser screens. The
software provisioning manager only accepts archives whose digital signature has been checked. After scanning
the archives and verifying the digital signature, an info file is written where you can find detailed information
about matching and non-matching archive files. You can access this info file by choosing the info file link in the
Archive Scanning Result section of the Software Package Browser screen. The info file contains only the results
of the latest archive scan.

Procedure

1. Download and unpack the latest version of software provisioning manager as described in Downloading
and Extracting the Software Provisioning Manager 1.0 Archive [page 98].

2. Make yourself familiar with current SAP Kernel releases and SAP's Kernel strategy:
Central SAP Notes
2083594 #% - SAP Kernel Versions and SAP Kernel Patch Levels
3116151# - SP Stack Kernel Schedule Forecast
1744209#% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546/ - Release Roadmap for Kernel 74x and 75x
1802333 - Finding information about regressions in the SAP kernel
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19466¢% - Downloading SAP kernel patches

2966761 - Overview of SAP Kernel Correction Archives

2966621 - Overview of Kernel-Related Software Components

953653 - Rolling Kernel Switch

The white paper Update Strategy for the Kernel of the Application # Server ABAP in On Premise
Landscapes provides SAP recommendations on how to patch the SAP kernel.

3. To get all downloadable software component archives required for your SAP product, go to https://
me.sap.com/softwarecenter® |# » SUPPORT PACKAGES & PATCHES » By Category 1

You can also search for dedicated software component archives by choosing | » SUPPORT PACKAGES &
PATCHES » By Downloads » Search

4. Choose the required software component, release, and technical stack:

If you want to install AS ABAP for SAP SAP S/4HANA Frontend , choose | SAP NetWeaver and
complementary products » AS ABAP FOR S/AHANA FRONTEND » AS ABAP <Release> FOR S/4
HANA <Release> J

If you want to install SAP NetWeaver AS for ABAP 7.52, choose [# SAP NetWeaver and complementary
products » NW AS ABAP INNOVATION PKG » NW AS ABAP 752 1

If you want to install SAP NetWeaver AS for ABAP 7.51 innovation package, choose |» SAP NetWeaver
and complementary products » NW AS ABAP INNOVATION PKG » NW AS ABAP 7.51 INNOVATION
PKG 3

If you want to install AS ABAP FOR OOEM, choose |# SAP NetWeaver and complementary products

» SAP NETWEAVER ABAP FOR OOEM J

If you want to install the ABAP part of an SAP Process Integration 7.5 system, choose

| SAP NetWeaver and complementary products » SAP NetWeaver » <Release> » Application Server
ABAP 3

If you want to install an SAP NetWeaver ABAP system, choose | SAP NetWeaver and complementary
products » SAP NetWeaver » <Release> »» [For releases lower than 7.5: Entry by Component]

» Application Server ABAP 3

If you want to install an SAP Business Suite system based on SAP NetWeaver, choose [+ SAP
Application Components » <SAP CRM | SAP ERP | SAP SCM | SAP SRM> » <Release> » Entry
by Component » <ABAP Product Instance> J

5. Choose the required package:

® Note

If you perform an additional application server installation, kernel archives,

such as SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR, IGSEXE<Version>_SAR,
igshelper<version>.sar, are only prompted if they cannot be retrieved from the primary
application server instance or the ASCS instance of the existing SAP system. The release and patch
versions must match those used for the primary application server instance and the ASCS instance.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
Preparation PUBLIC 101


http://help.sap.com/disclaimer?site=https://me.sap.com/notes/19466
http://help.sap.com/disclaimer?site=https://me.sap.com/notes/2966761
http://help.sap.com/disclaimer?site=https://me.sap.com/notes/2966621
http://help.sap.com/disclaimer?site=https://me.sap.com/notes/953653 
http://help.sap.com/disclaimer?site=https%3A%2F%2Fsupport.sap.com%2Fdeployment-strategies-kernel-abap.pdf
http://help.sap.com/disclaimer?site=https%3A%2F%2Fme.sap.com%2Fsoftwarecenter
http://help.sap.com/disclaimer?site=https%3A%2F%2Fme.sap.com%2Fsoftwarecenter

A Caution
* Make sure that you always use the highest available patch level unless special patch levels are

specified for the relevant package in SAP Note 1680045 #& .

* Make sure that you always choose SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR of the
same SAP kernel release and extension.

% Example

|f SAPEXE<Version>.SAR is of version 64-BIT UNICODE, then SAPEXEDB<Version>.SAR
must also be of version 64-BIT UNICODE.

* SAPEXE<Version>.SAR
| SAP KERNEL <Version><UC | NUC> » <Operating System> » #DATABASE INDEPENDENT 73

® Note

SAP KERNEL <Version> <NUC> is only available for SAP systems based on SAP NetWeaver 7.4 or
lower.

* SAPEXEDB<Version>.SAR
Choose the version corresponding to the SAPEXE<Version>.SAR from | SAP KERNEL <Version>
<UC | NUC> » <Operating System>» <DATABASE> 1

® Note

SAP KERNEL <Version> <NUC> is only available for SAP systems based on SAP NetWeaver 7.4 or
lower.

* igsexe<Version>.sar
| SAPIGS <Version> » <Operating System> J
* Yourequire the igshelper<Version>.sar.
Choose |* SAP IGS HELPER » # OS independent J
®* SAPHOSTAGENT<Version>.SAR
| SAP HOST AGENT 7.22 ¥ <Operating System> J

- Recommendation

It is highly recommended that you always choose the highest SP version of the
SAPHOSTAGENT<SP-version>.SAR archive.

® Note

The SAPHOSTAGENT<Version>.SAR archive is only prompted if there is either no SAP Host
Agent available on the installation host or you specified during the Define Parameters phase
that you want to upgrade an existing version of the SAP Host Agent already available

on the installation host. In the latter case, you must specify a higher version of the
SAPHOSTAGENT<Version>.SAR .Otherwise, the existing SAP Host Agent is not upgraded.

6. If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1 - that is you have to use SAP kernel
7.22 - download the latest patch level of SAPCRYPTOLIB <Version>.SAR from the following path:
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https:/me.sap.com/softwarecenter# |+ Support Packages and Patches » By Category ¥ Additional
Components » SAPCRYPTOLIB » COMMONCRYPTOLIB<Version> » <Operating System> J

7. Make the RDBMS and the export media available - either by using physical media as described in Media
Required for the Installation - Listed by SAP System Instance [page 94] or by downloading them as
described in Downloading Complete Installation Media [page 105].

Related Information

Downloading Software Packages for a Maintenance Planner Transaction [page 103]

4.71.3 Downloading Software Packages for a Maintenance
Planner Transaction

The software provisioning manager is now enabled to download all software packages that have been defined in
a Maintenance Planner Transaction.

® Note

This feature is only available if you perform an installation using a stack configuration file.

Prerequisites

Plan your new SAP system including the required Support Package level (applicable for SAP S/4 HANA, SAP
NetWeaver, SAP Business Suite, and SAP Financials) as available in the Maintenance Planner and run sapinst
SAPINST_STACK_XML=<Stack XML file>inorder to benefit from an automated installation process.

Procedure

1. Specify a download directory for the artifacts (SAP archives) to be downloaded.

2. Start the software provisioning manager as described in Running Software Provisioning Manager [page
121].

3. Onthe Welcome screen, choose | # Generic Options j» Download Software Packages for Maintenance
Planner Transaction 3

4. Follow the instructions on the software provisioning manager screens.
The software provisioning manager prompts you for the following input parameters:
* Maintenance Planner Transaction ID
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You can find the Maintenance Planner Transaction ID by one of the following ways:

* IntheMP_Plan_<Transaction ID>_<Generation Date>_.pdf file which you can download
during the Completed step in the Maintenance Planner by choosing the Download PDF button.

* From the Transaction ID column in the list of transactions displayed in the Transactions panel in the
maintenance planner.

* From the parameter mopz-transaction-id in the Stack XML file MP_Stack_<Transaction
ID>_<Generation Date>.xml which you can download during the Download Files step in the
Maintenance Planner by choosing the Download Stack XML button.

® Note

If you started the software provisioning manager using a Stack XML file, the Maintenance Planner
Transaction ID is only displayed.

* Your S-UserlID and password
You call Software Provisioning Manager with command line parameter
SAPINST_STACK_XML=<Absolute_Path_To_Stack_ XML_File> to get the Maintenance Planner
Transaction ID extracted from the Stack XML file.
You must perform this option directly after creating the Maintenance Planner Transaction, because the
contained download links usually expire soon.
Ensure the following for your S-User:

1. You have download permissions for all artifacts on https:/me.sap.com/softwarecenterfrto be
able to download them.

2. Consider the SAP Support Portal and the SAP ONE Support Launchpad password policies# : Your
password must be the same for both of them. If the passwords are not the same, you will lock the
S-User in the SAP Support Portal. The password must meet all of the following requirements:

* Must be exactly eight characters long
¢ Contains at least one upper-case letter (A-Z)
* Contains at least one lower-case letter (a-z)
¢ Contains at least one decimal digit (0-9)
* Contains at least one of the following special characters: IN@ $ % / ({[]})+-*=?"~#
_i<>
* Must not start with ? or !
* Must not contain any blanks
* Must not begin with three identical characters
* Must be different from the last five passwords you have already used
* Only one password change is allowed per day
If required, request a change of your SAP Support Portal Password and of your SAP ONE Support
Password at https://support.sap.com/en/my-support/users.htm| .

* Location of download folder for the installation software packages to be downloaded
* If you have a proxy configured in your network, provide the proxy host and port.
5. You get alist of all downloadable artifacts (SAP archives) as specified in the Stack XML file along with their
file size.
You can still deselect downloadable artifacts (SAP archives) that you do not need to be downloaded.

6. Choose Next to start the download.
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If you get a download error, this is the result of an unsuccessful network connection. Check your network
connection and proxy configuration. If the download of some artifacts finishes without any error, but still
with a status other than OK, you must do one of the following:

* Create an up-to-date Maintenance Plan and perform again the download of the files which were not
downloaded successfully. In case of an error, the software provisioning manager skips the download of
the artifact (SAR archive) in question and continue with the next one in the list.

* Download the still missing files directly from the SAP Software Center at https:/me.sap.com/
softwarecenter .

Results

You have downloaded the artifacts (SAP archives) required for your SAP system installation with the software
provisioning manager - corresponding to the archives listed in section Downloading SAP Kernel Archives
(Archive-Based Installation) [page 100] - and for applying the required kernel and support packages using
Software Update Manager (SUM) after the installation has completed.

SAP BW/4HANA 1.0 SR1 only: RDBMS and export media are not covered by this feature. You have to provide
them either as physical media or download them from the SAP Software Center as described in Downloading
Complete Installation Media [page 105] .

4714 Downloading Complete Installation Media

This section describes how you can download complete media from the SAP Software Download Center.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading
and Extracting the Software Provisioning Manager 1.0 Archive [page 98].

2. Create a download directory on the host where you want to run the software provisioning manager.

3. You identify the required media as listed in Media Required for the Installation - Listed by SAP System
Instance [page 94] .

4. l|dentify all download objects that belong to one medium according to one of the following:

® Note

Installation media might be split into several files. In this case, you have to reassemble the required files
after the download.

* Download path or location:

* To download the complete kernel media, go to https:/me.sap.com/softwarecenter/ # |
» SUPPORT PACKAGES & PATCHES » By Category » ADDITIONAL COMPONENTS » SAP KERNEL
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» SAP KERNEL 64-BIT UNICODE » SAP KERNEL <Version> 64-BIT UNICODE ¥ <Select your
0s> 1.

* Select | #DATABASE INDEPENDENT 3 to download the database-independent parts of the
kernel.

% Example

SAPEXE_1110-80002623.SAR
Kernel Part I (753) (*)

SAPEXE_1118-80002612.SAR

* Select|r <Your DB> Jto download the database-independent parts of the kernel.
% Example

SAPEXEDB_1110-80002623.SAR
Kernel Part Il (753) (*)

® Note

You can only download complete kernel media for kernel release 7.22, which can only be used
for provisioning of SAP products based on SAP NetWeaver 7.3 EHP1. For all remaining SAP
products, you have to download kernel media from https:/me.sap.com/softwarecenter/ #&r as
described in Downloading SAP Kernel Archives (Archive-Based Installation) [page 100].

* To download the remaining media required for your SAP product, you can use one of the following
navigation paths:

* https:/me.sap.com/softwarecenter®|» INSTALLATIONS & UPGRADES » By Category » SAP
NETWEAVER AND COMPLEMENTARY PRODUCTS ¥ <Product> » <Product Release> 3

* https:/me.sap.com/softwarecenter | INSTALLATIONS & UPGRADES » By Alphabetical
Index (A-Z) » <First Letter of Product> » <Product> }» <Product Release> 3

* Material number
All download objects that are part of an installation medium have the same material number and an
individual sequence number:
<Kernelpart>_<Sequence Number>-<Material Number>

% Example

SAPEXE_1110-80002623.SAR
Kernel Part I (753) (*)
SAPEXE_1111-80002623.SAR
Kernel Part I (753) (*)
SAPEXE_1112-80002623.SAR
Kernel Part I (753) (*)

% Example

SAPEXEDB_1110-80002623.SAR
Kernel Part Il (753) (*)
SAPEXEDB_1111-80002623.SAR
Kernel Part 11 (753) (*)
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SAPEXEDB_1112-80002623.SAR
Kernel Part Il (753) (*)

* Title
All objects that are part of an installation medium have the same title, such as
<Solution><Media_Name><0S> or <Database>RDBMS<0S> for database media.

5. Download the objects to the download directory.

6. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.

In the unpacking directory, the system creates a subdirectory with a short text describing the medium and
copies the data into it. The data is now all in the correct directory, the same as on the medium that was
physically produced. For more information, see SAP Note 1258173 .

A Caution

Make sure that you unpack each installation media to a separate folder. Do not unpack installation
media to the same folder where you unpack the Software Provisioning Manager archive.

Do not unpack installation media to the same folder where you unpack the SAP kernel archives for
archive-based installation.
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5 Installation

5.1 Installation Checklist

This section includes the installation steps for the following:

¢ Standard system

* Distributed system

* High-availability system

* Additional application server instance

Detailed information about the steps are available in the linked sections.

® Note

SAP ASE 16.0 is installed silently as part of the installation of the respective SAP product. Do not install the
database software separately prior to the SAP installation.

Standard System

I ® Note

1. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to install
the SAP system.

® Note

In a standard system, all mandatory instances are installed on one host in one installation run.

2. You continue with Post-Installation [page 142].

Distributed System

1. If you want to share the transport directory trans from another system, you have to mount [page 113] it
from this system. Otherwise, we recommend that you share the trans directory that is created during the
installation of the primary application server instance.

2. Onthe ASCS instance host, you do the following:

1. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to
install the ABAP central services instance (ASCS instance).
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® Note

If you want to install an ASCS instance with embedded SAP Web Dispatcher [page 32] or with
embedded SAP Gateway [page 34] or both, you must choose the Custom parameter mode.

When processing the screens for the ASCS instance installation, you are prompted to mark
the corresponding checkbox on the screen Additional Components to be Included in the ASCS
Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters
required for the SAP Web Dispatcher installation on the subsequent screens.

2. You export global directories [page 115] in <sapmnt>/<SAPSID> to the database and primary
application server instance host.

3. On the database instance host, you do the following:
1. You mount the global directories [page 115] in <sapmnt>/<SAPSI1D> that you exported from the

SAP global host and — optionally — the trans directory that you exported [page 113] from the SAP
transport host.

2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to
install the database instance.

4. Onthe primary application server instance host, you do the following:

1. You mount the global directories [page 115] in <sapmnt>/<SAPSI1D> that you exported from the SAP
global host.

2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to
install the primary application server instance.

3. If you want to use the shared transport directory trans from another system, you also mount [page
113] this directory.

5. You continue with Post-Installation [page 142].

Graphical Overview
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The following figure shows how you install the various instances in a distributed system:
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Distribution of Instances in an ABAP System

High-Availability System

® Note

The following procedure is only an example. In this example, we use only one primary cluster node, host A,
and one standby cluster node, host B. However, for your production system, we recommend that you have
more that one standby node.

1. You make sure that you have already prepared the standby node, host B. You ought to have already made
sure that it meets the hardware and software requirements and that it has all the necessary file systems,
mount points, and (if required) Network File System (NFS).

This is described in Performing Switchover Preparations for High Availability [page 92] and Setting Up File
Systems for a High Availability System [page 87]

2. If you want to share the transport directory trans from another system, you have to mount [page 113] it
from this system. Otherwise we recommend that you share the trans directory that is created during the
installation of the primary application server instance (see below).

3. You set up the switchover cluster infrastructure as follows:

1. You check the prerequisites [page 117] and Running Software Provisioning Manager [page 121] to
install the ABAP central services instance (ASCS instance) on the primary cluster node, . Use a virtual
host namehost A [page 91].

® Note

If you want to install an ASCS instance with embedded SAP Web Dispatcher [page 32] or with
embedded SAP Gateway [page 34] or both, you must choose the Custom parameter mode.
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When processing the screens for the ASCS instance installation, you are prompted to mark
the corresponding checkbox on the screen Additional Components to be Included in the ASCS
Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters
required for the SAP Web Dispatcher installation on the subsequent screens.

2. You hostcheck the prerequisites [page 117] and run the software provisioning manager [page 121] to
install the ERS instance for the ASCS instance on the primary cluster node, host A. Use a virtual host
name [page 91].

3. Youexport global directories [page 115] in <sapmnt>/<SAPSI1D> to the database host and to the
primary application server instance host.

4. You prepare the standby cluster node, host B, making sure that it meets the hardware and software
requirements [page 39] and it has all the necessary file systems [page 87], mount points, and (if
required) Network File System (NFS).

5. You set up the user environment on the standby node, host B:

* You use the same user and group IDs, and OS specific files (such as etc/services) as on the
primary node.
* You create the home directories of users and copy all files from the home directory of the primary
node.
For more information about the required operating system users and groups, see Creating Operating
System Users [page 77].

6. You configure the switchover software and test that switchover functions correctly to all standby nodes
in the cluster.

7. You repeat the following steps until you have finished installing the ERS instance on all nodes in the
cluster:

1. You perform the switchover to a node where you want to install the ERS instance for the ASCS
instance.

2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to
install the ERS instance for the ASCS instance on the standby node, host B.

4. Onthe database instance host, you do the following:

- Recommendation

We recommend that the database instance is part of the hardware cluster or of any other proprietary
high-availability solution for the database.

1. You make available the global directories in <sapmnt>/<SAPSID> from the switchover cluster
infrastructure and — optionally — from the SAP transport host.
2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to install
the database instance on the database instance host.
5. Onthe primary application server instance host, you do the following:

® Note

In a high-availability installation, the primary application server instance does not need to be part of the
cluster because it is no longer a single point of failure (SPOF). The SPOF is now in the ABAP central
services instance (ASCS instance), which is protected by the cluster.

1. You mount the global directories [page 115] in <sapmnt>/<SAPSID> that you exported from the
switchover cluster infrastructure.
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2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to install
the primary application server instance.

3. If you want to use the shared transport directory trans from another system, you also mount [page
113] this directory (see above).
6. We recommend you to install additional application server (AS) instances to create redundancy.
The AS instances are not a SPOF. Therefore, do not include these instances in the cluster.
7. You continue with Post-Installation [page 142].

Graphical Overview

The following figure provides an overview of how you install the various instances in a high-availability
installation:
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Distribution of Instances in a High-Availability ABAP System

Additional Application Server Instance

If you want to install additional application server instances on a host different from the SAP system host,
you export global directories in <sapmnt>/<SAPSID> to the hosts on which you want to install additional

1. If you want to install additional application server instances on a host different from the SAP system
host, you mount the global directories [page 115] in <sapmnt>/<SAPSID> that you exported from the

2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to install
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Installation Steps for an Application Server Instance for a Distributed System

1. If you want to share the transport directory trans from another system, you have to mount [page 113] it
from this system. Otherwise, we recommend that you share the trans directory that is created during the
installation of the primary application server instance.

2. Onthe SAP global host, you export global directories in <sapmnt>/<SAPSID> to the hosts on which you
want to install additional application server instances.

3. On every additional application server instance host, you do the following:

1. You mount the global directories [page 115] in <sapmnt>/<SAPSI1D> that you exported from the SAP
global host.

2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to install
the additional application server instance.

3. If you want to use the shared transport directory trans from another system, also mount [page 113]
this directory.

4. You continue with Post-Installation [page 142].

Installation Steps for an Additional Application Server Instance for a High-Availability System

1. If you want to share the transport directory trans from another system, you have to mount [page 1137 it
from this system. Otherwise, we recommend that you share the trans directory that is created during the
installation of the primary application server instance.

2. Onthe primary node, host A, of the switchover cluster infrastructure, you export global directories in
<sapmnt>/<SAPSID> to the hosts on which you want to install additional application server instances.

3. On each additional application server instance host, do the following:

1. You mount the global directories [page 115] in <sapmnt>/<SAPSI1D> that you exported from the SAP
global host.
2. You check the prerequisites [page 117] and run the software provisioning manager [page 121] to install
the additional application server instance.
3. If you want to use the shared transport directory trans from another system, you also mount [page
113] this directory.
4. You continue with Post-Installation [page 142].

5.2 Exporting and Mounting the Transport Directory

Every SAP system must be assigned to a transport directory. All application server instances of an SAP system
must point to the same transport directory.

Context

Multiple SAP system can use the same transport directory. However, it is not required to have one global
transport directory in your SAP system landscape. Depending on your security requirements, you must decide
how you want to set up the transport directories in your landscape. Systems with lower security requirements
can share a transport directory (DEV, QA, for example). For systems with higher security requirements (PROD,
for example), you might want to have a separate transport directory.
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The transport directory is used by the Change and Transport System (CTS). The CTS helps you to organize
development projects, and then transport the changes between the SAP systems in your system landscape.

For more information, see the SAP Library at:

Release SAP Library Path

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731#

® SAP NetWeaver 74
http://help.sap.com/nw74 Fir

® SAP NetWeaver 7.5
http://help.sap.com/nw75# the Change and Transport System # Transport Management

|} Application Help > Function-Oriented View > Application
Server # Application Server ABAP ¥ Administration of
Application Server ABAP > Change and Transport System

» Change and Transport System - Overview ¥ Basics of

® SAP NetWeaver Application Server for ABAP 7.51 System - Concept 3
innovation package
https://help.sap.com/nw751abap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap P

Consider the following:
* Ifthe transport directory already exists, make sure that it is exported on the transport directory host and
mount it on the SAP instance installation host.
* [fthe transport directory does not exist, proceed as follows:

* Create the transport directory (either on the host where the primary application server instance is
running or on a file server).

* Exportit onthe transport directory host.
¢ If you did not create the transport directory on your SAP instance installation host, mount it there.

Procedure

Mounting the Transport Directory

® Note

If the transport directory resides on your local SAP instance installation host, you do not need to mount it.

a. Logonasuser root to the host of the primary or additional application server instance, where /usr/sap/
transis to be mounted.

b. Create the mount point /usr/sap/trans.
c. Mount Zusr/sap/trans using Network File System (NFS) from the exporting host.
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5.3 Exporting and Mounting Global Directories

If you install a database or an additional application server instance on a host other than the SAP global host,
mount global directories from the SAP global host.

Prerequisites

If you want to install the executables locally instead of sharing them, do not mount the exe directory with
Network File System (NFS). Instead, create <sapmnt>/<SAPSID>/exe as a local directory (not a link) with a
minimum of 1.5 GB free space.

Context

There is no need to create the directories before the installation when you install a primary application server
instance. The global directories must be exported only if you install additional application server instances.

Choose one of the following ways to proceed, depending on whether you are performing a homogeneous or
heterogeneous installation:

Procedure

* Exporting and Mounting Global Directories for a Homogeneous Installation

a. Logontothe SAP global host as user root and export the following directories with read/write access
for the root user to the host where you want to install the new instance:

<sapmnt>/<SAPSID>/exe
<sapmnt>/<SAPSID>/profile

<sapmnt>/<SAPSI1D>/global
b. Log on to the host of the new instance that you want to install as user root.
c. Create the following mount points and mount them from the SAP global host:

<sapmnt>/<SAPSID>/exe
<sapmnt>/<SAPSID>/profile

<sapmnt>/<SAPSI1D>/global

A Caution

Make sure that the mount points under /<sapmnt>/<SAPSID>/ are permanent. Otherwise,
automatic start of the instance services does not work when you reboot the system.
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¢ Exporting and Mounting Global Directories for a Heterogeneous Installation

With a heterogeneous installation, the instances of an SAP system are installed on hosts with different
UNIX operating systems. If you need information about the installation of application servers on Windows
in a UNIX environment, see Heterogeneous SAP System Installations [page 200].

® Note

Mounting the directories between different system types, for example mounting a Windows file system
on a Linux host, requires a 3rd party product such as Samba. The installation and configuration of
Samba is not covered by in this guide.

Proceed as follows for a heterogeneous installation with different UNIX operating systems:

a. Logontothe SAP global host as user root and export the following directories with root access to

54

the host on which you want to install the new instance:
<sapmnt>/<SAPSID>/exe
<sapmnt>/<SAPSID>/profile

<sapmnt>/<SAPSID>/global
Log on to the host of the new instance as user root.
Create the following mount points and mount them from the SAP global host:

<sapmnt>/<SAPSID>/exe
<sapmnt>/<SAPSID>/profile

<sapmnt>/<SAPSID>/global

A Caution

Make sure that these mount points are permanent. Otherwise automatic start of the instance
services does not work when you reboot the system.

Specifying the Initial Data Source of the User
Management Engine

During the installation of your SAP system, you have to specify the initial data source of the User Management
Engine (UME).

Prerequisites

You have planned how you want to configure user and access management for your SAP system to be installed
as described in Planning User and Access Management [page 53].
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Procedure

Using Central User Management

1. You install your SAP system as described in this installation guide.

2. Add the system to Central User Administration (CUA). For more information, see Configuring User
Management [page 163].

Using an LDAP directory as Source for User Data

1. Youinstall your SAP system as described in this installation guide.

2. Configure the user management of the newly installed SAP system to use an LDAP directory.
For more information, see Configuring User Management [page 163].

5.5

Prerequisites for Running Software Provisioning
Manager

Make sure you fulfil the following prerequisites before running the software provisioning manager.

* Forthe SL-Ul, make sure that the following web browser requirements are met:

You have one of the following supported browsers on the device where you want to run the SL-Ul:
* Google Chrome (recommended)

* Mozilla Firefox

* Microsoft Edge

* Microsoft Internet Explorer 11 or higher.
Always use the latest version of these web browsers.

If you copy the SL-UlI URL manually in the browser window, make sure that you open a new Web
browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or private
browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering with the
SL-UL

A Caution

The software provisioning manager uses a self-signed certificate, which is used temporarily only

while the software provisioning manager is running. This certificate is not trusted by the browser
unless it is imported manually by the user running the software provisioning manager. This behavior

is intentionally designed in this way because - unlike ordinary public web servers - the software
provisioning manager has different usage patterns. You must configure your browser do trust the
self-issued certificate of the software provisioning manager after carefully performing the “thumbprint”
verification described in Running Software Provisioning Manager [page 121] . For more information
about adding trusted certificates, see the documentation of your browser.

For more information about the SL-Ul, see Useful Information about Software Provisioning Manager [page
128].

* If you want to enable Internet Protocol Version 6 (IPv6), make sure that you set SAP_1Pv6_ACTIVE=1 in
the environment of the user with root authorization which you use to start the software provisioning
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manager. While running the software provisioning manager, this setting is then also added to the
environment of the <sapsid>adm user.

® Note

By applying this setting the SAP system administrator is responsible for configuring the IP version on
each host of the system landscape, before installing any additional instance to it.

The software provisioning manager uses shell scripts to obtain the environment for user <sapsid>adm.

* |If user <sapsid>adm does not yet exist, a working /bin/csh must be available on the host where
you run the software provisioning manager. For more information about recommended login shells, see
SAP Note 202227 P .

* |f <sapsid> already exists and uses csh, before you start the software provisioning manager, execute
the following command as user <sapsid> to make sure that the csh scripts are up-to-date, depending
on your UNIX OS platform:

/bin/csh -c "source /home/<sapsid>adm/.cshrc;env' or /bin/csh -c "'source /home/
<sapsid>adm/.login;env"
Make sure that your operating system does not delete the contents of the temporary directory /tmp or
the contents of the directories to which the variables TEMP, TMP, or TMPDIR point, for example by using a
crontab entry.
Make sure that the temporary directory has the permissions 755.

Make sure that you have at least 700 MB of free space in the installation directory for each installation
option. In addition, you need 700 MB free space for the software provisioning manager executables. If you
cannot provide 700 MB free space in the temporary directory, you can set one of the environment variables
TEMP, TMP, or TMPDIR to another directory with 700 MB free space for the software provisioning manager
executables.

You can set values for the TEMP, TMP, or TMPDIR environment variable to an alternative installation
directory as described in section Useful Information about Software Provisioning Manager [page 128].

® Note

Some tools such as jsplitter may create files while the software provisioning manager is running.
The required free space in the /tmp directory depends on the amount of databases which you intend to
unload.

Make sure that umask is set to 022 for the user with root permissions that you want to use for running the
software provisioning manager.

As the user with root permissions that you want to use for running the software provisioning manager,
enter the following command: umask 022

[Only valid for 'Platform": AIX
AIX: Make sure that you have set the limits for operating system users as described in SAP Note

323816/ .
| End of 'Platform'’: AIX

[Only valid for 'Platform': HP-UX, Linux, Oracle Solaris

Linux: On Linux, starting with SLES 15, RHEL 8 and Oracle Linux 8, and respective recent SAP kernel
patch levels, there is native integration into systemd. In this case, limits for operating system users root,
<sapsid>adm, and your database-specific operating system users do not need to be set any longer. Make
sure that polkit is installed. systemd requires polkit for authorization checks for the <sapsid>adm user.
For older Linux versions and SAP kernel patch levels, however, you must still set these limits. For more
information about how to proceed for older Linux versions, see the following instructions. For more
information about Linux with systemd and the relevant SAP kernel patch levels, see SAP Note 3139184 # .
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HP-UX, Oracle-Solaris, Linux (versions lower than SLES 15, RHEL 8 and Oracle Linux 8 or lower
SAP kernel patch levels): Make sure that you have set the limits for operating system users root,

<sapsid>adm, and your database-specific operating system users (see also sections Creating Operating
System Users and Groups [page 77] and Running Software Provisioning Manager [page 121].

A Caution

Caution: the Iimit mechanism supports hard- and soft-limits. The soft-limit cannot be bigger than

the hard-limit. The hard-limit can be set/increased by the root user like: l'imit -h <limit>
<new_value>, for example limit -h datasize unlimited.

* Using csh shell, the output of command limit needs to be at least as follows:

% Example

The following table lists example output taken from SUSE Linux Enterprise Server 15 (x86_64).

Output Properties
cputime unlimited
filesize unlimited
datasize unlimited
stacksize 8192 KB
coredumpsize unlimited
descriptors 8192
memoryuse unlimited

* Using sh or ksh shell, the output of command ulimit -aneeds to be at least as follows:

% Example

The following table lists example output taken from SUSE Linux Enterprise Server 15 (x86_64).

Output sh Output ksh Properties
cpu time (seconds) cpu time (seconds) unlimited
file size (blocks) file size (blocks) unlimited
data seg size (kbytes) data size (Kibytes) unlimited
stack size (kbytes) stack size (Kibytes) 8192 KB
core file size (blocks) core file size (blocks) unlimited
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Output sh Output ksh Properties

open files nofile 8192

max memory size (kbytes) max memory size (Kibytes) unlimited

l End of 'Platform': HP-UX, Linux, Oracle Solaris

* Make sure that you have defined the most important SAP system parameters as described in Basic
Installation Parameters [page 54] before you start the installation.

* Check that your installation host meets the requirements for the installation options that you want to
install.
For more information, see Running the Prerequisite Checker [page 40].

¢ If you want to install an additional application server instance in an existing SAP system, make sure that:

* Thereis exactly one entry in the Zusr/sap/sapservices file for each SAP instance installed on this
host. Be sure to check that the entry refers to the correct profile.

® There are no profile backup files with an underscore “_" in their profile name. If so, replace the “_" with
a".

o Example

Rename /usr/sap/S14/SYS/profile/S14 D20 zsi-aix693p2_D20081204
to /usr/sap/S14/SYS/profile/S14 DVEBMGS20 zsi-aix693p2.D20081204.

* Make sure that the following ports are not used by other processes:

* Port 4237 is used by default as HTTPS port for communication between the software provisioning
manager and the SL-Ul.
If this port cannot be used, you can assign a free port number by executing sapinst with the following
command line parameter:
SAPINST _HTTPS_PORT=<Free Port Number>

* Port 4239 is used by default for displaying the feedback evaluation form at the end of the software
provisioning manager processing.
The filled-out evaluation form is then sent to SAP using HTTPS.
If this port cannot be used, you can assign a free port number by executing sapinst with the following
command line parameter:
SAPINST _HTTP_PORT=<Free Port Number>

¢ If you want to perform the installation in unattended mode, see System Provisioning Using an Input
Parameter File [page 130] which describes an improved procedure using inifile.params.
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5.6 Running Software Provisioning Manager

This section describes how to run the software provisioning manager.

Prerequisites

For more information, see Prerequisites for Running Software Provisioning Manager [page 1171].

Context

The software provisioning manager has a web browser-based GUI named “SL-Ul of the software provisioning
manager” - “SL-Ul" for short.

This procedure describes an installation where you run the software provisioning manager and use the SL-UI,
that is you can control the processing of the software provisioning manager from a browser running on any
device.

For more information about the SL-Ul, see Useful Information about Software Provisioning Manager [page 128].

Procedure

1. Logon to the installation host as a user with root permissions.

A Caution

Make sure that the user with root permissions that you want to use for running the software
provisioning manager has not set any environment variables for a different SAP system or database.

If your security policy requires that the person running the software provisioning manager is not

allowed to know the credentials of a user with root permissions on the installation host, you

can specify another operating system user for authentication purposes. You do this using the
SAPINST_REMOTE_ACCESS_USER parameter when starting the sapinst executable from the command
line. You must confirm that the user is a trusted one. For more information, see SAP Note 1745524 # .

2. Make the installation media available.

For more information, see Preparing the Installation Media [page 93].

® Note

Even if you use the complete SAP kernel media, the software provisioning manager might prompt you
during the provisioning process for additional archives (*.SAR files) due to special Patch Level (PL)
requirements depending on categories such as the product, operating system, and database platform.
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<X> of the SAPEXEDB. SAR (for DBTYPE <Y>), but this PL of the SAPEXEDB. SAR is not contained
in the SAP kernel media . In this case you must download the required PL from https://me.sap.com/

softwarecenter® following the instructions given in Downloading SAP Kernel Archives (Archive-Based

Installation) [page 100].

- Recommendation

Make the installation media available locallyFor example: The software provisioning manager might

require a certain PL . For example, if you use Network File System (NFS), reading from media mounted

with NFS might fail.

[ Only valid for 'Platform': Oracle Solaris

® Note

Oracle Solaris: If you mount installation media, make sure that you do this with option nomaplcase.

l End of 'Platform': Oracle Solaris

3. Start the software provisioning manager from the directory to which you unpacked the Software
Provisioning Manager archive by entering the following command:

<Path_To_Unpack_Directory>/sapinst
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® Note

If you are using a Stack XML file (see Installation Using a Stack XML File
[page 371), you must call the sapinst executable with command line parameter
SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>:

/<Path_To_Unpack Directory>/sapinst
SAPINST_STACK_XML=<Absolute_Path_To_Stack XML_File>

® Note

If you need to assign virtual host names to the instance to be installed, and it is not possible to do
this by specifying it as an input parameter on the <Instance Name> Instance screen, you can assign
a virtual host name by starting the software provisioning manager with the SAPINST _USE_HOSTNAME
property:

<Path_To_Unpack_Directory>/sapinst SAPINST_USE_HOSTNAME=<Virtual_Host_Name>

For more information, see Virtual Host Name in SAP System Parameters [page 55].

® Note

If you are running a system copy with parallel export/import using the Migration Monitor and started
the export with command line option SUPPORT_DECLUSTERING=Ffalse, you must start the software
provisioning manager for the installation of the target database instance with command line option
SUPPORT_DECLUSTERING=true for the import during the target system installation.

For more information, see the system copy guides for Product Release “SAP NetWeaver 7.X-based"

at https://help.sap.com/viewer/swpm1Oguides [ » System Copy Option of Software Provisioning
Manager 1.0 » System Copy Guides - Software Provisioning Manager 1.0 3 or http://support.sap.com/
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sltoolset | » System Provisioning ¥ System Provisioning Scenarios ¥ Copy a System using Software
Provisioning Manager ¥ System Copy Guides - Software Provisioning Manager 1.0 3
4. The software provisioning manager now starts and waits for the connection with the SL-UlI.

You can find the URL you require to access the SL-Ul at the bottom of the shell from which you are running
the software provisioning manager.

B

Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]

B o L

® Note

If the host specified by <hostname> cannot be reached due to a special network configuration,

proceed as follows:

1. Terminate the software provisioning manager as described in Useful Information about Software
Provisioning Manager [page 128].

2. Restart the software provisioning manager from the command line with the
SAPINST_GUI_HOSTNAME=<hostname> property.
You can use a fully-qualified host name.

If you have a supported web browser (see Prerequisites for Running Software Provisioning Manager [page
117]) installed on the host where you run the software provisioning manager, you can open this URL directly
in the shell. Otherwise, open the URL in a supported web browser that runs on another device.

A Caution

After opening the browser URL, make sure that the URL in the browser starts with “https://" to avoid
security risks such as SSL stripping .

Before you reach the Welcome screen, your browser warns you that the certificate of the sapinst
process on this computer could not be verified.

Proceed as follows to avoid security risks such as a man-in-the-middle attack:

1. Click on the certificate area on the left hand side in the address bar of your browser, and view the
certificate.
2. Open the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones
displayed in the console output of the software provisioning manager.
Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate
printed in the software provisioning manager console:
1. Gotothe sapinst_exe . xxxxxx.xxxx directory in the temporary directory to which the
software provisioning manager has extracted itself:
<User_Home>/.sapinst/
2. Inthe sapinst_exe.xxxxxx.xxxx directory, execute the sapgenpse tool with the
command line option get_my name -p.
As a result, you get the server fingerprint or thumbprint from the server certificate.
3. Accept the warning to inform your browser that it can trust this site, even if the certificate could not
be verified.
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The SL-Ul opens in the browser by displaying the Welcome screen.

5. Onthe Welcome screen, choose the required option:

Perform preparations
Go to |» Generic Options » <Database> }» Preparations Jand choose the required task.
To install SAP Host Agent separately, choose | Generic Options » <Database> » Preparations » SAP
Host Agent 1.
Install an SAP system:
* Toinstall an SAP system based on SAP NetWeaver AS ABAP from scratch, choose | <Product>
» <Database> j Installation » Application Server ABAP » <System_Variant> J.
* Toinstall the application server ABAP for an SAP Process Integration system based on
SAP NetWeaver 7.5 from scratch, choose [ SAP NetWeaver 7.5 » <Database> » Installation
» Application Server ABAP for SAP Process Integration » <System Variant> 1.
* Toinstall the application server ABAP for an SAP Solution Manager 7.2 system from
scratch, choose | SAP Solution Manager 7.2 <Support_Release> j» <Database> j Installation
» Application Server ABAP » <System Variant> 3.
* Toinstall an SAP system based on SAP NetWeaver AS ABAP as target system of a system copy,
choose | <Product> » <Database> » System Copy » Target System » <System_Variant>
» Based on AS ABAP .
* Toinstall the application server ABAP for an SAP Process Integration system based on SAP
NetWeaver 7.5 as target system of a system copy, choose [+ SAP NetWeaver 7.5 » <Database>
» System Copy # Target System » <System_Variant> » Based on AS ABAP 7.
¢ Toinstall the application server ABAP for an SAP Solution Manager 7.2 system as target system
of a system copy, choose || SAP Solution Manager 7.2 <Support_Release> » <Database>
» System Copy » Target System » <System Variant> » Based on AS ABAP .
Install an additional SAP system instance, go to [ <Product> j» <Database> » Additional SAP
System Instances ¥ Additional Application Server Instance 3.
Perform other tasks or install additional components
Go to |* Generic Options » <Database> J and choose the required task.

6. Choose Next.

® Note

If there are errors during the self-extraction process of the software provisioning manager, you can find
the log file dev_selfex.out in the temporary directory.

7. Follow the instructions on the software provisioning manager screens and enter the required parameters.
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® Note

To find more information on each parameter during the Define Parameters phase, position the cursor
on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.
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® Note

If you want to install an ASCS instance with embedded SAP Web Dispatcher [page 32] or with
embedded SAP Gateway [page 34] or both, you must choose the Custom parameter mode.

When processing the screens for the ASCS instance installation, you are prompted to mark the
corresponding checkbox on the screen Additional Components to be Included in the ASCS Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters
required for the SAP Web Dispatcher installation on the subsequent screens.

® Note

If you are performing the target system installation in the context of a system copy with parallel export/
import using the Migration Monitor and the target database is declustered - that is you started the
software provisioning manager for the target database instance installation with command line option
SUPPORT_DECLUSTERING=true as described above - add the following load options parameter in the
SAP System Advanced Load Configuration screen:

-datacodepage <datacodepage_of source_system>

The advanced screen for load configuration only appears if you run the software
provisioning manager in Custom parameter mode. You can check the parameter within the
import_monitor_cmd.properties file located in the installation directory, in the loadArgs entry.

For more information, see the system copy guides at http:/support.sap.com/sltoolset# | » System
Provisioning  System Copy Option # Guide for Systems Based on SAP NetWeaver 7.1 & Higher . 3

A Caution

The digital signature of installation media and installation archives is checked automatically during the
Define Parameters phase while processing the Media Browser and - if you perform an archive-based
installation - the Software Package Browser screens.

Note that this automatic check is only committed once and not repeated if you modify artifacts such
as SAR archives or files on the media after the initial check has been done. This means that - if you
modify artefacts later on either during the remaining Define Parameters phase or later on during the
Execute Service phase - the digital signature is not checked again.

For more information, see SAP Note 2393060 #& .

After you have entered all requested input parameters, the software provisioning manager displays the
Parameter Summary screen. This screen shows both the parameters that you entered and those that the
software provisioning manager set by default. If required, you can revise the parameters before starting the
installation.

8. To start the installation, choose Next.

The software provisioning manager starts the installation and displays the progress of the installation.
When the installation has finished, the software provisioning manager shows the message: Execution of
<Option_Name> has completed.
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[ Only valid for 'Platform': HP-UX

A Caution

HP-UX only: If you decided to use 02 as the instance number, the instance fails to start during the
installation process. For more information about the cause, see SAP System Parameters [page 55] .
You must manually change the port number for report RSLGCOLL to continue with the installation.
Proceed as follows:

1. Gotodirectory /<sapmnt>/<SAPSID>/profile.
2. Edit DEFAULT.PFL.
3. Set the parameter rslg/Zcollect_daemon/listen_port to afree port number.

| End of ‘Platform'’: HP-UX

During the installation of an Application Server ABAP for SAP Process Integration 7.5 or SAP Solution
Manager 7.2, the following is automatically accomplished by the software provisioning manager:

* The Java users for the Application Server Java for SAP Process Integration or SAP Solution Manager
are created, which you have to install once the installation of the Application Server ABAP for SAP
Process Integration or SAP Solution Manager is complete.

* The Application Server ABAP for SAP Process Integration or SAP Solution Manager is prepared for
connection to the Application Server Java for SAP Process Integration or SAP Solution Manager.
For details on these users, see the Preparing an External ABAP System as Source for User Data chapter
of the Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.5 and SAP
Solution Manager 7.2 SR2 Java on <OS>: <DB> documentation, which you must use anyway to install
the Application Server Java for SAP Process Integration 7.5 or SAP Solution Manager 7.2 after you have
installed the Application Server ABAP.

If you are performing an Installation Using a Stack XML File [page 37], the Software Update Manager
(SUM) is started by the software provisioning manager at the end of the installation process. A browser
window opens with a link to Ul of the SUM that is already running. Follow the instructions on the SUM

dialogs and in the SUM Guide at https://support.sap.com/sltoolset# | # System Maintenance 3.

If required, delete directories with the name sapinst_exe . xxxxxx . xxxx after the software provisioning
manager has finished. Sometimes these directories remain in the temporary directory.

- Recommendation

Keep all installation directories until you are sure that the system, including all instances, is completely
and correctly installed. Once the system is completely and correctly installed, make a copy of the
installation directories with all their contents and save it to a physically separate medium, such

as an optical medium or a USB drive separate from your installation hosts. This might be useful

for analyzing issues occurring later when you use the system. For security reasons, do not keep
installation directories on installation hosts, but make sure that you delete them after saving them
separately.

If you copied the software provisioning manager software to your hard disk, you can delete these files when
the installation has successfully completed.

For security reasons, we recommend that you remove the operating system users from the group sapinst
after you have completed the installation.
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® Note

This step is only required, if you did not specify during the Define Parameters phase that the operating
system users are to be removed from the group sapinst after the execution of the software
provisioning manager has completed.

12. For security reasons, we recommend that you delete the .sapinst directory within the home directory of
the user with which you ran the software provisioning manager:

<User_Home>/_sapinst/

13. The software provisioning manager log files contain IP addresses and User IDs such as the ID of your
S-User. For security, data protection, and privacy-related reasons we strongly recommend that you delete
these log files once you do not need them any longer.

You find the software provisioning manager log files in the sapinst_instdir directory. For more
information, see Useful Information about Software Provisioning Manager [page 128].

5.7 Additional Information about Software Provisioning
Manager

The following sections provide additional information about the software provisioning manager.

Useful Information about Software Provisioning Manager [page 128]
This section contains some useful technical background information about the software provisioning
manager and the software provisioning manager's SL-UI.

System Provisioning Using an Input Parameter File [page 130]
Provisioning with software provisioning manager, for example installation, of SAP systems in
unattended mode with an input parameter file.

Restarting Interrupted Processing of Software Provisioning Manager [page 135]
Here you find information about how to restart the software provisioning manager if its processing has
been interrupted.

Entries in the Services File Created by Software Provisioning Manager [page 138]

Troubleshooting with Software Provisioning Manager [page 139]
This section tells you how to proceed when errors occur while the software provisioning manager is
running.

Using the Step State Editor (SAP Support Experts Only) [page 140]
This section describes how to use the Step State Editor available in the software provisioning
manager.
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5.7.1 Useful Information about Software Provisioning

Manager

This section contains some useful technical background information about the software provisioning manager
and the software provisioning manager's SL-UlI.
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The software provisioning manager has a framework named “SAPinst”. For more information about the
current SAPinst Framework version and its features, see SAP Note 3207613# (SAPinst Framework 753
Central Note).

The software provisioning manager has the web browser-based “SL-Ul of the software provisioning
manager” - “SL-UI" for short.
The SL-Ul uses the SAP Ul Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5
rendering library based on JavaScript. The benefits of this new user interface technology for the user are:
® Zero foot print, since only a web browser is required on the client
* New controls and functionality, for example, view logs in web browser.
As of version 1.0 SP24 Patch Level (PL) 5, the software provisioning manager comes with a new look and
feel of the SL-UI. For more information, see https://blogs.sap.com/2018/11/10/new-look-for-software-
provisioning-manager/ #r .
The SL-Ul connects the web browser on a client with the sapinst executable - which is part of software
provisioning manager - running on the installation host using the standard protocol HTTPS.
For the SL-Ul the software provisioning manager provides a pre-generated URL at the bottom of the shell
from which you are running the software provisioning manager . If you have a supported web browser
installed on the host where you run the software provisioning manager, you can start the SL-Ul directly
from this URL. Otherwise, open a web browser supported by the SL-Ul on any device and run the URL from
there.
For more information about supported web browsers see Prerequisites for Running Software Provisioning
Manager [page 117].
If you need to run the SL-Ul in accessibility mode, apply the standard accessibility functions of your web
browser.

As soon as you have started the sapinst executable, the software provisioning manager creates

a .sapinstdirectory underneath the /home/<User> directory where it keeps its log files. <User> is

the user with which you have started the software provisioning manager.

After you have reached the Welcome screen and selected the relevant software provisioning manager
option for the SAP system or instance to be installed , the software provisioning manager creates a
directory sapinst_instdir where it keeps its log files, and which is located directly below the temporary
directory. The software provisioning manager finds the temporary directory by checking the value of the
TEMP, TMP, or TMPDIR environment variable. If no value is set for these variables, the software provisioning
manager uses /tmp by default.

All'log files which have been stored so far in the .sapinst folder are moved to the sapinst_instdir
directory as soon as the latter has been created.

If you want the sapinst_instdir directory to be created in another directory than /tmp, set the
environment variable TEMP, TMP, or TMPDIR to this directory before you start the software provisioning
manager.
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Shell Used Command

Bourne shell (sh) TEMP=<Directory>

export TEMP

C shell (csh) setenv TEMP <Directory>
Korn shell (ksh) export TEMP=<Directory>
A Caution

Make sure that the installation directory is not mounted with NFS, or there might be problems when
the Java Virtual Machine is started.

The software provisioning manager records its progress in the keydb . xml file located in the
sapinst_instdir directory. Therefore, if required, you can continue with the software provisioning
manager from any point of failure, without having to repeat the already completed steps and without
having to reenter the already processed input parameters. For security reasons, a variable encryption key
is generated as soon as the sapinst_instdir directory is created by the software provisioning manager.
This key is used to encrypt the values written to the keydb . xml file.

- Recommendation

We recommend that you keep all installation directories until the system is completely and correctly
installed.

¢ The software provisioning manager extracts itself to the temporary directory. These executables are
deleted again after the software provisioning manager has stopped running.
Directories called sapinst_exe . XxXxXxxx . Xxxx sometimes remain in the temporary directory after the
software provisioning manager has finished. You can safely delete them.
The temporary directory also contains the log file dev_selfex.out from the self-extraction process of
the software provisioning manager, which might be useful if an error occurs.

A Caution

If the software provisioning manager cannot find a temporary directory, the installation terminates with
the error FCO-00058.

¢ Tosee alist of all available software provisioning manager properties (command line options) and related
documentation, start the software provisioning manager as described above with command line parameter
-p:
-/sapinst -p

¢ If you want to perform the installation in unattended mode, see System Provisioning Using an Input
Parameter File [page 130] which describes an improved procedure using inifile.params.

* Ifrequired, stop the software provisioning manager by choosing the Cancel button.

® Note

If you need to terminate the software provisioning manager, press +[c]
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5.7.2 System Provisioning Using an Input Parameter File

Provisioning with software provisioning manager, for example installation, of SAP systems in unattended mode
with an input parameter file.

Prerequisites

Provisioning of SAP systems can also be done in unattended mode without the user interface of software
provisioning manager. This means that, after inserting the required parameters into a parameter-file and
running the sapinst executable by providing the path to this parameter-file , the installation will run in the
background and no further user interaction is required.

Context

This section describes the steps that you need to execute in addition to the procedure described in this guide,
when running software provisioning manager in unattended mode using an input parameter file.

Since the new Web-based SL-Ul (see Useful Information about Software Provisioning Manager [page 128]) was
introduced in 2017 there are two ways to run the unattended mode: “observer mode” and “non-observer
mode”.

Observer Mode

If you are running an installation in unattended mode but you are sitting in front of the screen, you might want
to check the progress from time to time. In this case the “observer mode” makes sense.

Start the installation as described below in the Solution section, using the following parameters:

SAPINST_INPUT_PARAMETERS_URL=<path_to_your_parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
SAPINST_SKIP_DIALOGS=true

The software provisioning manager will start the installation in the background AND start a Web Dispatcher
and provide an URL to access the SL-Ul. The user who has started the installation can now connect to the URL
and observe the progress of the installation, for example to look at the logfiles in the Web browser. However, all
parameters will be taken from the input parameter file and can not be changed in the Web browser.

Non-Observer Mode

Choose that mode if you want to run a “scripted” or by other means automated scenario, for example
overnight. In that case it is crucial that the process is started without a Web Dispatcher and therefore without
the software provisioning manager's SL-Ul. Otherwise, the automation could be stuck if software provisioning
manager encounters a situation that requires user interaction.

Start the installation as described below in the Solution section, using the following parameters (use the same
parameters like for Observer Mode, but provide SAPINST_START_GUISERVER=Talse in addition):

SAPINST_INPUT_PARAMETERS_URL=<path_to_your_parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
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SAPINST_SKIP_DIALOGS=true
SAPINST_START GUISERVER=False

This will start the installation but this time NO Web Dispatcher will be started and no URL to access the SL-Ul

will be provided either. So the user can not follow the processing of the installation in a Web browser and the
installation will run completely in the background.

If the process runs into an error, the software provisioning manager will abort and you have to check for the
reason in the log files.

Restrictions

In exceptional cases, parameters prompted or displayed in the Software Provisioning Manager Ul are not
maintainable in the input parameter file. If one of those parameters, that are only available in the Ul mode of
the Software Provisioning Manager, is needed for your unattended installations, you should create a ticket in
the best fitting component below BC-INS to get the issue analyzed.

Must Know about the Input Parameter File

* The input parameter file only contains values that you entered in the software provisioning manager's
SL-UL.

* Withthe SAPinst 749.0.69 or by other means patch we provide a better encryption of passwords in
software provisioning manager files:

If the input parameter file has parameters which are encrypted with Des25 encryption, the instkey . pkey
file available in the installation directory contains the key for the encryption. The instkey . pkey file must

be always located in the same directory as the input parameter file and is used to decrypt the values of the
encrypted parameters. If you need to copy an input parameter file to another directory, you must also copy

the instkey.pkey file to this directory.
* Not explicitly set parameters are documented as comments in the generated input parameter file.

* Each parameter has got a documentation assigned as a comment on top.
o Example
Example for a parameter that is not used and therefore commented out:

# Specify whether software provisioning manager is to drop the schema if
it exists. <= Documentation
# HDB_Schema_Check_Dialogs.dropSchema = false

% Example

Example for a parameter that is used:

# The name of the database schema. <= Documentation
HDB_Schema_Check Dialogs.schemaName = SAPABAP2

* You have to manually provide the media information, using the following convention:

SAPINST.CD.PACKAGE .<unique_media_name>=<location>

* For each media location you must manually insert a dedicated line in your input parameter file. The

software provisioning manager does not automatically take over the media locations you entered while

processing the Media Browser dialog.

* For <media_name> you can choose any value, but the <location> must be unique.
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¢ To find out the required media entries, open the summary.html file which you can find in the
installation directory and go to the Dialog "Media" section.

¢ Make sure that you enter the full paths to all required media, relative paths are not sufficient.

% Example
Example on UNIX:

SAPINST.CD.PACKAGE .KERNEL = /mnt/KERNEL
SAPINST.CD.PACKAGE.LOAD = /mnt/LOAD
SAPINST.CD.PACKAGE .RDBMS = /mnt/RDBMS

% Example
Example on Windows:

SAPINST.CD.PACKAGE.KERNEL = C:\sapdvds\KERNEL
SAPINST.CD.PACKAGE.LOAD = C:\sapdvds\LOAD
SAPINST.CD.PACKAGE .RDBMS =C:\sapdvds\RDBMS

* |If one media contains several subfolders, you can specify it in one of the following ways:

% Example
The SAP Export DVDs/media:

Installation Master /usr/local/TESI/SWPM/slinst_d_stream/
IM_0S400 PPC64

Installation Export NW73 (folder EXP1) /sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP1

Installation Export NW73 (folder EXP3) /sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP3

Installation Export NW73 (folder EXP2) /sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP2

* By specifying each subfolder:

SAPINST.CD.PACKAGE . ExportNW73EXP1=/sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP1

SAPINST.CD.PACKAGE . ExportNW73EXP2=/sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP3

SAPINST.CD.PACKAGE . ExportNW73EXP3=/sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP3

* By specifying only the root-folder:
SAPINST.CD.PACKAGE . ExportNW73=/sapmnt/mediaserver2/arch04_6/51042309

¢ Restriction: Currently you can only specify complete media, not paths to single files like * . SAR
archives.
* When performing a system copy, you need to add one additional media path:

SAPINST.CD.PACKAGE.MIGRATION1 = <full path to ABAP Export media>
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* Caution:
If you want to use archives for your installation, you must copy all files that are to be used to a single

directory. In the input parameter file you must specify this directory as a download basket, using the
archives.downloadBasket parameter.

Make sure that there is only one version of the same archive in the directory, for example
SAPEXE_<Version>_SAR

Procedure

1. You plan and prepare the run as described in Planning [page 36] and Preparation [page 76].
2. Create your input parameter file as follows:
1. Start software provisioning manager as described in Running Software Provisioning Manager [page
121].
2. Choose the option you want to run, and follow the instructions on the screens by entering all
parameter values.
3. Stop after the Parameter Summary screen has been displayed.
4. Find the input parameter file named “inifile.params” in the installation directory.
* Inthe same directory, you will also find the instkey . pkey file with the keys for the encrypted
parameters. For more information, see Must Know about the Input Parameter File above.
* Inthe same directory, you will also find the summary . html file with the required media locations.
For more information, see Must Know about the Input Parameter File above.
5. Ifrequired, you can rename the “inifile.params” file as you wish.
3. Adjust the values of the input parameter file as follows:
1. Edit your input parameter file and modify the parameters according to your needs.
2. Add required media or archives information line by line.
4. l|dentify the Product-ID:
* Tostartin unattended mode, you need to know the component ID for the option that are required for
your provisioning scenario.
Proceed as follows:
1. Open the sapinst_dev. log in the installation directory.
2. Check for the “product-id”

% Example

product-id=NW_ABAP_ASCS:NW750.ADA.ABAP

¢ Alternatively, you can check the header of the generated input parameter file.
% Example

product id “NW_ABAP_ASCS:NW750.ADA.ABAP"

5. Run the software provisioning manager [page 121] with the parameters required for unattended mode:

Make sure that the instkey. pkey file with the keys for the encrypted parameters is available in the
same directory as the input parameter file. Otherwise the encrypted parameters cannot be decrypted.
For more information, see Must Know about the Input Parameter File above.
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* In observer mode: Start the sapinst executable from an empty directory with the following
parameters:

SAPINST_INPUT_PARAMETERS URL=<path_to_your_parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
SAPINST_SKIP_DIALOGS=true
* In non-observer mode: Start the sapinst executable from an empty directory with the following
parameters:

SAPINST_INPUT_PARAMETERS URL=<path_to_your_ parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
SAPINST_SKIP_DIALOGS=true
SAPINST_START_GUISERVER=Talse

6. After software provisioning manager has completed, perform follow-up activities as described in Post-

Installation [page 142].

Related Information

SAP Note 2230669 Provisioning with software provisioning manager - for example installation - of SAP
systems in unattended mode with an input parameter file. #r

SAP Note 2849054 Software Update Manager Automation with software provisioning manager ¥

SAP Note 2742212 Unattended installation fails with "Empty directory name is not allowed." message#

SAP Note 2626837 'isUnicode': Radio group contains an invalid value ". Valid values are: false|true|#

SAP Note 2669183 ASCS installation failure with Software Provisioning Manager unattended mode (Non-
Observer mode) #

SAP Note 2482103 Installation with Software Provisioning Manager in unattended mode using input parameter
file fails

SAP Note 2974889 Installation with Software Provisioning Manager in unattended mode fails in step getDBInfo
due to missing paramerters#r
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5.7.3 Restarting Interrupted Processing of Software

Provisioning Manager

Here you find information about how to restart the software provisioning manager if its processing has been

interrupted.

Context

The processing of the software provisioning manager might be interrupted for one of the following reasons:

* Anerror occurred during the Define Parameters or Execute phase:
The software provisioning manager does not abort the installation in error situations. If an error occurs, the
installation pauses and a dialog box appears. The dialog box contains a short description of the choices
listed in the table below as well as a path to a log file that contains detailed information about the error.

* You interrupted the processing of the software provisioning manager by choosing Cancel in the SL-Ul.

A Caution

If you stop an option in the Execute phase, any system or component installed by this option is
incomplete and not ready to be used. Any system or component uninstalled by this option is not

completely uninstalled.

The following table describes the options in the dialog box:

Option Definition
Retry The software provisioning manager retries the installation from the point of failure
without repeating any of the previous steps.
This is possible because the software provisioning manager records its progress in
the keydb . xml file.
We recommend that you view the entries in the log files, try to solve the problem, and
then choose Retry.
If the same or a different error occurs, the software provisioning manager displays
the same dialog box again.
Stop The software provisioning manager stops the installation, closing the dialog box and
the software provisioning manager's SL-UI.
The software provisioning manager records its progress in the keydb . xml file.
Therefore, you can continue with the software provisioning manager from the point of
failure without repeating any of the previous steps. See the procedure below.
Continue The software provisioning manager continues the installation from the current point.
View Log Access installation log files.
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® Note

You can also terminate the software provisioning manager by choosing +[c|but we do not
recommend this because it kills the process immediately.

The following procedure describes the steps to restart an installation, which you stopped by choosing Stop, or
to continue an interrupted installation after an error situation.

Procedure

1. Logon to the installation host as a user with the required permissions as described in Running Software
Provisioning Manager [page 121].

2. Make sure that the installation media are still available.

For more information, see Preparing the Installation Media [page 93] .

- Recommendation

Make the installation media available locally. For example, if you use remote file shares on other
Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from
media mounted with NFS might fail.

[ Only valid for 'Platform': Oracle Solaris

® Note

Oracle Solaris: If you mount installation media, make sure that you do this with option nomaplcase.

| End of 'Platform': Oracle Solaris

3. Restart the software provisioning manager from the directory to which you unpacked the Software
Provisioning Manager archive by executing the following command:

<Path_To_Unpack_Directory>/sapinst
4. The software provisioning manager is restarting.

You can find the URL you require to access the SL-Ul at the bottom of the shell from which you are running
the software provisioning manager.

Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]

® Note

If the host specified by <hostname> cannot be reached due to a special network configuration,

proceed as follows:

1. Terminate the software provisioning manager as described in Useful Information about Software
Provisioning Manager [page 128].
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2. Restart the software provisioning manager from the command line with the
SAPINST_GUI_HOSTNAME=<hostname> property.
You can use a fully-qualified host name.

If you have a supported web browser (see Prerequisites for Running Software Provisioning Manager [page
117]) installed on the host where you run the software provisioning manager, you can open this URL directly
in the shell. Otherwise, open the URL in a supported web browser that runs on another device.

A Caution

After opening the browser URL, make sure that the URL in the browser starts with “https://" to avoid
security risks such as SSL stripping .

Before you reach the Welcome screen, your browser warns you that the certificate of the sapinst
process on this computer could not be verified.

Proceed as follows to avoid security risks such as a man-in-the-middle attack:
1. Click on the certificate area on the left hand side in the address bar of your browser, and view the
certificate.
2. Open the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones
displayed in the console output of the software provisioning manager.
Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate
printed in the software provisioning manager console:
1. Gotothe sapinst_exe . xxxxxx.xxxx directory in the temporary directory to which the
software provisioning manager has extracted itself:
<User_Home>/_sapinst/
2. Inthe sapinst_exe . xxxxxx.xxxx directory, execute the sapgenpse tool with the
command line option get_my_name -p.
As a result, you get the server fingerprint or thumbprint from the server certificate.

3. Accept the warning to inform your browser that it can trust this site, even if the certificate could not
be verified.

The SL-Ul opens in the browser by displaying the Welcome screen.

5. From the tree structure on the Welcome screen, select the installation option that you want to continue and
choose Next.
The What do you want to do? screen appears.

6. Onthe What do you want to do? screen, decide between the following alternatives and continue with Next:
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Alternative Behavior

Perform a new run The software provisioning manager does not continue the interrupted installa-
tion option. Instead, it moves the content of the old software provisioning man-
ager directory and all software provisioning manager-specific files to a backup
directory. Afterwards, you can no longer continue the old option.

The following naming convention is used for the backup directory:

log_<Day>_<Month>_<Year>_<Hours>_<Minutes>_<Seconds>

% Example

log 01 Oct 2016 13 47 56

® Note

All actions taken by the installation before you stopped it (such as creating
directories or users) are not revoked.

A Caution

The software provisioning manager moves all the files and folders to a new
log directory, even if these files and folders are owned by other users. If
there are any processes currently running on these files and folders, they
might no longer function properly.

Continue with the existing one The software provisioning manager continues the interrupted installation from
the point of failure.

5.7.4 Entries in the Services File Created by Software
Provisioning Manager

After the installation has finished successfully, the software provisioning manager has created the following
entries in /etc/services:

sapdp<Instance_Number> = 32<lInstance_Number>/tcp
sapdp<Instance_Number>s = 47<Instance_Number>/tcp
sapgw<Instance_Number> = 33<Instance_Number>/tcp
sapgw<Instance_Number>s = 48<Instance_Number>/tcp

sapms<SAPSID> = 36<Instance_Number>/tcp (unless you specified another value during the installation)
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® Note

* There s a port created for every possible instance number, regardless of which instance
number you specified during the installation. For example, for sapgw<Instance_ Number> =
33<Instance_Number>/tcp the following range of entries is created:
sapgw00 = 3300/tcp
sapgw0l = 3301/tcp
sapgw02 = 3302/tcp

L---1
sapgw98 = 3398/tcp
sapgw99 = 3399/tcp

* |fthere is more than one entry for the same port number, this is not an error.

5.7.5 Troubleshooting with Software Provisioning Manager

This section tells you how to proceed when errors occur while the software provisioning manager is running.

Context

If an error occurs, the software provisioning manager:

* Stops processing
* Displays a dialog informing you about the error

Procedure

1. Check SAP Note SAP Note 3207613 (SAPinst Framework 753 Central Note) for known software
provisioning manager issues.

2. If anerror occurs during the Define Parameters or the Execute Service phase, do one of the following:

* Try to solve the problem:

* To check the software provisioning manager log files (sapinst. log and sapinst_dev. log) for
errors, choose the LOG FILES tab.

® Note

The LOG FILES tab is only available if you have selected on the Welcome screen the relevant
software provisioning manager option for the SAP product to be installed .

If you need to access the log files before you have done this selection, you can find them in
the .sapinst directory underneath the /home/<User> directory, where <User> is the user
that you used to start the software provisioning manager.

For more information, see Useful Information about Software Provisioning Manager [page
128].

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
Installation PUBLIC 139


http://help.sap.com/disclaimer?site=https://me.sap.com/notes/3207613

* To check the log and trace files of the software provisioning manager's SL-Ul for errors, go to the
directory <User_Home>/_.sapinst/

® Then continue by choosing Retry.

* If required, abort the software provisioning manager by choosing Cancel in the tool menu and restart
the software provisioning manager. For more information, see Restarting Interrupted Processing of
Software Provisioning Manager [page 135].

3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*,

For more information about using subcomponents of BC-INS* see SAP Note 1669327 #ar.

5.7.6 Using the Step State Editor (SAP Support Experts Only)

This section describes how to use the Step State Editor available in the software provisioning manager.

® Note

Only use the Step State Editor if the SAP Support requests you to do so, for example to resolve a
customer incident.

Prerequisites

* SAP Support requests you to use the Step State Editor.

* Make sure that the host where you run the software provisioning manager meets the requirements listed in
Prerequisites for Running Software Provisioning Manager [page 117].

Procedure

1. Start the software provisioning manager from the command line as described in Running
Software Provisioning Manager [page 121] with the additional command line parameter
SAPINST_SET_STEPSTATE=true

2. Follow the instructions on the software provisioning manager screens and fill in the parameters prompted
during the Define Parameters phase until you reach the Parameter Summary screen.

3. Choose Next.

The Step State Editor opens as an additional dialog. Within this dialog you see a list of all steps to be
executed by the software provisioning manager during the Execute Service phase. By default all steps are

in an initial state. Underneath each step, you see the assigned software provisioning manager component.
For each step you have a Skip and a Break option.

* Mark the checkbox in front of the Break option of the steps where you want the software provisioning
manager to pause.

* Mark the checkbox in front of the Skip option of the steps which you want the software provisioning
manager to skip.
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4. After you have marked all required steps with either the Break or the Skip option, choose OK on the Step
State Editor dialog.

The software provisioning manager starts processing the Execute Service phase and pauses one after
another when reaching each step whose Break option you have marked. You can now choose one of the
following:

* Choose OK to continue with this step.

* Choose Step State Editor to return to the Step State Editor and make changes, for example you
can repeat the step by marking the checkbox in front of the Repeat option.

* Choose Cancel to abort the software provisioning manager.

5. Continue until you have run through all the steps of the Execute Service phase of the software provisioning
manager.
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6 Post-Installation

6.1 Post-Installation Checklist

This section includes the post-installation steps that you have to perform for the following:

® Note
SAP systems based on SAP NetWeaver 7.4:

You can automate some of these post-installation steps by running task list

SAP_BASIS _SETUP_INITIAL_CONFIG in the ABAP task manager for lifecycle management automation
(transaction STCO1). For more information, see SAP NetWeaver 7.4 and Higher: Performing Automated
Initial Setup (Optional) [page 145].

The sections describing these steps are marked with a corresponding note at the beginning.

* Standard, distributed, or high-availability system
* Additional application server instance

More detailed information about the steps are available in the linked sections.

Standard, Distributed, or High-Availability System

® Note

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a
standard system, you can ignore references to other hosts.

1. Ifrequired, you perform a full installation backup [page 171] immediately after the installation has finished.

2. You check and if necessary modify the settings for the operating system users for your SAP system if they
were created by the software provisioning manager.
For more information, see Creating Operating System Users and Groups [page 77].

3. You check whether you can log on to the Application Server ABAP [page 144].

4. SAP systems based on SAP NetWeaver 7.4 and higher only: You perform the automated initial setup
[page 145].

® Note

This step is optional.

5. You install the SAP license [page 146].
6. If you have installed a high-availability system, you set up the licenses for high availability [page 147].
7. You configure the remote connection to SAP support [page 149].
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8. You enable the Note Assistant to apply note corrections [page 149].

9. You configure the documentation provided on the SAP Help Portal [page 150].

10. You perform the consistency check [page 152].

11. You configure the Transport Management System [page 153].

12. For production systems it is highly recommended that you connect the system to SAP Solution Manager
[page 154].

13. You apply the latest kernel and Support Packages [page 156].

14. You perform post-installation steps for the application server ABAP [page 158].

15. If you installed a high-availability system based on SAP NetWeaver AS for ABAP 7.52, you can decide
whether you want to switch to the new standalone enqueue server 2 and enqueue replicator 2 [page 160].

16. If you installed the ABAP part of an SAP Solution Manager 7.2 or SAP Process Integration 7.5 system,
enable HTTPS communication with the Java part of the system.
For more information, see SAP Solution Manager 7.2, SAP Process Integration 7.5 only: Enabling HTTPS
Communication for ABAP [page 161].

17. If required, you install additional languages and perform language transport [page 162].

18. You ensure user security [page 164].

19. You perform the client copy [page 168].

20.SAP systems based on SAP NetWeaver 7.4 and higher only: If required, you change the keys for the
secure storage [page 169].

21. You enable the database [page 170].

22.You perform a full installation backup [page 171].

23.1f you chose to install an embedded SAP Web Dispatcher within the ASCS instance, you log on to the SAP
Web Dispatcher Management Console [page 173]

24.1f you chose to install an embedded SAP Web Dispatcher within the ASCS instance, you configure the SAP
Web Dispatcher [page 174]

25.1f you chose to install an embedded Gateway within the ASCS instance, you configure the SAP Gateway
[page 175].

26.You check the Master Guide for your SAP Business Suite application, SAP Solution Manager system
(section Implementation Sequence) or SAP NetWeaver application (section Configuration of Systems and
Follow-Up Activities) for additional implementation and configuration steps, such as language installation,
monitoring, work processes, transports, SAP license, printers, system logs, and connectivity to system
landscape directory (SLD).

Additional Application Server Instance

1. Ifrequired, you perform an installation backup [page 171] immediately after the installation has finished.
2. You check and if necessary modify the settings for the operating system users for your SAP system if they
were created by the software provisioning manager.

For more information, see Creating Operating System Users and Groups [page 77].

You check whether you can log on to the Application Server ABAP [page 144].

You configure the documentation provided on the SAP Help Portal [page 150].

You ensure user security [page 164].

R

You perform a full installation backup [page 171].
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6.2 Logging On to the Application Server ABAP

You need to check that you can log on to the Application Server ABAP with the standard users, given in the
table below.

Prerequisites

* The SAP system is up and running.

* You have installed the SAP front-end software.

Context

In a distributed or high-availability system, you check whether you can log on to every instance of the SAP
system that you installed.

® Note

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 .

User User Name Client
SAP system user SAP* 000, 001, 066
DDIC 000, 001

You access the application server ABAP using SAP Logon.

Procedure

1. Start SAP Logon on the host where you have installed the SAP front-end software as follows:
* SAP GUI for Windows:
On the host where you have installed the front end, choose:
|» Start » Programs » SAP Front End<Release> » SAPlogon 3

* SAP GUI for Java:
Enter the following command from the GUI installation directory:
guilogon
2. Create alogon entry for the newly installed system in the SAP Logon.

For more information about creating new logon entries, press .
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3. When you have created the entry, log on as user SAP* or DDIC.

6.3 SAP NetWeaver 7.4 and Higher: Performing Automated
Initial Setup (Optional)

After the installation of a new SAP system you have to configure the system to enable its usage. For example,
you have to install an SAP license, create logon groups, and configure the Transport Management System
(TMS) and security settings. If your SAP system is based on SAP NetWeaver 7.4 and higher, you can profit from
an automated initial setup which executes these steps automatically.

Prerequisites

Note that the best point in time when you perform automated initial setup depends on the following:

¢ If you have run the installation using a Stack XML file (also called “up-to-date installation™), we recommend
that you proceed as follows:
1. Perform the complete installation and update process - that is the installation with Software
Provisioning Manager and the update with Software Update Manager.
2. Perform the automated initial setup.
By running first the update and then the automated initial setup, you can profit from latest features and
fixes in the initial setup configuration content.
Background: As of Software Logistics Toolset 1.0 SPS12, the installation procedure with Software
Provisioning Manager 1.0 SPO7 and higher also includes basic configuration activities, such as initial basic
configuration of transport management, which are a prerequisite for the subsequent maintenance process.
In previous SP versions of Software Logistics Toolset 1.0, this prerequisite had to be fulfilled by running
automated initial setup before the update process.
¢ If you have not run the installation using a Stack XML file (also called “up-to-date installation™), we
recommend that you proceed as follows:
1. Runautomated initial setup directly after the installation, using the automation content provided with
the system load.
2. Apply the Support Packages to benefit from the already performed initial configuration — for example,
using the already configured Transport Management System.
3. Consider running the automated initial setup a second time, especially if you want to benefit from
the latest improvements and fixes offered by the updated automation content provided by the applied
Support Package.

For more information about automated initial setup, see the SAP Community Network at https://
wiki.scn.sap.com/wiki/display/SL/Automated+Initial+Setup+of+ ABAP-Based+Systems .

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
Post-Installation PUBLIC 145


http://help.sap.com/disclaimer?site=https%3A%2F%2Fwiki.scn.sap.com%2Fwiki%2Fdisplay%2FSL%2FAutomated%2BInitial%2BSetup%2Bof%2BABAP-Based%2BSystems
http://help.sap.com/disclaimer?site=https%3A%2F%2Fwiki.scn.sap.com%2Fwiki%2Fdisplay%2FSL%2FAutomated%2BInitial%2BSetup%2Bof%2BABAP-Based%2BSystems

Procedure

1. Start the ABAP Task Manager by calling transaction STCOL.
2. Choose task list SAP_BASIS_SETUP_INITIAL_CONFIG.

3. Select the tasks you want to get executed.

For this, the task list offers sophisticated online documentation of the comprised activities.

4. Choose Execute.

You are guided through the configuration steps where you can enter the required values.

Related Information

Installation Using a Stack XML File [page 37]

Installing the SAP License [page 146]

Configuring the Remote Connection to SAP Support [page 149]

Configuring the Change and Transport System [page 153]

Applying the Latest Kernel and Support Package Stacks [page 156]
Performing Post-Installation Steps for the ABAP Application Server [page 158]
Performing the Consistency Check [page 152]

6.4 Installing the SAP License

You must install a permanent SAP license. When you install your SAP system, a temporary license is
automatically installed.

® Note
SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 145].

Context

A Caution
Before the temporary license expires, you must apply for a permanent license key from SAP.

We recommend that you apply for a permanent license key as soon as possible after installing your system.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
146 PUBLIC Post-Installation



For more information about SAP license keys and how to obtain them, see http://support.sap.com/
licensekey .

Procedure

Install the SAP license as described in the SAP Library at:

® Note

If you have installed a high-availability system, proceed as described in High Availability: Setting Up
Licenses [page 147].

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Pack-
agel
http://help.sap.com/nw731#

® SAP NetWeaver 74
http://help.sap.com/nw74 ¥

® SAP NetWeaver 7.5
http://help.sap.com/nw75 "

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap #r

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|+ Application Help ¥ Function-Oriented View 1 Solution Life
Cycle Management > SAP Licenses }

6.5 High Availability: Setting Up Licenses

You need to install a permanent license, which is determined by the hardware environment of the message
server.

Prerequisites

The SAP system is up and running.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
Post-Installation PUBLIC 147


http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Flicensekey
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Flicensekey
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw731
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw74
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw75
http://help.sap.com/disclaimer?site=https%3A%2F%2Fhelp.sap.com%2Fnw751abap
http://help.sap.com/disclaimer?site=https%3A%2F%2Fhelp.sap.com%2Fnw752abap

Context

SAP has implemented a license mechanism for switchover solutions and clustered environments. Your
customer key is calculated on the basis of local information on the message server host. This is the host
machine where the ABAP central services instance (ASCS instance) runs.

To be able to perform a switchover, the temporary license that is installed automatically with the ASCS
instance is not sufficient. You first need to install a permanent license, which is determined by the hardware
environment of the message server. Since SAP's high-availability (HA) solution stipulates two or more cluster
nodes (host machines) where the message server is enabled to run, you have to order as many license keys
[page 146] as you have cluster nodes.

When we receive confirmation from your vendor that you are implementing a switchover environment, we
provide the required license keys for your system, one key for each machine.

Procedure

1. To find the hardware ID of the primary host, log on to any application server instance of the SAP system
and call transaction SLICENSE.

2. Perform a switchover of the ABAP central services instance (ASCS) to another node in the cluster and
repeat the previous step.
Repeat this for all remaining nodes in the cluster.

3. To obtain the two license keys, enter the hardware IDs for each cluster node, where message server is
enabled to run: http:/support.sap.com/licensekey #s

4. Toimport the files containing the two licenses, log on to any application server instance of the SAP system
and call transaction SLICENSE.

5. Perform a switchover of the ABAP central services instance (ASCS) to another node in the cluster and
repeat the previous step.

Repeat this for all remaining nodes in the cluster.

Results

The license is no longer a problem during switchover. This means you do not need to call saplicense in your
switchover scripts.
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6.6 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the Early Watch
Service orthe GoingLive Service. Therefore, you have to set up a remote network connection to SAP.

® Note

SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_ CONFIG_0SS COMM inthe ABAP task
manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 74 and Higher: Performing Automated Initial Setup (Optional) [page 145].

For more information about configuring the remote connection to SAP Support, see the SAP Support Portal at
https://support.sap.com/remote-support.html| .

6.7 Enabling Note Assistant to Apply Note Corrections

Use the Note Assistant to implement note corrections in your ABAP system.

Context

The Note Assistant allows you to automatically implement note corrections in your ABAP system. For
more information about the Note Assistant, see https:/support.sap.com/noteassistant# and https:/

help.sap.com/netweaver | # SAP NetWeaver Platform » <Release> j» Application Help » SAP NetWeaver
Library: Function-Oriented View ¥ Solution Life Cycle Management ¥ Software Logistics  Note Assistant 4.

Procedure

1. Follow the instructions in SAP Note 2836302#% for enabling the Note Assistant for TCI and digitally signed
SAP Notes.

2. Apply important SAP Notes for SAP_BASIS as described in SAP Note 1668882 .
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6.8 Configuring Documentation Provided on the SAP Help
Portal

In transaction SR13, you can configure the settings of your backend system to point to documentation that is
provided on the SAP Help Portal.

Context

You can configure your backend system to access documentation that is provided on the SAP Help Portal.
Prerequisites

* The documentation you want to access must be available on the SAP Help Portal.
* The users who access the documentation must have access to the Internet.
* You can configure an ABAP system to connect to only one combination of product and version.

If you cannot fulfill one or more of these prerequisites, you must install the documentation in your local system
landscape using the download packages or media provided.

® Note

For more information about installing the documentation in your local system landscape, see the
Installation of SAP Library guide.

Procedure

1. Open transaction SR13.
2. Select the tab PlainHtmIHttp.

3. Choose New Entries.

A Caution

You have to create entries for both documentation and XML documentation areas for each platform
you are using and each language in which you want to provide documentation.

You must use the exact combination of uppercase and lowercase characters specified in the product
and version.

To find the correct entry for the Path field, see the list of products and versions attached to SAP Note
2652009 ¥ .

4. To create entries for the documentation area, enter the following values:
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Name Value to be entered

Variant Enter a name for the variant.

Platform Select the platform relevant for your implementation from
the list of available platforms, for example, WN32.

Area Select Documentation from the list; this will display as
IWBHELP in the table.

Server Names https://help.sap.com/http.svc/ahp2

Path <product/version>

To find the correct entry for the Path field, see the list of
products and versions attached to SAP Note 2652009 # .

Language Select the language you need from the list.

5. To create entries for the XML documentation area, enter the following values:

Name Value to be entered

Variant Enter a name for the variant (any name).

Platform Select the platform relevant for your implementation from
the list of available platforms, for example, WN32.

Area Select XML Documentation from the list; this will display
as XML_DOCU in the table.

Server Names https://help.sap.com/http.svc/ahp2

Path <product/version>

To find the correct entry for the Path field, see the list of
products and versions attached to SAP Note 2652009 #r .

Language Select the language you need from the list.

6. Repeat steps 4 and 5 for each relevant platform and language.
7. Select one entry as the default language for each platform and area.

8. Save your entries.

Results

You have configured the settings to point to documentation that is provided on the SAP Help Portal.

Related Information

Installation of SAP Library
SAP Note 2149786#%
SAP Note 2652009
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6.9 Performing the Consistency Check

We recommend that you check the consistency of the newly installed SAP ABAP system.

® Note

SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 145].

Prerequisites

¢ If the installation finished successfully, your SAP system should be up and running. Otherwise, start it as
described in Starting and Stopping SAP System Instances [page 192].

* You have logged on to the SAP system [page 144].

Context

When logging on to the system for the first time, you need to trigger a consistency check manually. The
function is then called automatically whenever you start the system or an application server.

The following checks are performed:

* Completeness of installation

* Version compatibility between the SAP release and the operating system
The initial consistency check determines whether:

* Therelease number in the SAP kernel matches the release number defined in the database system

® The character set specified in the SAP kernel matches the character set specified in the database
system

¢ Critical structure definitions that are defined in both the data dictionary and the SAP kernel are
identical. The structures checked by this function include SYST, T100, TSTC, TDCT and TFDIR.

* Accessibility of the message server
* Availability of all work process types

* Information about the standalone enqueue server and the update service

Procedure

1. Perform a system check:
Call transaction SICK.
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You should see the entry SAP System Check | no errors reported

2. Perform a database check:

In the DBA Cockpit (transaction DBACOCKPIT), check for missing tables or indexes by choosing
| Diagnostics # Missing Tables and Indexes 3.

6.10 Configuring the Change and Transport System

You have to perform some steps in the Transport Management System to be able to use the Change and
Transport System (TMS).

® Note

SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 145].

® Note

SAP_BASIS_SETUP_INITIAL_CONFIG only covers the configuration of TMS as single system.

® Note

If you are using a Stack XML file (see Installation Using a Stack XML File [page 37]) and chose Run TMS
Configuration (for Single System) during the installation, you have already completed this step and and skip
this section.

Context

Procedure

1. Call transaction STMS in the ABAP system to configure the domain controller in the Transport Management
System (TMS).
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For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package 1

| Application Help # Function-Oriented View # Solution
http://help.sap.com/nw731 /%

Life Cycle Management  Software Logistics ¥ Change

SAP NetWeaver 7.4

http://help.sap.com/nw 74 and Transport System > Change and Transport System —
SAP NetWeaver 7.5 Overview ¥ Basics of the Change and Transport System
http://help.sap.com/nw75# > Transport Management System — Concept ]

SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap P

SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

2. Inaddition, you must configure the system change options.

For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package 1 |

|+ Application Help ¥ Function-Oriented View ¥ Solution
http://help.sap.com/nw731 %

Life Cycle Management > Software Logistics > Change

SAP NetWeaver 7.4

http://help.sap.com/nw 74 and Transport System > Transport Organizer (BC-CTS-
SAP NetWeaver 7.5 ORG) ¥ Requirements for Working with the Transport
http://help.sap.com/nw75# Organizer > Setting the System Change Option |

SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap

SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

3. Calltransaction SE38 to schedule a dispatcher job for transport programs by executing report RDD IMPDP.

You schedule the transport dispatcher in the current client. This is equivalent to the execution of job
RDDNEWPP in transaction SE38

6.11

Connecting the System to SAP Solution Manager

Here you find information about how to connect your newly installed SAP system to the SAP Solution Manager
in your system landscape.

® Note

You can skip this section if your newly installed SAP system is itself a SAP Solution Manager system.
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Prerequisites

An SAP Solution Manager system must be available in your system landscape. For more information, see
http://help.sap.com/solutionmanager .

Context

SAP Solution Manager gives you central access to tools, methods, and preconfigured content that you can use
to evaluate and implement your solutions.

When your implementation is running, you can use SAP Solution Manager to manage, monitor, and update
systems and business processes in your solution landscape, and also to set up and operate your own solution
support.

Procedure

You connect a technical system to SAP Solution Manager by the following steps:
1. Onthe technical systems of your landscape, data suppliers are implemented, for example, with
transaction RZ70 for Application Server ABAP and with Visual Administrator for Application Server Java.

For more information, see the SAP Solution Manager Application Help:

¢ If your SAP Solution Manager release is 7.2:
http://help.sap.com/solutionmanager# | » Version 7.2 SPS <No> » Application Help (English)
» Technical Infrastructures » Landscape Management Database (LMDB) » Setting Up the Landscape
Management Infrastructure » Importing Landscape Data, CIM Model, and CR Content 3

* |f your SAP Solution Manager release is 7.1:
http://help.sap.com/solutionmanager# ||» » Version 7.1 SPS <No> » Application Help (English)
» SAP Solution Manager Operations » Managing System Landscape Information » Managing Technical
System Information  Register Technical Systems Automatically by Data Suppliers 3

2. The data suppliers send information about the hardware and installed software to a central System
Landscape Directory (SLD). Updates are sent to the SLD as well. Alternatively, systems can send
information directly to the LMDB in SAP Solution Manager, without an SLD, as described in http://

help.sap.com/solutionmanager# | » Version 7.2 SPS <No> j» Application Help (English) ¥ Technical
Infrastructures » Landscape Management Database (LMDB) » Setting Up the Landscape Management
Infrastructure ¥ Importing Landscape Data, CIM Model, and CR Content 7.

For more information, see Handling Technical Systems' Data - System Landscape Directory
at https://support.sap.com/en/tools/software-logistics-tools/landscape-management-process/system-
landscape-directory.htmi| .

3. Fromthe SLD, this information is regularly synchronized with SAP Solution Manager where it is managed
in the Landscape Management Database (LMDB).

For more information, see the SAP Solution Manager Application Help:
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¢ If your SAP Solution Manager release is 7.2:
http://help.sap.com/solutionmanager# | » Version 7.2 SPS <No> » Application Help (English)
» Technical Infrastructures ¥ Landscape Management Database (LMDB) # Setting Up the Landscape
Management Infrastructure » Importing Landscape Data, CIM Model, and CR Content
» Synchronization with an SLD 3

* |f your SAP Solution Manager release is 7.1:
http://help.sap.com/solutionmanager# | » Version 7.1 SPS <No> j» Application Help (English) » SAP
Solution Manager Operations » Managing System Landscape Information } Setting Up the Landscape
Management Infrastructure » Connecting LMDB to System Landscape Directory (SLD) 3

4. Inthe LMDB, you complete the information from the SLD manually.

For more information, see the SAP Solution Manager Application Help:

¢ If your SAP Solution Manager release is 7.2:
http://help.sap.com/solutionmanager# | » Version 7.2 SPS <No> » Application Help (English)
» Technical Infrastructures ¥ Landscape Management Database (LMDB) ¥ Managing Technical System
Information 3

* If your SAP Solution Manager release is 7.1:
Managing Technical System Information and Managing Product System Information at http://

help.sap.com/solutionmanager# | » Version 7.1 SPS <No> » Application Help (English) » SAP

Solution Manager Operations » Managing System Landscape Information 3

Related Information

Setting Up the Landscape Management Infrastructure

Importing Landscape Data, CIM Model, and CR Content
Synchronization with an SLD

Managing Technical System Information

Handling Technical Systems' Data - System Landscape Directory#

6.12 Applying the Latest Kernel and Support Package
Stacks

We strongly recommend that you apply the latest kernel and Support Package stacks before you start
configuring your SAP system.

® Note

If you are using a Stack XML file (see Installation Using a Stack XML File [page 37]), you already
downloaded the stack.xml file and the delta archives. If you then already called the Software Update
Manager (SUM) from the software provisioning manager and applied the Support Package Stacks after the
installation had finished, you can skip this section.
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Context

For more information about release and roadmap information for the SAP Kernel versions, and how this relates
to SAP system support packages - including important notes on downward compatibility and release dates -
see the central SAP Kernel notes:

Central SAP Notes

2083594 #% - SAP Kernel Versions and SAP Kernel Patch Levels

3116151#% - SP Stack Kernel Schedule Forecast

1744209#% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546#% - Release Roadmap for Kernel 74x and 75x

1802333#% - Finding information about regressions in the SAP kernel
19466#% - Downloading SAP kernel patches

2966761#% - Overview of SAP Kernel Correction Archives

2966621#%F - Overview of Kernel-Related Software Components

953653 #r - Rolling Kernel Switch

The white paper Update Strategy for the Kernel of the Application #& Server ABAP in On Premise Landscapes
provides SAP recommendations on how to patch the SAP kernel.

® Note

If you have installed an SAP Solution Manager 7.2 system, you must apply at least Support Package Stack
(SPS) 01. You cannot use SAP Solution Manager 7.2 with SPS 00.

Procedure

¢ Download and apply the latest Kernel and Support Package stacks using the Software Update Manager
(SUM) as described in the Software Update Manager documentation at: https:/support.sap.com/en/
tools/software-logistics-tools/software-update-manager.html|#

* If you want to update the kernel manually, proceed as described below:

a. Logon as user <sapsid>adm to the hosts of the SAP system instances to be updated.

b. Download the latest kernel for your operating system and database platform as described in SAP Note
19466#% .

c. Back up the kernel directory that is specified by the profile parameter DIR_CT_RUN.

d. Extract the SAR files of the kernel Support Packages of the target SP level to a temporary directory
using the SAPCAR tool.

e. Copy or move the extracted programs from the temporary directory to the local kernel directory.

f.  Adjust the ownership and permissions of the kernel binaries by entering the following command
sequence (Execute the saproot.sh script that is located in the kernel directory):

Su - root
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cd <Kernel_Directory>
./saproot.sh <SAPSID>

exit

6.13 Performing Post-Installation Steps for the ABAP
Application Server

This section describes the post-installation steps you have to perform for the ABAP application server.

® Note

SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 74 and Higher: Performing Automated Initial Setup (Optional) [page 145].

Prerequisites

You have logged on to the ABAP application server as described in Logging On to the Application Server [page
144].

Context

You have to perform the following post-installation steps for the ABAP application server:

¢ Upload and set system profiles using transaction RZ10

* Configure the number of work processes

* Create logon and RFC server groups using transactions SMLG and RZ12
¢ Create operation modes using transaction RZ04

® Schedule standard jobs using transaction SM36

* Configuration of SLD data supplier using transaction RZ70

* Perform load generation using transaction SGEN

For more information, see the appropriate sections below.
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Procedure

Upload and Set System Profiles using Transaction RZ10

You upload system profiles, such as default profile and instance profile, from the file system into the
database of the target system using transaction RZ10.

For more information about how to maintain SAP system profiles, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731 "

® SAP NetWeaver 74
http://help.sap.com/nw74#

® SAP NetWeaver 7.5
http://help.sap.com/nw75#r

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View >
Application Server ¥ Application Server ABAP
Administration of Application Server ABAP ]

Configure the number of work processes

SAP systems are installed with a minimum number of work processes. This is only an initial configuration
to get you started after the installation. It is not detailed enough for a production system because the
optimal number of each type of work process depends on the system resources and on the number of
users working in each SAP system application. For more information about how many work processes to
configure and how to set the number, see SAP Note 39412 .

Create Logon and RFC Server Groups using Transactions SMLG and RZ12
You create the following:

* Logon groups using transaction SMLG

* RFC server groups using transaction RZ12
Specify the following:

* Name of the logon or RFC server group
* Instance name (application server)

* Group type attributes are optional

If required, you create the RFC server group parallel_generators.
Create Operation Modes using Transaction RZ04

You check for existing operation modes and - if required - create a new operation mode using transaction
Rz04.

Specify the following:

* Name of the operation mode
* Short description
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* QOptional: monitoring properties variant

Select the corresponding checkbox to assign the operation mode to the following:

* Time table (assignment only from 0-24 h)
* Current application server instance
* Schedule Standard Jobs using Transaction SM36

You schedule SAP standard jobs using transaction SM36.

If a standard job is already scheduled, it is kept. Only missing jobs are scheduled.
* Configure the SLD Data Supplier using Transaction RZ70

a. Make sure that the SLD and the SLD bridge (the receiving thread of the SLD, which runs on a Java EE
engine) are running.

b. Configure the System Landscape Directory (SLD) data supplier with default settings, using transaction
RZ70.

SLD configuration is a prerequisite for the connection of an SAP system to SAP Solution Manager.

For more information, see Connecting the System to SAP Solution Manager [page 154]
¢ Perform Load Generation using Transaction SGEN

You generate the ABAP loads using transaction SGEN. ABAP loads are platform-dependent programs that
are generated during runtime and stored in database tables. Using transaction SGEN you can generate
ABAP loads of a number of programs, function groups, classes, and so on.

Choose one of the following generation modes:

* Generate All Objects
All existing objects of all software components are generated synchronously. Job RSPARGENERSM
starts the generation directly after all ABAP objects have been prepared for generation and have been
stored in table GENSETC. Be aware that this is a time-consuming process.

® Note

Make sure that you have sufficient space available on your database. The generation of all existing
objects requires around 2 - 9 GB of free space.

* Prepare All Objects for Generation
All objects to be generated are prepared for generation and stored in table GENSETM. You can start the
generation of these objects later with transaction SGEN. Choose this strategy if object generation is to
be done outside the configuration task due to performance issues.

6.14 Systems Based on SAP NetWeaver AS for ABAP 7.52
only: Switching to Standalone Enqueue Server 2 and
Enqueue Replicator 2

If you installed a high-availability SAP system based on SAP NetWeaver AS for ABAP 7.52 , you can switch to
“Standalone Enqueue Server 2" and “Enqueue Replicator 2".

When installing an SAP system based on SAP NetWeaver AS for ABAP 7.52 or lower, Software Provisioning
Manager 1.0 installs the ASCS instance with the classic “Standalone Enqueue Server” and the ERS instance
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with the classic “Enqueue Replication Server” by default. However, if you installed an SAP system based on
SAP NetWeaver AS for ABAP 7.52 , you can switch to" Standalone Enqueue Server 2" and “Enqueue Replicator
2"

For more information, see https://help.sap.com/nw752abap# |p Application Help » SAP NetWeaver Library:
Function-Oriented View » SAP NetWeaver Application Server for ABAP Infrastructure » Components of SAP
NetWeaver Application Server for ABAP ¥ Standalone Enqueue Server 2 » Switching to the Standalone Enqueue
Server2 1.

Related Information

High-Availability System [page 26]

6.15 SAP Solution Manager 7.2, SAP Process Integration 7.5
only: Enabling HTTPS Communication for ABAP

For secure communication between the SAP systems connected to the ABAP stack, further post-installation
steps are required to fully enable HTTPS communication.

Prerequisites

* You have installed the application server ABAP for an SAP Solution Manager 7.2 or SAP Process Integration
7.5.

* You entered the HTTPS port that is to be configured in the application server instance profile when
processing the Communication Port for ABAP screen. For more information, see Additional Parameters
when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2.

Procedure

Proceed as described in the SAP Note 510007 #r.

Related Information

Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2 [page 66]
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6.16 Installing Additional Languages and Performing
Language Transport

This section describes how to install and transport additional languages.

® Note

You do not have to perform these steps or at least some of these steps if you are using a Stack XML file (see
Installation Using a Stack XML File [page 37]) and processed the Install Additional Languages screen during
the installation.

Context

If you have problems during the language installation, see SAP Note 2456868 ¥ .

Procedure

1. Configure the language settings by using transaction 118N and choosing |# [I8N Customizing ¥ 118N
System Configuration J or by executing report RSCPINST directly.

For more information, see SAP Note 42305#

AIX: If you wish to use the Turkish locale with SAP on AlX, you must install the Turkish locale supplied by
SAP instead of the one supplied with the operating system. For more information, see SAP Note 39718 .

2. Perform the language transport using transaction SMLT:
® Note

German is already available in the system. Do not transport it via SMLT.

a. Classify the language.
b. Schedule the language transport.
c. Schedule the language supplementation.

Next Steps

® Note

You can also install additional languages later, but if you install any Support Packages in the meantime, you
have to do one of the following:

* Install the Support Packages again.
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* Use the report RSTLAN_IMPORT_OCS to extract the language-relevant information from each Support
Package.

For information about the language transport, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731 %

® SAP NetWeaver 74
http://help.sap.com/nw74#

® SAP NetWeaver 7.5
http://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Solution
Life Cycle Management » Software Logistics > Change and
Transport System > Language Transport (BC-CTS-LAN) }

6.17 Configuring the User Management

After the installation has completed, configure the user management of your SAP system.

® Note

For SAP Process Integration 7.5 and SAP Solution Manager configuring the user management with an
external ABAP system is mandatory. For more information, see Preparing an External ABAP System as
Source for User Data in the Java installation guide for your operating system and database .

For SAP Process Integration 7.5 and SAP Solution Manager go to Pl 7.5: Configuring the Process Integration
System After the Installation respectively Configuring an SAP Solution Manager System in the Java
installation guide for your operating system and database.

Context

For Solution Manager and Process Integration 7.5, your UME has been configured with the ABAP part of the
system during the target system installation. For other SAP system products this configuration is optional. For
more information, see Preparing an External ABAP System as Source for User Data in the Java installation guide
for your operating system and database .
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Procedure

After the installation of your SAP system has finished, you must decide whether you want to do the following:

* Add the system to Central User Administration (CUA)
* Use Lightweight Directory Access Protocol (LDAP) synchronization

For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetW 7.3 including Enh t
erieaver /.= neluding Enhancemen |} Application Help >Function—Oriented View: English >Security

Package 1

https://help.sap.com/nw731¢ > Identity Management > Identity Management for System Landscapes
e SAP NetWeaver 74 > Integration of User Management in Your System Landscape

https://help.sap.com/nw74 P » Adding an ABAP System to Your System Landscape 4

® SAP NetWeaver 7.5
https://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP
7.51 innovation package
https://help.sap.com/nw751abap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

6.18 Ensuring User Security

You need to ensure the security of the users that the software provisioning manager created during the
installation.

The tables below at the end of this section list the following users:

* Operating system users
* SAP system users

During the installation, the software provisioning manager by default assigned the master password [page 55]
to all users created during the installation unless you specified other passwords.

-> Recommendation

The Master Password feature can be used as a simple method to obtain customer-specific passwords for
all newly created users. A basic security rule is not to have identical passwords for different users. Following
this rule, we strongly recommend individualizing the values of these passwords after the installation is
complete.

- Recommendation

In all cases, the user ID and password are encoded only when transported across the network. Therefore,
we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL)
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protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog
and RFC.

A Caution

Make sure that you perform this procedure before the newly installed SAP system goes into production.

For the users listed below, take the precautions described in the relevant SAP security guide.

You can find the security guide in the Security section of the product page for your SAP product at https://
help.sap.com/

Operating System and Database Users

After the installation, operating system users for SAP system, database, and SAP Host Agent are available as
listed in the following table:

-> Recommendation

For security reasons, we recommend that you remove the operating system users from the group sapinst
after you have completed the installation of your SAP system.

You do not have to do this if you specified this “cleanup” already during the Define Parameters phase on
the Cleanup Operating System Users screen. Then the removal had already been done automatically when
the processing of the software provisioning manager had completed. For more information, see Operating
System Users in SAP System Parameters [page 55].

Operating System Users

User Primary Group

UNIX superuser root No primary group assigned by the software provisioning
manager (group sapinst is assigned as secondary group)

SAP system administrator <sapsid>adm sapsys (sapinst secondary group)

syb<dbsid> as secondary group) sapsys
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SAP Host Agent User

User Type User Comment

Operating system user sapadm SAP Host Agent administrator is the user for central
monitoring services.

You do not need to change the password of this user
after the installation.

This user is for administration purposes only.

You are not able to log on as sapadm as this user is
locked.

SAP System Users

After the installation, ABAP system users are available. The following table shows these users with the SAP
system clients in which they are available, together with recommendations on how you can ensure the security
of these users.

® Note

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 ¥ .

SAP System Users

User User Name Comment
SAP system user SAP* User exists in at least SAP system clients 000, 001,
and 066.
DDIC User exists in at least SAP system clients 000 and
00L1.
EARLYWATCH User exists in at least SAP system client 066.
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User

User Name

Comment

Application Server Java Admin-
istrator

® Note

This user has only been cre-
ated if you have installed the
application server ABAP for
an SAP Process Integration
(P1) 7.5 system or for an
SAP Solution Manager 7.2
system.

The name that you gave this

user during the installation or the
default name J2EE_ADMIN (see
SAP System Parameters [page

55])

This user exists in at least clients 000 and 001 of the
ABAP system and in the User Management Engine
(UME) of the Java system. It has administrative per-
missions for user management.

The password of this user is stored in secure storage.
Therefore, whenever you change the password of the
administrator password, you must also change the
password in secure storage.

- Recommendation

We recommend that you use strong password
and auditing policies for this user.

Application Server Java Guest

® Note

This user has only been cre-
ated if you have installed the
application server ABAP for
an SAP Process Integration
(PI) 7.5 system or for an
SAP Solution Manager 7.2
system.

The name that you gave this

user during the installation or the
default name J2EE_GUEST (see
SAP System Parameters [page

55])

This user exists in at least clients 000 and 001 of the
ABAP system and in the User Management Engine
(UME) of the Java system. It is used for anonymous

access.

Communication user for Appli-
cation Server Java

® Note

This user has only been cre-
ated if you have installed the
application server ABAP for
an SAP Process Integration
(PI) 7.5 system or for an
SAP Solution Manager 7.2
system.

The name that you gave this user
during the installation or the de-
fault name SAPJSF (see SAP Sys-

tem Parameters [page 55])

This user exists in at least clients 000 and 001 of the
ABAP system and in the User Management Engine
(UME) of the Java system. It is used for a remote
function call (RFC) between the ABAP system and
the Java system.
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6.19 Performing the Client Copy

To get a production client, you have to perform a copy of the SAP reference client.

Context

The software provisioning manager creates three ABAP clients during the installation, client 000, client 001,
and client 066.

® Note

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 .

Use client 000 as source client for the client copy.

® Note

SAP SCM: If you want to mark the client 001 as not relevant for liveCache, run report /SAPAPO/
OM_NON_LC_RELEVANT_CLT or /SLCA_NON_LC_RELEVANT_CLIENT using transaction SE38.

Procedure

1. Maintain the new client with transaction SCC4.
2. Activate kernel user SAP*:
a. Set the profile parameter login/no_automatic_user_sapstar to 0.
b. Restart the application server.
Log on to the new client with kernel user SAP* and password PASS.
Copy the client with transaction SCCL and profile SAP_CUST.
Check the log files with transaction SCC3.

o o~ W

Create the required users. These users must have at least the authorizations required for user
administration and system administration. Create a user SAP* with all required authorizations for this
user. If you want to have other users for system administration, you can also create user SAP* without
authorizations.

7. Deactivate kernel user SAP*:

a. Reset login/no_automatic_user_sapstar to 1.

b. Restart the application server.
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Next Steps

For more information about the client copy and about how to perform it, see the SAP Library at :

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731F%

® SAP NetWeaver 74
http://help.sap.com/nw74 ¥

® SAP NetWeaver 7.5
http://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Application
Server > Application Server ABAP > Administration of
Application Server ABAP ¥ Change and Transport System
» BC - Client Copy and Transport 4

6.20 SAP Systems Based on SAP NetWeaver 7.4 and Higher:
Changing Keys for the Secure Storage

The secure storage in the file system and the secure storage in the database have been encrypted with a
randomly generated individual encryption key or with a default key.

In the first case, you have made a backup of the individual key because you need this value in case of failure to
recover the data.

No matter what you chose during installation, you can change the encryption key at any time using the
respective maintenance tool.

-> Recommendation

SAP recommends using an individual encryption key.
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* For the secure storage in the file system, the key change is described in the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 74
http://help.sap.com/nw74 P

® SAP NetWeaver 7.5
http://help.sap.com/nw75 "

|} Application Help > Function-Oriented View > Security > System
Security ¥ System Security for SAP NetWeaver AS ABAP Only
» Secure Storage in the File System (AS ABAP) 4

® SAP NetWeaver Application Server for
ABAP 7.51 innovation package
https://help.sap.com/nw75labap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

* For the secure storage in the database, the key change is described in the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 74
http://help.sap.com/nw74 Fi
® SAP NetWeaver 7.5
http://help.sap.com/nw75Fr
*  SAP NetWeaver Application Server for Encryption Keys > Generating Encryption Keys }
ABAP 7.51 innovation package
https://help.sap.com/nw75labap
® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|+ Application Help ¥ Function-Oriented View @ Security # System
Security > System Security for SAP NetWeaver AS ABAP Only
> Secure Storage (ABAP) > Key Management > Using Individual

More Information

See also the entry Individual Encryption Key for the Secure Storage in table SAP System Parameters in SAP
System Parameters [page 55].

6.21 Enabling the Database

Use

After the SAP system installation, you must enable the database.
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Procedure

1. Make sure that the version of your database is still supported, and check if there are newer versions
available. For more information, see SAP Notes 1554717 #% and 1590719 % .

2. You must enable the database for monitoring by setting up a DBA Cockpit Framework (DCF) after
the SAP system installation. The DCF provides a time-based collection and evaluation of performance,

configuration, and space-related data. In your SAP system, call transaction DBACOCKPIT to start the DBA

Cockpit. Calling the DBA Cockpit automatically checks the existence of the DCF.

- Recommendation

To make sure that the DCF was set up correctly, we recommend that you go to |+ Configuration  Data

Collectors and Admin Procedures Jin the DBA Cockpit.

For further details, refer to the SAP ASE database administration guide https://help.sap.com/viewer/
ase_admin.

3. Manually activate the Internet Communication Framework (ICF) service to ensure that the DBA Cockpit
functions correctly. It is not activated by default. For more information, see SAP Note 1245200 .

4. Apply the latest patches for the DBA Cockpit. For more information, see SAP Note 1558958 .

5. Set up Automatic Table Maintenance in the DBA Cockpit. Read the article DBA Cockpit: Automatic Table
Maintenance for SAP ASE (http://scn.sap.com/docs/DOC-15162#%).

6. Check SAP Note 1539124#% to make sure that the database configuration for your SAP installation
complies with SAP's requirements and recommendations.

7. For systems with high load, refer to SAP Note 1722359 #r .

6.22 Performing a Full Installation Backup

You must perform a full offline backup after the configuration of your SAP system. If required, you can also

perform a full offline backup after the installation (recommended). In addition, we recommend you to regularly

back up your database.

The UNIX commands used in this procedure work on all hardware platforms. For more information about
operating system-specific backup tools, see your operating system documentation.

You need to back up the following directories and files:

¢ All SAP-specific directories:
* /Jusr/sap/<SAPSID>

* You have logged on as user as
/usr/sap/trans

* <sapmnt>/<SAPSID>
* Home directory of the user <sapsid>adm
¢ All database-specific directories

* Theroot file system
This saves the structure of the system and all configuration files, such as file system size, logical volume
manager configuration, and database configuration data.
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® Note

This list is only valid for a standard installation.

Prerequisites

You have logged on as user <sapsid>adm and stopped the SAP system and database [page 192].

Use the backup tool of your choice and refer to the backup software documentation. You can also use the
standard UNIX commands as described below.

Backing Up the Installation

1. Logonasuser root.
2. Manually create a compressed tar archive that contains all installed files:

* Saving to tape:
tar -cf - <fFile_system> | compress -c > <tape_device>

* Saving to the file system:
tar -cf - <file_system> | compress -c > ARCHIVENAME.tar.Z

® Note

Linux only: You can also execute the following command to manually create a compressed GNU tar
archive that contains all installed files and save it to the file system:

tar -czf <ARCHIVENAME>.tgz <fTile_system>

Restoring Your Backup

If required, you can restore the data that you previously backed up.

A Caution

Check for modifications in the existing parameter files before you overwrite them when restoring the
backup.

1. Logonasuser root.
2. Gotothe location in your file system where you want to restore the backup image.
3. Restore the data with the following commands:
* From tape:
cat <tape_device> | compress -cd | tar -xf -

* From the file system:
cat ARCHIVENAME.tar.Z | compress -cd | tar -xf -
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[ Only valid for 'Platform': Linux

® Note

Linux only: If you want to restore the data from a GNU tar archive, you have to execute the following

command:

tar -xzf <ARCHIVENAME>.tgz

l End of 'Platform': Linux

6.23 Logging on to the SAP Web Dispatcher Management
Console

This section describes how to log on to the SAP Web Dispatcher.

Context

® Note

This step is only required if you chose to install an embedded SAP Web Dispatcher instance within the
ASCS instance.

You must log on to the SAP Web Dispatcher Management Console to do the following:

¢ Check whether the SAP Web Dispatcher was installed successfully,
¢ Change the password of the webadm user,

® Access monitoring and administration tools.

Procedure

1. Open aweb browser.
2. Enter the following URL, depending on whether you use HTTP or HTTPS:

http(s) ://<Webdispatcher_Host>:<HTTP(S)_PORT>/sap/wdisp/admin/public/
default._html

% Example
https://plx282:44300/sap/wdisp/admin/public/default_html

3. Log on as user webadm with the password that you entered during the input phase of the installation.
The SAP Web Dispatcher Monitor screen appears.
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4. We recommend that you change the password of webadm immediately after the installation for security

reasons.

For more information on how to change passwords of existing users using the Admin Handler, see the

SAP Library at:

SAP Release and SAP Library Quicklink

SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Pack-

agel
http://help.sap.com/nw731 "

|} Application Help > Function-Oriented View > Application
Server > Application Server Infrastructure > Components of
SAP NetWeaver Application Server > SAP Web Dispatcher

> Administration of the SAP Web Dispatcher > Area menu

> Section "HTTP Handler” }

® SAP NetWeaver 74
http://help.sap.com/nw74 F

® SAP NetWeaver 7.5
http://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP 7.51
innovation package

|+ Application Help ¥ Function-Oriented View ¥ Application
Server > Application Server Infrastructure > Components of
SAP NetWeaver Application Server  SAP Web Dispatcher

> Administration of the SAP Web Dispatcher > Using the
Web Administration Interface > Area menu > Section "HTTP

https://help.sap.com/nw75labap
® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

Handler” ]

Related Information

ASCS Instance with Embedded SAP Web Dispatcher [page 32]

6.24 SAP Web Dispatcher Configuration (Optional)

After installing SAP Web Dispatcher, you must configure it to be able to use it.

® Note

This step is only required if you chose to install an embedded SAP Web Dispatcher instance within the
ASCS instance.

You can find the configuration information in the SAP Library at:
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SAP Release and SAP Library Quicklink SAP Library Path (Continued)

* SAP NetWeaver 7.3 including Enhancement Package |} Application Help > Function-Oriented View > Application
1

http://help.sap.com/nw731F

® SAP NetWeaver 74
http://help.sap.com/nw74

® SAP NetWeaver 7.5
http://help.sap.com/nw75#r

® SAP NetWeaver Application Server for ABAP 7.51
innovation package

https://help.sap.com/nw75labap
SAP NetWeaver AS for ABAP 7.52

https://help.sap.com/nw752abap

Server > Application Server Infrastructure > Components of

SAP NetWeaver Application Server » SAP Web Dispatcher |

Related Information

ASCS Instance with Embedded SAP Web Dispatcher [page 32]

6.25 Gateway Configuration

You have to configure the gateway to be able to use it.

® Note

This step is only relevant if you installed a gateway embedded in the ASCS instance. For more information,

see ASCS Instance with Embedded Gateway [page 34].

You can find all relevant configuration information in the gateway documentation in the SAP Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

* SAP NetWeaver 7.3 including Enhancement Package | Application Help ¥ SAP NetWeaver Library: Function-
1 Oriented View > Application Server > Application Server
http://help.sap.com/nw731# Infrastructure ¥ Connectivity # Gateway 4
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SAP Release and SAP Library Quicklink SAP Library Path (Continued)

® SAP NetWeaver 74 |} Application Help > SAP NetWeaver Library: Function-
http://help.sap.com/nw74 ¢ Oriented View » Application Server @ Application Server

® SAP NetWeaver 7.5 Infrastructure  Components of SAP NetWeaver Application
http://help.sap.com/nw75i‘hr Server > Gateway }

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap i

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

Related Information

ASCS Instance with Embedded Gateway [page 34]
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7 SAP ASE 16.0: Auditing with SAP
Adaptive Server Enterprise

As of SAP ASE 16.0 the software provisioning manager creates the database sybsecurity with one data
device for the purpose to collect SAP ASE configuration changes per default.

Itis also possible to enable further auditing options to detect penetration of the system and misuse of
resources. For an overview about the available configurations, see SAP Note 2717834 #% - SYB: Discretionary
Access Control configuration options offered by SWPM. The SAP ASE auditing system is described in detail in
the SAP ASE Security Administration Guide.

If you specify two or more data devices for the sybsecurity database, the software provisioning manager
creates an audit table on each data device. You may want the software provisioning manager to establish a
threshold procedure to automatically switch auditing tables when the current audit table becomes full. The
Audit Trail Management is described in the SAP ASE Security Administration Guide. Depending on the selected
auditing options and system workload, a lot of events can be recorded and the size of the sybsecurity
database must be adapted according to your specific needs.

We recommend two or more audit tables. In this way, you can set up a smoothly running auditing process in
which audit tables are archived and processed without losing audit records and without manual intervention.
The software provisioning manager also offers to create the optional database sybsecurityarchive for
archiving audit records. You may want the software provisioning manager to establish a threshold procedure to
automatically move audit events to the sybsecurityarchive database.

The size of sybsecurityarchive database depends on the selected auditing options, system workload and
the time period of keeping the audit records in your SAP ASE system before making a database dump and
removing them from the active sybsecurityarchive database.

® Note

You need to implement a backup strategy and a sybsecurityarchive database cleanup process
according to your specific needs. Otherwise the sybsecurityarchive database will run full and you
will lose auditing records.
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8 SAP ASE 16.0: Disaster Recovery Setup
with SAP Replication Server

8.1 Disaster Recovery Setup with SAP Business Suite on
SAP ASE 16.0

The Disaster Recovery setup for SAP ASE 16.0 offers the following replication modes:

* Synchronous Replication (Hot Standby)
* Near-Synchronous Replication (Hot Standby)
* Asynchronous Replication (Warm Standby)
SAP recommends to always install the latest versions of SAP ASE and of the SAP Replication Server. For more

information on the latest versions and the certified combinations of SAP ASE and SAP Replication Server, see
SAP Note 1891560 # .

The DR setup with SAP ASE 16.0 provides additional features for monitoring the SAP Replication Server using
the Replication Management Agent (RMA).

You can install the SAP Replication Server on the same host as SAP ASE 16.0 (co-located scenario).

For more information, see the HADR Users Guide for SAP ASE 16.0%%, Chapter 4, Installing HADR for SAP
Business Suite and SAP Note 1891560#%, section Additional Information.
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9 Additional Information

9.1 Additional Information

The following sections provide additional information about optional preparation, installation, and post-
installation tasks.

There is also a section describing how to delete an SAP system.

Preparation

* Integration of LDAP Directory Services [page 183]

Installation

* Installing the Host Agent Separately [page 188]

Post-Installation

¢ Starting and stopping SAP System Instances [page 192]

* |f you decided to use a generic LDAP directory, you have to create a user for LDAP directory access [page
199]

¢ Heterogeneous SAP System Installation [page 200]
Deleting an SAP System or SAP Instance

* Deleting an SAP System [page 200]
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9.2 Splitting Off an ABAP Central Services Instance from
an Existing Primary Application Server Instance

With the installation option Split Off ASCS Instance from existing Primary Application Server Instance, you can
move the message server and the enqueue work process from an existing primary application server instance
to a newly installed ABAP central services instance (ASCS instance). The new ASCS instance is installed while
the split is done.

Prerequisites

The existing SAP system of the primary application server instance must meet the following requirements:

* It was upgraded from an SAP system release based on SAP NetWeaver lower than 7.1.
* |t does not yet have an ASCS instance

Context

Before the Split

The primary application server instance includes:

* ABAP dispatcher and work processes (dialog, batch, spool, enqueue, or update)
* Gateway

* Internet communication manager (ICM)

* Internet graphics service (IGS)

* ABAP message server

After the Split
An ABAP central services instance (ASCS instance) has been split off from the existing primary application
server instance.

The primary application server instance now includes:

* ABAP dispatcher and work processes (dialog, batch, spool, or update)
* Gateway
* Internet communication manager (ICM)

* Internet graphics service (IGS)
The newly created ABAP central services instance (ASCS instance) includes:

* ABAP message server

* ABAP standalone enqueue server
The ABAP enqueue work process is now replaced with the ABAP standalone enqueue server.

® Note

ASCS instance with “Standalone Enqueue Server” versus ASCS instance with new “Standalone
Enqueue Server 2": Software Provisioning Manager 1.0 installs the “Standalone Enqueue Server"” by
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default for all SAP system releases in the ASCS instance. However, if you have installed the ASCS
instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to the new
“Standalone Enqueue Server 2" after the installation has completed. For more information, see https:/

help.sap.com/nw752abap# | Application Help » SAP NetWeaver Library: Function-Oriented View
» SAP NetWeaver Application Server for ABAP » Components of SAP NetWeaver Application Server for

ABAP » Standalone Enqueue Server 2 » High Availability with Standalone Enqueue Server 2 3, and
Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2
and Enqueue Replicator 2 [page 160] .

The Effect of the Split

The following graphic provides an overview of the components contained in the primary application server
instance before and after the split, along with the newly created ASCS instance:

SAP Global Host

ASCS Instance

Primary Application Server Instance Host Message Server

Primary Application Server
Instance

Enqueue Server

ABAP Dispatcher +
Work Processes

Split Primary Application Server Instance Host
Enqueue Work
Process

Primary Application Server
Instance

ABAP Dispatcher +

Gateway
Work Processes

ICM

IGS

Gateway

Message Server

ICM

IGS

Procedure

1. Plan the basic parameters, as described in SAP System Parameters [page 55]:

* Choose an instance number for the ASCS instance to be created.
* Note that the message server port is not changed during the split.
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2. Check the hardware and software requirements for the ASCS instance to be created as described in
Hardware and Software Requirements [page 39].

3. Specify basic SAP System Parameters [page 55] for the ASCS instance to be created.

4. Set up the required file systems [page 82] for the ASCS instance to be created.

5. Check the prerequisites [page 117] and start the software provisioning manager [page 121] on the host
where the ASCS instance is to be created.

6. Onthe Welcome screen, choose |[» Generic Options # <Database> » Split Off ASCS Instance from Existing
Primary Application Server Instance .

7. Follow the instructions on the software provisioning manager screens and enter the required parameters.

® Note

To find more information on each parameter during the Define Parameters phase, position the cursor
on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.

After you have entered all requested input parameters, the software provisioning manager displays the
Parameter Summary screen. This screen shows both the parameters that you entered and those that the
software provisioning manager set by default. If required, you can revise the parameters before starting the
installation.

8. To start the installation, choose Start.

A Caution

All SAP system instances are stopped during the split procedure.

The software provisioning manager starts the installation and displays the progress of the installation.
When the installation has successfully completed, the software provisioning manager shows the dialog
Execution of Split Off ASCS Instance from existing Primary Application Server Instance has completed.

9. You check and if necessary modify the settings for the operating system users for your SAP system if they
were created by the software provisioning manager.

For more information, see Creating Operating System Users and Groups [page 77].

10. Restart the application server instances [page 192] (primary application server instance and additional
application server instances if they exist).

11. Check whether you can log on to the application servers [page 144].
12. Ensure user security [page 164] for the operating system users of the newly created ASCS instance.

13. If you installed a high-availability system based on SAP NetWeaver AS for ABAP 7.52, you can decide
whether you want to switch to standalone enqueue server 2 and enqueue replication server .

14. If required, perform an installation backup [page 171].
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9.3 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol
(LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the
directory.

A Caution

SAP recommends that you no longer use the LDAP configuration options provided by the software
provisioning manager, because current security guidelines make it unsafe to run SAP applications on a
domain controller. Instead, SAP recommends that you follow the instructions in SAP Note 3251648 to
enable LDAP directory service integration of your SAP system with Active Directory.

LDAP defines a standard protocol for accessing directory services, which is supported by various directory
products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables
important information in a corporate network to be stored centrally on a server. The advantage of storing
information centrally for the entire network is that you only have to maintain data once, which avoids
redundancy and inconsistency.

If an LDAP directory is available in your corporate network, you can configure the SAP system to use this
feature. For example, a correctly configured SAP system can read information from the directory and also store
information there.

® Note

The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

* The communication protocol between the SAP system and the directory

* How datain the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take
advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows
server, you can configure the SAP system to use the information available there. In the following text,
directories other than the Active Directory that implement the LDAP protocol are called generic LDAP
directories.
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This section does not provide information about the use of LDAP directories with the LDAP Connector. For
more information about using and configuring the LDAP Connector for an ABAP system, see the SAP Library

at:

SAP Release and SAP Library Quick Link

SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package |" Application Help > Function-Oriented View > Security

1

http://help.sap.com/nw731#

SAP NetWeaver 7.4
http://help.sap.com/nw74

SAP NetWeaver 7.5
http://help.sap.com/nw75#

SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap
SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

> Identity Management > User and Role Administration of
Application Server ABAP > Configuration of User and Role
Administration > Directory Services > LDAP Connector 1

Prerequisites

You can only configure the SAP system for Active Directory services or other LDAP directories if these are

already available on the network. The Active Directory is automatically available on all domain controllers. A
generic LDAP directory is an additional component that you have to install separately on a UNIX or Windows
server.

184

You can only configure the SAP system for Active Directory services or other LDAP directories if these are
already available on the network. The Active Directory is automatically available on all domain controllers.
A generic LDAP directory is an additional component that you have to install separately on a UNIX or

Windows server.

Make sure that the required software is installed:

Operating System Required Software
AIX IBM Tivoli Directory Server client packages
HP-UX The LDAP libraries listed in SAP Note 541344 ¥
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Operating System Required Software

Linux You must have at least the following RPM packages installed:

® Oracle Linux:
openldap2

® RedHat Linux:
openldap2

® SUSE LINUX
openldap2
openldap2-client

Solaris You must have at least the libldap.so library installed.

Features

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory
by using:

¢ SAP Logon

* The SAP Microsoft Management Console (SAP MMC)
For more information about the automatic registration of SAP components in LDAP directories and the
benefits of using it in SAP Logon and SAP MMC, see the documentation SAP System Information in
Directory Services at:
https://archive.sap.com/documents/docs/DOC-14384 ¥

¢ The SAP Management Console (SAP MC)

SAP Logon

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the sapmsg. ini
configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon
to use the LDAP directory, it queries the directory each time Server or Group selection is chosen to fetch
up-to-date information on available SAP systems.

To use LDAP operation mode, check that the sapmsg- ini file contains the following:
[Address]

Mode=LDAPdirectory

LDAPserver=

LDAPnode=

LDAPoptions=

Distinguish the following cases:

* If you use an Active Directory, you must set LDAPoptions=“DirType=NT5ADS”. For more information,
see the SAP system profile parameter Idap/options.
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* You must specify the directory servers (for example, LDAPserver=pcintel6 p24709) if one of the
following is true:

* Theclientis not located in the same domain forest as the Active Directory

* The operating system does not have a directory service client (Windows NT and Windows 9X without
installed dsclient).
For more information, see the SAP system profile parameter Idap/servers.

* For other directory services, you can use LDAPnode to specify the distinguished name of the SAP root
node. For more information, see the SAP system profile parameter Idap/saproot.

SAP MMC

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central
location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been
prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various
sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read
system information straight from the directory that automatically registers changes to the system landscape.
As a result, up-to-date information about all SAP application servers, their status, and parameter settings is
always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together
with Active Directory services. You can keep track of significant events in all of the systems from a single

SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such
changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances
both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the
instances running on Unix.

SAP MC

The SAP MC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central
location. The SAP MC is automatically set up when you install an SAP system on any platform. If the SAP
system has been prepared correctly, the SAP MC presents and analyzes system information that it gathers
from various sources, including a generic LDAP Directory.

Integrating a generic LDAP Directory as a source of information has advantages for the SAP MC. It can read
system information straight from the directory that automatically registers changes to the system landscape.
As a result, up-to-date information about all SAP application servers, their status, and parameter settings is
always available in the SAP MC.
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For more information about the SAP MC and about how to configure it to access LDAP directories, see the
documentation SAP Management Console in the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731F%

® SAP NetWeaver 74
http://help.sap.com/nw74 P

® SAP NetWeaver 7.5
http://help.sap.com/nw75 "

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap i

|+ Application Help # Function-Oriented View # Solution Life
Cycle Management > SAP Management Console }

Configuration Tasks for LDAP Directories
This section describes the configuration tasks for the Active Directory or other (generic) LDAP directories.

¢ Configuration Tasks for Active Directory
To enable an SAP system to use the features offered by the Active Directory, you have to configure the
Active Directory so that it can store SAP system data.
To prepare the directory, you use the software provisioning manager to automatically:

A Caution

SAP recommends that you no longer use the LDAP configuration options provided by the software
provisioning manager, because current security guidelines make it unsafe to run SAP applications on a
domain controller. Instead, SAP recommends that you follow the instructions in SAP Note 3251648
to enable LDAP directory service integration of your SAP system with Active Directory.

* Extend the Active Directory schema to include the SAP-specific data types
* Create the domain accounts required to enable the SAP system to access and modify the Active
Directory. These are the group SAP_LDAP and the user sapldap.
* Create the root container where information related to SAP is stored
¢ Control access to the container for SAP data by giving members of the SAP_LDAP group permission to
read and write to the directory
You do this by running the software provisioning manager on the Windows server on which you want to
use Active Directory Services and choosing |F Generic Installation Options » <Database> ¥ Preparations
» LDAP Registration » Active Directory Configuration . For more information about running the software
provisioning manager on Windows, see the documentation Installation of SAP Systems Based on
the Application Server <Stack> of SAP NetWeaver <Release> on Windows: <Database> at https:/

help.sap.com/docs/SOFTWARE_PROVISIONING_MGR_10/159a36e76fe84e54a703f846b08aelf6/
c8ed609927fa4e45988200b153ac63d1l.html

® Note

You have to configure the directory server only once. Then all SAP systems that need to register in this
directory server can use this setup.
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¢ Configuration Tasks for Generic LDAP Directories
To configure other LDAP directories, refer to the documentation of your directory vendor.

¢ Configuration Tasks for Generic LDAP Directories on Windows
To configure other LDAP directories, refer to the documentation of your directory vendor. The software
provisioning manager software contains schema extensions for directory servers Netscape/iPlanet
(Idregns4.txt, Idregns5.txt) and OpenLDAP slapd (Idregslapd.schema). Both files are located
in the directory \<Unpack_Directory>\COMMON\ADS. After you have applied the schema extension, you
need to create a root container to store the SAP-related information and create a directory user that the
SAP application server can use to write information to the directory.
For more information about how to set up a Netscape/iPlanet directory server, see the documentation SAP
System Information in Directory Services at:
https://archive.sap.com/documents/docs/DOC-14384 ¥

* Enabling the SAP System LDAP Registration
Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP
system by setting some profile parameters in the default profile.
To do this, run the software provisioning manager [page 121] once for your system and choose:

A Caution

SAP recommends that you no longer use the LDAP configuration options provided by the software
provisioning manager, because current security guidelines make it unsafe to run SAP applications on a
domain controller. Instead, SAP recommends that you follow the instructions in SAP Note 3251648#%
to enable LDAP directory service integration of your SAP system with Active Directory.

|» Generic Installation Options » <Database> » Preparations » LDAP Registration » LDAP Support 3

If you use a directory server other than Microsoft Active Directory and/or non-Windows application
servers, you have to store the directory user and password information by using Idappasswd
pf=<any_instance_profile>. The informationis encrypted for storage in DIR_GLOBAL and is therefore
valid for all application servers. After restarting all application servers and start services, the system is
registered in your directory server. The registration protocols of the components are dev_lIdap*. The
registration is updated every time a component starts.

9.4 Installing the SAP Host Agent Separately

This procedure tells you how to install an SAP Host Agent separately.

Context

The SAP Host Agent is installed automatically during the installation of new SAP instances with SAP kernel 7.20
or higher (integrated installation). This procedure is only for hosts with no SAP Host Agent running on them,
due to the following reasons:

® Thereis no SAP system or instance on the host.

* The SAP system or instance running on the host has a kernel release lower than SAP kernel 7.20 and the
host does not yet have an SAP Host Agent.
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* You have upgraded your SAP system to a release with a kernel release lower than SAP kernel 7.20 and the
host of the upgraded system or instance does not yet have an SAP Host Agent.

SAP Host Agent has the following executable programs and services:

* The SAPHostExec service
* The sapstartsrv service SAPHostControl
® The operating system collector saposcol

® Note
The installed programs are automatically started when the host is booted.

The automatic start is ensured by the startup script sapinit, which starts the required executables.

The following procedure describes the steps you have to perform on the host where you install the SAP Host
Agent separately.

Procedure

1. Check the hardware and software requirements on the installation host.

The minimum requirements are as follows:

* Hard Disk Space: 1GB
° RAM:0.5GB
* Swap Space: 2 x RAM

2. Make sure that the sapadm user is created.

During the installation, the software provisioning manager checks all required accounts (users, groups)
and services on the local machine. The software provisioning manager checks whether the required users
and groups already exist. If not, it creates new users and groups as necessary.
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User and Groups of the SAP Host Agent

User Primary Group Additional Group Comment
sapadm sapsys - SAP Host Agent administrator
® Note

If sapadm does not exist, itis
created during the SAP Host
Agent installation using Zbin/
false shell.

Make sure that /bin/false
can be used as a login shell.

| Only valid for ‘Platform': AIX |

AlX: Add /bin/false to
the list of valid login shells
(attribute shells) in Zetc/
security/login.cfg.

| End of 'Platform': AIX |

Groups and Members of the SAP Host Agent User

Groups Members
sapsys sapadm
sapinst sapadm

Set up the required file system for the SAP Host Agent and make sure that the required disk space is
available for the directories to be created during the installation.

For more information, see Required File Systems and Directories [page 82].

Download and unpack the Software Provisioning Manager 1.0 archive on the host where you want to install
the SAP Host Agent as described in Downloading and Extracting the Software Provisioning Manager 1.0
Archive [page 98].

Make the latest patch level of the SAPHOSTAGENT <Version>.SAR available on the host where you want
to install the SAP Host Agent.

Download it from the following path: https:/me.sap.com/softwarecenter# | » SUPPORT PACKAGES &
PATCHES » By Category » #» SAP Technology Components » SAP HOST AGENT » SAP HOST AGENT 7.22
» <Operating System> J

® Note

The digital signature of installation archives is checked automatically by the software provisioning
manager [page 121] during the Define Parameters phase while processing the Software Package
Browser screens. The software provisioning manager only accepts archives whose digital signature
has been checked. After scanning the archives and verifying the digital signature, an info file is written
where you can find detailed information about matching and non-matching archive files. You can
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access this info file by choosing the info file link in the Archive Scanning Result section of the Software
Package Browser screen. The info file contains only the results of the latest archive scan.

- Recommendation

It is highly recommended that you always choose the highest SP version of the SAPHOSTAGENT<SP-
version>_SAR archive.

6. Toinstall the SAP Host Agent, you Running Software Provisioning Manager [page 121] and choose

| Generic Options » <Database> » Preparations » SAP Host Agent J on the Welcome screen of the
software provisioning manager.

Follow the instructions on the software provisioning manager screens and enter the required parameters.

8. When the installation has finished, the software provisioning manager shows the message: Execution of
SAP Host Agent has completed.

Post-Installation

9. Check that the SAP Host Agent is installed and running by entering this command:
/usr/sap/hostctril/exe/saphostexec —status
If the SAP Host Agent is running, you see something like this:
saphostexec running (pid = 21942)

10. If the SAP Host Agent is installed but not running, enter the following:
/usr/sap/hostctrl/exe/saphostexec -restart

11. Check whether the installed services are available:

a. Logonas auser with root authorizations.

® Note

When the host is booted, the startup script sapinit automatically starts the required executables.

b. Check whether the following services are available:
® The control program saphostexec
* The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
Additional Information PUBLIC 191



Next Steps

For more information about the SAP Host Agent, see the following documentation:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3
http://help.sap.com/nw73#r

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731#

® SAP NetWeaver 74
http://help.sap.com/nw74

® SAP NetWeaver 7.5
http://help.sap.com/nw75#

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Solution Life
Cycle Management > SAP Host Agent 1

9.5 Starting and Stopping SAP System Instances

Start or stop SAP system instances in one of the following ways:

* Using the SAP Management Console (SAP MC) [page 192]
* Using commands [page 196].

9.5.1 Starting and Stopping SAP System Instances Using the
SAP Management Console

You can start and stop all instances of your SAP system using the SAP Management Console (SAP MC).

Prerequisites

* Make sure that the host names defined in the DNS server match the names of the SAP system instance
hosts. In particular, keep in mind that host names are case-sensitive. For example, if the names of the SAP
system instance hosts are in upper case, but the same host names are defined in the DNS server in lower
case, starting and stopping the system does not work.
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* If youwant to start or restart remote systems or instances, make sure that you have registered them in the
SAP Management Console (SAP MC). You do not need to register SAP systems or instances installed on
the local host, because the SAP MC displays them automatically.

* The SAP Host Agent is installed on the host where the application server of the SAP system or instance
runs.

* You have installed Java Runtime Environment (JRE) 5.0 or higher.
*  Your Web browser supports Java.
* Your Web browser's Java plug-in is installed and enabled to run scripting of Java applets.

® Note

If your Web browser no longer supports Java applet technology, you can configure the SAP MC to run
locally on your PC. For more information, see section Configuring SAP MC locally in SAP Note 1014480 #r .

Context

-> Recommendation

If you experience any issues when starting or using the SAP MC, refer to SAP Note 1153713 #% .

* For more information about handling the SAP MC, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731

® SAP NetWeaver 74
http://help.sap.com/nw74#

® SAP NetWeaver 7.5
http://help.sap.com/nw75#r

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap Far

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Solution
Life Cycle Management > SAP Management Console ]

¢ If your newly installed SAP system is part of a heterogeneous SAP system landscape comprising systems
or instances on Windows platforms, you can also start and stop it from a Windows system or instance
using the SAP Microsoft Management Console (SAP MMC).
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For more information about handling the SAP MMC, see the SAP Library at:

Release SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731

® SAP NetWeaver 74
http://help.sap.com/nw74#

® SAP NetWeaver 7.5
http://help.sap.com/nw75#r

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap Far

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Solution
Life Cycle Management > SAP Microsoft Management
Console: Windows ]

|On|y valid for 'Platform": Linux

® Note

Linux only: If your server runs on a Linux distribution using systemd version 234 or later, it's technically
possible that you use systemd commands on operating system level to start and stop SAP systems.
However, we recommend that you do not use these systemd commands. For example, using systemd to
restart or stop the systemd unit will not only stop the start service, but the entire related SAP instance
with time limits for the processes to shut down. This might end in unexpected results. To start and stop
SAP instances, we recommend that you use the SAP Management Console, as outlined here, or the
sapcontrol commands (see also Starting and Stopping SAP System Instances Using Commands [page
1967). For more information about systemd, see SAP Note 3139184 ¥

| End of 'Platform': Linux

Procedure

¢ Starting the Web-Based SAP Management Console

1. Start a Web browser and enter the following URL:
http://<Host_Name>:5<Instance_Number>13

% Example
If the instance number is 53 and the host name is saphost06, you enter the following URL:

http://saphost06:55313

This starts the SAP MC Java applet.

® Note

If your browser displays a security warning message, choose the option that indicates that you
trust the applet.
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2. Choose Start.
The SAP Management Console (SAP MC) appears.
By default, the instances installed on the host you have connected to are already added in the SAP MC.

® Note

If the instances have not been added or if you want to change the configuration to display systems
and instances on other hosts, you have to register your system manually. This is described in
Registering Systems and Instances in the SAP Management Console below.

* Starting SAP Systems or Instances

Similarly, you can start or restart all SAP systems and individual instances registered in the SAP MC.

1. Inthe navigation pane, open the tree structure and navigate to the system node that you want to start.
2. Select the system or instance and choose Start from the context menu.

3. Inthe Start SAP System(s) dialog box, choose the required options.
4

. Choose OK.
The SAP MC starts the specified system or system instances.

® Note

The system might prompt you for the SAP system administrator credentials. To complete the
operation, you require administration permissions.

Log in as user <sapsid>adm.

Starting SAP System Instances Successively

>|f you need to start the instances of an SAP system successively — for example when you want to start a
distributed or a high-availability system — proceed as follows:

1. Start the database instance.

2. Start the ABAP central services instance ASCS<Instance_Number>.

3. Start the primary application server instance D[VEBMGS]<Instance_Number>.

® Note

In SAP systems based on SAP NetWeaver 7.5 or higher, the primary application server instance is
named D<Instance_Number>.

In SAP systems based on SAP NetWeaver 7.4 or lower, the primary application server instance is
named DVEBMGS<Instance_Number>.

4. Start additional application server instances D<Instance_Number>, if there are any.

¢ Stopping SAP Systems or Instances

Similarly, you can stop all SAP systems and individual instances registered in the SAP MC.

1. Select the system or instance you want to stop and choose Stop from the context menu.
2. Inthe Stop SAP System(s) dialog box, choose the required options.
3. Choose OK.

The SAP MC stops the specified system or system instances.
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® Note

The system might prompt you for the SAP system administrator credentials. To complete the
operation, you require administration permissions.

Log in as user <sapsid>adm.

Stopping SAP System Instances Successively

If you need to stop the instances of an SAP system successively — for example when you want to start a
distributed or a high-availability system — proceed as follows:

1. Stop additional application server instances D<Instance_Number>, if there are any.
2. Stop the primary application server instance D[VEBMGS]<Instance_Number> .

® Note

In SAP systems based on SAP NetWeaver 7.5 or higher, the primary application server instance is
named D<Instance_Number>.

In SAP systems based on SAP NetWeaver 7.4 or lower, the primary application server instance is
named DVEBMGS<Instance Number>.

3. Stopthe ABAP central services instance ASCS<Instance_Number>.
4. Stop the database instance.

9.5.2 Starting and Stopping SAP System Instances Using
Commands

Prerequisites

You are logged on to the SAP system host as user <sapsid>adm.

Context

® Note

The startsap and stopsap commands are deprecated. SAP recommends that you do not use them any
longer. For more information, see SAP Notes 1763593 and 809477 #r .

|On|y valid for 'Platform': Linux |

Linux only: If your server runs on a Linux distribution using systemd version 234 or later, it's technically
possible that you use systemd commands on operating system level to start and stop SAP systems.
However, we recommend that you do not use these systemd commands. For example, using systemd to
restart or stop the systemd unit will not only stop the start service, but the entire related SAP instance with
time limits for the processes to shut down. This might end in unexpected results. To start and stop SAP
instances, we recommend that you use the sapcontrol commands or the SAP Management Console (see
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also Starting and Stopping SAP System Instances Using the SAP Management Console [page 192]). For
more information about systemd, see SAP Note 3139184 #.

|End of 'Platform': Linux |

This section only lists the basic commands how to start or stop an SAP system. You can find a detailed list of all
SAPControl options and features in the command line help, which you can call as follows:

/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol --help

% Example

/usr/sap/GB1/D00/exe/sapcontrol --help

Procedure

¢ Starting an SAP System or Instance

¢ Starting an SAP System:
You can start an SAP system by executing the following commands from the command line
(<Instance_Number> can be the number of any instance of the SAP system):
/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol -nr <instance_number>
-function StartSystem

% Example

/usr/sap/GB1/D00/exe/sapcontrol -nr 01 -function StartSystem

¢ Starting an SAP System Instance
You can start an SAP system instance by executing the following commands from the command line:
/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol -nr <instance_number>
-function Start

% Example

Starting an instance with <instance_number> 02: /usr/sap/GB1/D00/exe/sapcontrol -nr
02 -function Start

For remote instances, the syntax is slightly different, because you also have to apply the -host and
—-user parameters:

/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol —nr <instance_number>
-host <remote host> —user <sapsid>adm <password> -function Start

% Example

Starting a remote instance with <instance_number> 02: /usr/sap/GB1/D00/exe/
sapcontrol -nr 02 -host myremotehost —user gbladm -function Start

¢ Stopping an SAP System or Instance

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise
Additional Information PUBLIC 197


http://help.sap.com/disclaimer?site=https://me.sap.com/notes/3139184

* Stopping an SAP System
You can stop an SAP system by executing the following commands from the command line
(<Instance_Number> can be the number of any instance of the SAP system):
/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol -nr <instance_number>
-function StopSystem

% Example

/usr/sap/GB1/D00/exe/sapcontrol -nr 01 -function StopSystem

* Stopping an SAP System Instance
You can stop an SAP system instance by executing the following commands from the command line:
/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol -nr <instance_number>
-function Stop

% Example

Stopping an instance with <instance_number> 02: /usr/sap/GB1/D00/exe/sapcontrol
-nr 02 -function Stop

For remote instances, the syntax is slightly different, because you also have to apply the -host and
—-user parameters:

/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol —nr <instance_number>
-host <remote host> —user <sapsid>adm <password> -function Stop

% Example

Stopping a remote instance with <instance_number> 02: /usr/sap/GB1/D00/exe/
sapcontrol -nr 02 -host myremotehost —user gbladm -function Stop

® Note

The database is not stopped by these commands. You have to stop the database using database-
specific tools or commands.

* Checking System Instance and Processes

* With the following command you get a list of system instances, their status, and the ports used by
them (<Instance_Number> can be the number of any instance of the SAP system):
/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol —nr <instance_number>
-host <remote host> —user <sapsid>adm <password> -function
GetSystemlnstancelList

o Example

/usr/sap/GB1/D00/exe/sapcontrol -nr 02 -host myremotehost —user gbladm
-function GetSystemlnstanceList

* With the following command you get a list of instance processes and their status:
/usr/sap/<SAPSID>/<INSTANCE><NUMBER>/exe/sapcontrol —nr <instance_number>
-host <remote host> —user <sapsid>adm <password> -function GetProcessList
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% Example

/usr/sap/GB1/D00/exe/sapcontrol -nr 02 -host myremotehost —user gbladm
-function GetProcessList

* Troubleshooting

If you get an error like ""FAIL: NIECONN_REFUSED", execute sapcontrol -nr <Instance_ Number>
-function StartService <SAPSID>to ensure that sapstartsrv is running. Then execute again the
start or stop command.

9.6 Creating a User for LDAP Directory Access

If you use LDAP directory services, you have to set up a user with a password on the host where the SAP
system is running. This permits the SAP system to access and modify the LDAP directory.

A Caution

SAP recommends that you no longer use the LDAP configuration options provided by the software
provisioning manager, because current security guidelines make it unsafe to run SAP applications on a
domain controller. Instead, SAP recommends that you follow the instructions in SAP Note 3251648 to
enable LDAP directory service integration of your SAP system with Active Directory.

Prerequisites

During the SAP instance installation you chose to configure the SAP system to integrate LDAP services.

Context

For more information, see Integration of LDAP Directory Services [page 183].

Procedure

1. Logonasuser <sapsid>adm.
2. Enter the following:
ldappasswd pf=<Path_and_Name_of_Instance_Profile>

3. Enter the required data.
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% Example
The following is an example of an entry to create an LDAP Directory User:

CN=sapldap,CN=Users,DC=nt5,DC=sap-ag,DC=de

9.7 Heterogeneous SAP System Installation

This section provides information on the installation of an SAP system in a heterogeneous system landscape.
“Heterogeneous system landscape” means that application servers run on different operating systems.

See SAP Note 1067221#% for more information on:

* Supported combinations of operating systems and database systems
* How to install an application server on Windows in a heterogeneous (UNIX) SAP system environment
* Heterogeneous SAP system landscapes with different UNIX operating systems

9.8 Enabling SSL Encrypted Data Transfer

Secure Sockets Layer (SSL) encrypted data transfer is available for SAP ASE 16.0 SPO2 starting with PL6.

For general limitations and prerequisites refer to SAP Note 2481596/ - SYB: Encrypted data transfer between
SAP system and SAP ASE database.

The software provisioning manager offers the possibility to enable the SSL encrypted data transfer via a
checkbox. The SSL certificates are generated by the software provisioning manager and enabled for the
database server and the SAP application server.

There are no manual steps necessary to configure the usage of SSL for the purpose of encrypted data transfer.

® Note

The software provisioning manager adds the profile parameter dbs/syb/ssl = 1 to the SAP System
DEFAULT profile and configures the environment variable dbs_syb_ssl = 1 for the OS user <sid>adm.

The SAP ASE interface file contains the keyword ssl in the TCP/IP connection string.

9.9 Uninstalling an SAP System or Single Instances

Uninstalling an SAP system or single instances is described in this section. It includes prerequisites, manual
steps, and recommendations for deleting the system or instances using the software provisioning manager. It
also provides information on deleting database content and other related considerations.
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Prerequisites

You have installed your SAP system with standard SAP tools according to the installation documentation.
You are logged on as a user with root permissions.

A Caution

Do not use the <sapsid>adm user to delete the SAP system.

Make sure that the SAP system, or single instance, or standalone engine, or optional standalone unit to
be deleted is down and that you are not logged on as one of the SAP system users. Also check that all
SAP-related processes are stopped. If there is a lock on one of the SAP system objects, the uninstall fails.

® Note

You do not have to stop the SAP Host Agent. The SAP Host Agent is stopped automatically during the
uninstall process.

When starting the uninstall, make sure that there are no SAP system user sessions still open.

Context

Note the following when deleting an SAP system or single instances:

We strongly recommend that you delete an SAP system or single instances using the software provisioning
manager. However, you can also delete an SAP system or single instance manually. For more information,
see SAP Note 1259982 .

You cannot delete an SAP system remotely.

During the uninstall process, all file systems and subdirectories of the selected SAP system or single
instance are deleted. Before you start uninstalling, check that you have saved a copy of all files and
directories that you want to keep to a secure location.

The uninstall process is designed to remove as much as possible of the SAP system to be deleted. If an
item cannot be removed, a message informs you that you have to remove this item manually. You can do
this either at once or after the uninstall process has finished. As soon as you confirm the message, the
uninstall process continues.

Procedure

Start the software provisioning manager as described in Running Software Provisioning Manager [page
121].

. Onthe Welcome screen, choose:

| Generic Installation Options # <Database> ¥ Uninstall  Uninstall SAP Systems or Single Instances J

Follow the instructions on the software provisioning manager screens to delete a complete SAP system or
single instances.
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® Note

To find more information on each parameter during the Define Parameters phase, position the cursor

on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.

The following table provides information about deleting a complete system or single instances with the
software provisioning manager.

Deletion of Remarks

Standard system You can delete a standard system (where all instances reside on the same host) in one
software provisioning manager run.

Distributed or high-availability  If you want to delete a distributed or high-availability system, you have to run the
system software provisioning manager to delete the required instances locally on each of the
hosts belonging to the SAP system in the following sequence:

A Caution

Only select checkbox Uninstall all instances of the SAP system from this host when
removing the last remaining instance of the SAP system. Otherwise the contents
of mounted global directories under /<sapmnt>/<SAPSI1D>/ such as instance
profiles and kernel executables, are also deleted.

Additional application server instances, if there are any

Primary application server instance

w N

Database instance

Since the software provisioning manager only stops local instances automati-
cally, make sure that before deleting the database instance of a distributed
system, you stop all remaining instances. You must stop the instance with the
message server only after having entered all software provisioning manager pa-
rameters for the deletion of the database instance.

4. ABAP Central services instance (ASCS)

® Note

To delete system directories mounted from an NFS server, you have to run the
software provisioning manager on the NFS server.

Additional application server  If you want to delete additional application server instances of an existing SAP system,
you have to run the software provisioning manager to delete them locally on each
additional application server instance host.
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Deletion of Remarks

Standalone SAP Host Agent The SAP Host Agent is automatically uninstalled from a host together with the last
remaining SAP system instance.

If you want to uninstall a standalone SAP Host Agent, deselect Profiles Available and
select Uninstall Standalone SAP Host Agent on the General SAP System Parameters
screen.

4. When you have finished, delete the relevant directory structure on the global host.

5. If you created the directories Zusr/sap/<SAPSID> and /<sapmnt>/<SAPSI1D> as mount points, but not
as directories on the local file system, you have to remove them manually.

6. Toremove obsolete SLD data, see the following document: https://wiki.scn.sap.com/wiki/display/SL/
More+on+System+Landscape+Directory | How-to Manage House-Cleaning in the System Landscape
Directory - Duplicate System Entries 3

7. If the following directories and files exist, delete them by entering the following command:
WRKLNKSAP

* Jusr/sap/trans/cofiles/*<SAPSID>*
* /usr/sap/trans/data/*<SAPSID>*

* /usr/sap/trans/log/*<SAPSID>*

* /usr/sap/trans/buffer/*<SAPSID>*

Choose 4 (Remove) on every file that is found by the command WRKLNKSAP.

<% Example
For example, for directory Zusr/sap/trans/data, enter the following command:
WRKLNKSAP DIR("/usr/sap/trans/data/*<SAPSID>*")

Choose 4 (Remove) on the listed files.

® Note

To limit the command WRKLNKSAP, choose Subset (in the upper right part on the screen).

8. If the following directories exist, delete them by entering the following commands:
RMVDIR DIR("/sapmnt/<SAPSID>") SUBTREE(*ALL)

RMVDIR DIR("/usr/sap/trans/config/<SAPSID>") SUBTREE(*ALL)

® Note

If you are removing a system from an independent ASP also delete the contents from the following
directories:

RMVDIR DIR("/<IASP_Name>/usr/sap/<SAPSID>") SUBTREE(*ALL)

RMVDIR DIR("/<IASP_Name>/sapmnt/<SAPSID>") SUBTREE(*ALL)

9. If the kernel library of the system you just deleted was only used by the deleted system, you can remove it.
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To remove the kernel library from the library list, enter the following command:
RMVLIBLE LIB(SAP<SAPSID>IND)

To delete the kernel library, enter the following command:
DLTLIB LIB(SAP<SAPSID>IND)

Results

The SAP system is now deleted. If you want to reinstall an SAP system, you can use the same <SAPSID> as the
one of the SAP system you deleted.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on UNIX: SAP Adaptive Server Enterprise

204 PUBLIC Additional Information



A Appendix

A.1 Online Information from SAP

More information is available online as follows:

Titel Internet Address

Database Administration Guide: SAP Applications on  https://help.sap.com/viewer/ase_admin
SAP Adaptive Server Enterprise

Security Guide for SAP Application on SAP Adaptive  https://help.sap.com/viewer/ase_security
Server Enterprise
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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